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Sambutan

Puji syukur kami panjatkan ke hadirat Allah SWT, berkat
rahmat dan karunia-Nya, Pemerintah, dalam hal ini,
Departemen Pendidikan Nasional, pada tahun 2009, telah
membeli hak cipta buku teks pelajaran ini dari
penulis/penerbit untuk disebarluaskan kepada masyarakat
melalui situs internet (website) Jaringan Pendidikan
Nasional.

Buku teks pelajaran ini telah dinilai oleh Badan Standar
Nasional Pendidikan dan telah ditetapkan sebagai buku teks
pelajaran yang memenuhi syarat kelayakan untuk digunakan
dalam proses pembelajaran melalui Peraturan Menteri
Pendidikan Nasional Nomor 49 Tahun 2009 tanggal 12
Agustus 2009.

Kami menyampaikan penghargaan yang setinggi-
tingginya kepada para penulis/penerbit yang telah berkenan
mengalinkan hak cipta karyanya kepada Kementerian
Pendidikan Nasional untuk digunakan secara luas oleh para
siswadan guru di seluruh Indonesia.

Buku-buku teks pelajaran yang telah dialihkan hak
ciptanya ini, dapat diunduh (down load), digandakan, dicetak,
dialihmediakan, atau difotokopi oleh masyarakat. Namun,
untuk penggandaan yang bersifat komersial harga
penjualannya harus memenuhi ketentuan yang ditetapkan
oleh Pemerintah. Diharapkan buku teks pelajaran ini akan
lebih mudah diakses oleh siswa dan guru di seluruh Indonesia
maupun sekolah Indonesia yang berada di luar negeri
sehingga dapat dimanfaatkan sebagai sumber belajar.

Kami berharap, semua pihak dapat mendukung kebijakan
ini. Kepada para siswa kami ucapkan selamat belajar dan
manfaatkanlah buku ini sebaik-baiknya. Kami menyadari
bahwa buku ini masih perlu ditingkatkan mutunya. Oleh
karenaitu, saran dan kritik sangat kami harapkan.

Jakarta, April 2010
Kepala Pusat Perbukuan
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Pengantar

Buku ini disusun berdasarkan Standar Isi Kurikulum yang
berlaku dengan penekanan utama pada penggunaan dan
pengembangan ketrampilan proses. Sehingga siswa dapat
bekerja secara ilmiah dan dapat memahami konsep serta
mampu memecahkan masalah. Buku ini mengacu pada
pendekatan CTL (Contextual Teaching Learning) sehingga
siswa dapat mengaplikasikan teori dan praktikum yang
sesuai dengan aktifitasnya dalam kehidupan sehari-hari.

Buku TIK SMA/MA kelas XII ini terdiri atas 6 bab. Setiap
bab memuat uraian materi, tugas, diskusi, praktikum,
rangkuman, dan glosarium. Juga dilengkapi ilustrasi yang
mendukung materi pembelajaran yang terkait, ilustrasi ada
yang berupa foto (diambil dari berbagai situs internet) dan
berupa capture screen materi yang dibahas.

Selain itu juga dilengkapi Sekilas Info, Tips dan triks, serta
beberapa ulasan tentang tokoh Teknologi yang terkait. Hal-
hal ini dapat menambah wawasan siswa dengan informasi
terkini. Buku ini juga dilengkapi dengan Uji Kompetensi
yang isinya merupakan kompetensi yang harus dicapai.
Pada setiap bab diberikan bahan diskusi dan presentasi hal
ini dapat dijadikan bahan penilaian portofolio.

Penulis mengucapkan terima kasih kepada editor yang telah
banyak membantu hingga terbitnya buku ini. Kritik dan
saran sangat penulis harapkan guna perbaikan selanjutnya.
Tangerang, Januari 2009

Penulis
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endahuluan

Buku ini disusun dengan maksud untuk memberikan
Petunjuk dan Berbagai Tehnik kepada siswa-siswi untuk
mempermudah dalam mempelajari teori Teknologi
Komunikasi dan Komputer. Secara umum buku ini disajikan
dengan pendekatan kontekstual, dimana banyak contoh
tugas dan diskusi bahkan latihan terkait dengan keseharian
kehidupanmu.

Penyajian buku ini dijabarkan dengan prinsip belajar
bermakna, yaitu belajar yang mengutamakan pengertian
atau pemahaman konsep dan ditekankan kepada beberapa
hal penting seperti:

1. Paragraf pembangkit Minat gambar atau foto yang
dapat menarik siswa untuk mempelajari bab yang
bersangkutan.

2. Kata Kunci adalah kumpulan kata-kata atau istilah
penting yang ada pada setiap bab.

3. Peta Konsep memberi gambaran secara umum tentang
materi yang akan dipelajari dan keterkaitannya antar
subbab.

4. Contextual Teaching Learning (CTL) merupakan
tehnik pembelajaran yang melibatkan kasus nyata dalam
kehidupan sehari-hari seperti membuat puisi, data
sekolah, membuat majalah dinding dan sebagainya.

5. Gambar dan ilustrasi membantu memperjelas materi
yang dibahas.

6. Soal-soal latihan disajikan secara runtut dalam bentuk
praktikum maupun teori.

7. Aktifitas Siswa merupakan aktifitas yg menarik
melibatkan siswa dalam menjawab soal secara kreatif.

8. Diskusi dan presentasi kami sajikan untuk mengajak
anda terlibat secara aktif dalam pembahasan bab yang
bersangkutan. Ini juga merupakan bagian penilaian
untuk portofolio.

9. Sekilas Info kami ambil dari berbagai media dan situs
internet yang berisi informasi  up to date dan relevan
dengan materi pembahasan bab yang bersangkutan.

10. Internet Link kami rujuk supaya kalian dapat mendapat

(o,




Informasi lebih jauh ke situs tertentu di internet untuk

melengkapi informasi pembahasan bab yang bersangkutan.

11. Tokoh Teknologi kami sajikan dari berbagai media yang
berisi informasi terkini tentang Tokoh Teknologi yang
berjasa dibidangnya.

12. Ringkasan pada akhir bab memuat hal-hal pokok yang
perlu dipelajari dalam bab tersebut.

13. Uji Kompetensi Semester 1 dan 2 merupakan kumpulan
soal untuk latihan evaluasi kemampuan anda selama 1
semester.

14. Glosarium adalah kamus mini yang berisi definisi dan
penjelasan dari suatu istilah yang disebutkan dalam
penjelasan materi.

15. Indeks, merupakan daftar kata kunci beserta nomor
halamannya. Indeks ini diurutkan berdasarkan urutan
alfabetis.

Besar harapan kami buku ini dapat memotivasi anda dalam
mempelajari teknologi informasi dan komunikasi sehingga
mutu pendidikan teknologi informasi dan komunikasi secara
keseluruhan dapat ditingkatkan.

Penulis.




Tujuan Pembelajaran:

Setelah mempelajari bab ini diharapkan
siswa mampu:

1. Memahami dan mengenal program
pengolah gambar CorelDRAW

2. Mengenalbagian-bagian jendela
CorelDRAW

3. Mengetahui kegunaan tool program
CorelDRAW

4. Memahami dan dapat membuat gambar
vektor sederhana dengan CorelDRAW

Bagaiman cara membuat gambar seperti di
samping ini?

Dengan software apa kita bisa
mengerjakannya?

Banyak sekali poster yang kita temui di
jalan-jalan, seperti poster yang ada di
samping. Tentunya untuk membuat karya
desain grafis seperti itu, dibutuhkan alat
untuk membuatnya. Salah satu alat yang
dapatkita gunakan adalah Corel[DRAW.

Pada bab ini kita akan mengenal apa itu
CorelDRAW dan tool apa saja yang ada di

dalamnya.
~ KATA KUNCI |
B Zoom B Shape tool B Knife tool  ® Perfect Shapes
B Desain B Rectangle tool ™ Grafis ® Eyedropper
= Tool ® Ellipse tool B Curve = [con

B Pick tool B Text tool B Poster



Peta konsep

Mengenal
Software
Core]DRAW

Mengenal
Tools
Mengenal CorelDRAW 12
dan Mengenal
Mengaplikasikan dan
Dasar Memulai
Desain CoreDRAW 12

Grafis

Membuat
Logo
Sederhana




BAB Mengenal dan
1 Mengaplikasikan
Dasar Desain Grafis

Desain grafis merupakan media penyampaian informasi yang
disampaikan melalui bentuk grafis sebagai aplikasi dari
keterampilan seni dan komunikasi. Dalam kehidupan kita
sehari-hari, sering kita jumpai berbagai desain grafis untuk
bermacam-macam kepentingan. Contohnya logo di produk-
produk yang dijual di supermarket, baliho dan poster yang
dipasang di jalan, dan lain-lain. Saat membeli pakaian pun,
pastinya kita memilih pakaian dengan desain gambar yang
menarik. Ini membuktikan pentingnya peranan desain gambar
dalam kehidupan kita.

Mengenal dan Memulai CorelDRAW 12

Gambar merupakan bentuk seni rupa yang paling dasar. Proses
penciptaan karya seni rupa biasanya berawal dari gambar
sederhana yaitu coretan pencil di atas selembar kertas.

Gambar atau sering disebut dengan citra grafis sendiri
dikelompokkan menjadi 2 jenis, yaitu gambar dengan format
vektor dan gambar dengan format bitmap. Apa perbedaan dari
keduanya? Gambar dengan format vektor dibuat dengan
perhitungan matematis sehingga tidak akan pecah walaupun di
besarkan ukurannya. Sedangkan gambar dengan format bitrmap
dibuat dari kumpulan titik-titik berwarna yang pada akhirnya
membuat suatu bentuk gambar. Karenanya, gambar bitmap
akan pecah ketika ukurannya dibesarkan.

Pada semester ini, kita akan mencoba untuk belajar dan
membuat berbagai desain gambar vektor dengan software
CorelDRAW.

1. Mengenal CorelDraw

Tentunya, sebelum kita menggunakan CorelDRAW, kita harus
meng-install terlebih dahulu sofiware tersebut ke dalam
komputer kita. Software CorelDRAW yang terbaru adalah
CorelDRAW X4, namun saat ini kita cukup memakai
CorelDRAW 12.

BAB 1 Dasar Desain Grafis I




Untuk dapat menjalankan Core/lDRAWI12, spesifikasi
komputer minimal yang diperlukan yaitu:

» Sistem Operasi Windows 2000 Sp4 atau Windows XP SP1

» Pentium II, 200 Mhz atau lebih

» RAM128 MB (direkomendasikan 256 MB RAM)

» Hard Disk250 MB
Setelah software tersebut terpasang di komputer, kita bisa
Gambar 1.1 membuka dengan cara:
Shortcut > Klik start
CorelDRAW12

» Klik programs

» Klik CorelDRAW 12

Atau dengan mengklik shortcut yang terletak di desktop seperti
gambar 1.1.

Selanjutnya, akan muncul sebuah jendela. Jendela dalam
CorelDraw memiliki beberapa bagian. Untuk lebih jelasnya,
lihatlah gambar 1.2.

(" )

Title bar__

Menu Bar—

Toolbar—— Rul
Property _~Ruler
Bar

Toolbox
Drawing

window
Drawing
page
Color
/ \ palette
Document S
navigator Bt;rtus
N\ J
Gambar 1.2.
Bagian-bagian jendela CorelDRAW 12
Soal 1

1. Apa yang dimaksud dengan desain grafis dan gambar?
2. Sebutkan dan jelaskan jenis-jenis gambar!
3. Sebutkan dan jelaskan bagian-bagian pada jendela CorelDRAW 12!




Nama

Title bar

Menu bar

Toolbar

Toolbox

Property bar

Document
navigator

Status bar

Drawing
window

Drawing page

Color palette

Ruller

Flyout

Keterangan

Menampilkan judul document dan menandai aktif atau tidaknya
sebuah jendela.

Area yang terdiri dari perintah-perintah yang dikelompokkan
dalam menu.

Kumpulan icon yang memiliki fungsi tertentu dan digunakan
untuk mempermudah pengaksesan sebuah perintah.

Toolbox juga merupakan sebuah toolbar,

tetapi foolbox lebih khusus digunakan untuk memanipulasi
objek gambar.

Digunakan untuk menampilkan dan merubah status dari toolbox
yang aktif. Maka dari itu, property bar dapat berubah-ubah.

Area yang terdiri dari contro/ untuk menambah halaman dan
berpidah ke halaman lain dalam satu file.

Menampilkan status objek yang sedang aktif dan posisi kursor
di jendela.

Area diluar lembar kerja.

Area lembar kerja dimana setiap objek gambar yang terdapat
di area tersebut dapat dicetak.

Daerah yang digunakan untuk memilih warna.

Berfungsi untuk menentukan posisi sebuah objek pada lembar
kerja.

Ditandai dengan gambar segitiga kecil di toolbox.
Berfungsi untuk menampilkan tools dalam kelompok.

Tabel Daftar tombol toolbar beserta fungsinya.

BAB 1 Dasar Desain Grafis I_




Gambar 1.3
Pick tool

Gambar 1.4
Kegunaan pick tool

Gambar 1.5
Tool yang terdapat
dalam flyout Shape edit

2. Mengenal Tools CorelDraw 12

Setelah kita mengetahui bagian-bagian dalam jendela
CorelDRAW, kita dapat membuat gambar dengan foolbox yang
disediakan. Coba lihat pada tabel sebelumnya, pada kolom
paling bawah, kita melihat terdapat istilah yang disebut flyout.
Dalam sebuah toolbox, terdapat berbagai macam tool yang
mempunyai fungsi yang hampir mirip. Itulah sebabnya
digunakan flyout untuk mengelompokkan fool yang fungsinya
hampir sama atau berhubungan.

Sekarang, kita akan membahas fungsi dari ool dalam toolbox
berdasarkan pengelompokannya.

a. Pick

Tool yang berbentuk seperti panah ini mempunyai fungsi utama
untuk memilih objek dan memindahkan objek. Namun, bisa
juga digunakan untuk memutar objek dan mengubah ukuran
objek. Kita bisa melihat kegunaan pick pada saat itu dengan
melihat perbedaan tanda pada sudut-sudut gambar yang
sedang aktif.

Pick berfungsi untuk Pick berfungsi untuk
memutar objek mengubah ukuran objek
b. Shape edit

Shape edit merupakan kumpulan foo/ yang berfungsi untuk
mengubah sebuah objek gambar. Misalnya memotong gambar,
menghapus sebagian gambar, dan lain-lain. Terdiri dari 7 buah
tool, dapat dilihat pada tabel berikut ini.




Digunakan untuk mengubah bentuk sebuah objek dengan

Shape tool | enarik titik-titik pada sisi objek.
Knife tool Digunakan untuk memotong objek.
Eraser tool Digunakan untuk menghapus area gambar yang dipilih.

Smude brush | Digunakan untuk mengubah bentuk objek vekfor sesuai
dengan jalur yang kita buat dengan rool tersebut.

tool

Document Digunakan untuk mengubah sisi objek dengan menarik pada
navigator sisi-sisi objek.

Free Dengan alat ini, kita bisa mengubah objek secara bebas

transform tool | sepertimengubah sudut objek, ukuran objek, dan lain-lain.

Virtual Digunakan untuk menghapus bagian yang bergesekan
Sjglmte”t dengan garis yang kita buat dengan ool ini.
elete

c.Zoom
Zoom berkaitan dengan bagaimana pengguna dapat melihat
lembar kerja dari jendela Corel DRAW.

Gambar 1.6
Tool yang terdapat
dalam flyout zoom

Digunakan untuk memperbesar atau memperkecil

Bowp 00 tampilan lembar kerja.
Digunakan untuk menggeser lembar kerja sehingga kita
Hand tool dapat melihat area yang kita inginkan.
d. Curve

Fasilitas-fasilitas dalam curve digunakan untuk membantu
pengguna dalam membuat kurva dan garis. Fasilitas curve ini
terdiri atas 7 tool yang dapat dilihat pada tabel dibawah ini.

Gambar 1.7
Tool yang terdapat dalam flyout
curve.
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Freehand
tool

Besier tool

Digunakan untuk membuat garis, baik garis lurus maupun
melengkung. Menggunakan piranti ini, sama halnya seperti
ketika kita membuat garis dengan pensil di atas kertas.

Piranti ini digunakan untuk membuat kurva.

Artistic Digunakan untuk membuat objek artistik dengan preset,

media tool brush, sprayer, caligraphic, dan pressure tool.

p / Berfungsi untuk membuat kurva atau garis lurus hanya

en too dengan satu kali klik.

1;00?} e Berguna untuk membuat garis lurus dan kurva.

3 point Digunakan untuk membuat kurva dengan tiga titik, yaitu

curve tool titik awal, titik akhir, dan titik tengah.

Interactive Digunakan untuk membuat garis sebagai penghubung

foogzlnector antara dua buah objek.

Dimension Digunakan sebagai alat bantu untuk mengukur tinggi dari

tool sebuah objek.
e. Smart Drawing Tool
Dengan menggunakan smart drawing tool, gambar yang kita
buat akan menyesuaikan diri ke bentuk-bentuk dasar yang
mendekati dengan kurva yang lebih halus. Misalkan kita
membuat objek yang mirip persegi, maka setelah mouse
dilepas, objek tersebut secara otomatis akan berubah menjadi
objek segi empat.

Gambar 1.8

Smart Drawing tool

Gambar sebelum
mouse dilepas

Gambear setelah mouse
Gambar 1.9 dilepas

Kegunaan Smart Drawing Tool




f. Rectangle

Dalam rectangle, kita bisa menemukan dua buah foo! yaitu
rectangle tool dan 3 point rectangle tool. Kedua tool ini sama-
sama mempunyai fungsi untuk membuat bentuk persegiempat.
Yang membedakan dari keduanya adalah cara pemakaiannya.

9. Ellipse

Ellipse, digunakan untuk membuat bulatan, baik bulat penuh
maupun oval. Seperti pada rectangle tool, yang membedakan
antara ellipse tool dan 3 point ellipse tool, juga dalam cara

pemakaiannya saja.
Gambar 1.10 Gambar 1.11
Tool yang terdapat dalam flyout rectangle Tool yang terdapat dalam flyout ellipse

Tahukah Kamu

Untuk lebih mengetahui tentang rectangle dan ellipse tool, kita akan melakukan
analisa. Cobalah memulai analisa dengan membuat sebuah objek dengan tool
tersebut. Untuk membantu pengamatan kalian, kalian bisa menjawab pertanyaan di
bawah ini:
1. Apa perbedaan cara pemakaian rectangle tool dengan 3 point rectangle tool?
deskripsikan dengan bahasamu.
2. Cobalah menggunakan ellipse tool atau rectangle tool dengan menekan tombol
ctrl pada keyboardkalian.
a. apayang terjadi? Bagaimanakan bentuk objek yang dibuat?
b. apa kesimpulan yang bisa kalian dapat tentang penggunaan tombol ctrl dalam
penggambaran objek? Jawablah dengan bahasamu.
3.Tuliskan kesimpulan-kesimpulan lain yang bisa kalian dapat dari
pengamatan pribadi kalian.

h. Object

Di dalam object, kita dapat menggunakan 3
macam fool, yaitu graph paper tool, polygon
tool, dan spiral tool.

Gambar 1.12
Tool yang terdapat dalam flyout object
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Graph
paper tool

Polygon
tool

Spiral tool

Gambar 1.13
Tool yang terdapat
dalam perfect shapes

Digunakan untuk membuat objek seperti kertas bergaris.
Akan tetapi, sering digunakan untuk membuat tabel.

Berfungsi untuk membuat bentuk dengan banyak sisi.

Digunakan menggambar spiral simetris.

i. Perfect Shapes

Selain dengan rectangle tool dan ellipse tool, kita bisa
membuat gambar dengan fool yang disediakan oleh perfect
shape. Dengan perfect shapes, kita bisa membuat panah
dengan arrow shapes, membuat label dengan banner shapes,
dan membuat kotak dialog dengan callout shapes secara
mudah.

Tips and Trick

Tips: untuk mengubah bentuk dasar shape, kita bisa mencari bentuk-bentuk lain
yang sudah disediakan oleh CorelDRAW dengan melihat propertise bar.

Gambar 1

Gambar 1.15
Text tool

I TIK SMA Kelas XII

.14 Bentuk lain yang disediakan dalam propertise bar.

j- Text tool
Digunakan untuk membuat zext atau paragraf di dalam lembar
kerja corel.




k. Interactive tools
Terdapat 7 tool yang merupakan interactive tool, yaitu:

g

Interactive
blend

Interactive
contour tool

Interactive
distortion

Interactive
drop shadow

Interactive
envelope

Interactive
extrude

Interactive
transparency

I. Eyedropper
Dalam kelompok eyedropper terdapat dua macam tool yang
saling melengkapi. Tool pertama adalah Eyedropper tool.
Eyedropper tool yang disimbolkan dengan icon bergambar
pipet berguna untuk mengambil properti suatu objek, seperti
ukuran, warna, ketebalan garis, dan lain-lain.

Internet Link

Gambar 1.16
Tool yang terdapat dalam flyout
interactive tools

Berfungsi untuk memadukan dua buah objek yang berbeda.

Memperbanyak garis pada objek sehingga menimbulkan
kesan timbul atau tenggelam pada objek.

Fasilitas ini berguna untuk membuat distorsi pada objek.

Digunakan untuk membuat bayangan pada sebuah objek.

Berfungsi untuk mengubah objek dengan menarik titik-titk
pada objek.

Berfungsi untuk memberi efek tiga dimensi pada sebuah
objek.

Berfungsi membuat objek menjadi tembus padang atau
transparan.

Gambar 1.17
Tool yang termasuk dalam
flyout Eyedropper

Untuk mengetahui lebih lanjut tentang CorelDraw,
kalian dapat mengunjungi situs web milik CorelDRAW di
http://www.corel.com/international.html
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Kemudian dengan paintbucket tool, kita bisa menerapkan
properti objek yang kita dapat dengan eyedropper tool tadi ke
objek yang lain.

Untuk lebih jelasnya, lihatlah gambar 1.18 kemudian ikuti

langkah-langkah berikut:

1. Buatlah dua buah objek dengan properti yang berbeda.
Misalnya, objek pertama berwarna merah dengan garis
tebal dan objek kedua berwarna hitam dengan garis tipis.

2. Letakkan eyedropper tool di atas objek yang akan diambil

propertinya.

Klik mouse.

Pilih paintbucket tool.

Letakkan paintbucket tool ke objek yang akan disamakan

propertinya dengan objek pertama.

whkw

Dengan fool ini , kita dapat mengubah properti berbagai objek
sejenis tanpa perlu mengubah propertinya satu per satu.

Gambar 1.18
Objek awal

Gambar 1.19

(a) Cara menggunakan
eyedropper dan paintbucket tool. @

(b) Hasil objek setelah

menggunakan eyedropper

dan paint bucket tool

Tugas 1

1. Buatlah sebuah logo yang mencerminkan pribadimu.

2. Simpan logo tersebut dalam format corel.

3. Buatlah langkah-langkah pembuatan logo beserta fool-tool apa saja yang
digunakan.




Mengaplikasikan Dasar Desain Grafis

Kalian pasti sering melihat logo seperti contoh di bawah
bukan? Bahkan, kalian pasti sering melihat logo-logo yang
lain. Banyak sekali contoh penggunaan logo dalam kehidupan
kita. Baik instansi maupun sebuah produk biasanya
mempunyai logo yang berfungsi untuk memberi identitas bagi
perusahaan atau produk mereka.

Pada sub bab sebelumya, kita telah mengenal berbagai fools
(piranti) yang bisa digunakan pada CorelDRAW 12. Maka dari
itu, sekarang kita akan melangkah lebih jauh dengan
mempraktekkan fools tersebut untuk membuat gambar
sederhana yang secara khusus. Pada sub bab ini, kita akan
belajar membuat sebuah logo.

Gambar 1.20.
Contoh logo dalam
kehidupan sehari-hari

1. Membuat Logo Sederhana

Sebagian besar dari kalian pasti pernah menonton film The
Incredibles bukan? Seperti halnya dengan film kepahlawanan
lain, tokoh pada film ini juga mengenakan kostum berlogo.
Nah, logo pertama yang akan menjadi percobaan kita adalah
logo dalam film The Incredibles seperti pada gambar 1.21

HE |NCRED|BLES
Logo film The Incredibles
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Untuk membuat logo seperti gambar 1.21, kita hanya
memerlukan beberapa tool, diantaranya:

1, Picktool

2. Ellipse tool

3. Knife tool

4. Text tool

5. Interactive envelope tool

6. Shape tool

7. Rectangle tool

Langkah 1:

Bukalah CorelDrawli2. Setelah jendela corel terbuka, buatlah
lembar baru dengan cara klik icon new pada foolbar, atau tekan
ctrl+N pada keyboard atau jika kalian menemui jendela seperti
pada gambar 1.22, tekan gambar yang diberi tanda lingkaran.

Gambar 1.22
Tampilan awal jendela
CorelDRAW 12

Langkah 2:

Pertama-tama, kita akan membuat huruf'i. Kita tidak membuat
huruf tersebut dengan text rool, tetapi kita buat dengan
rectangle tool dan ellipse tool.

A

Aturlah ukuran
objek di sini.

Gambar 1.23 Cara mengatur ukuran objek
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1. Klik rectangle tool.

2. Buatlah sebuah persegi, kira-kira berukuran 1.5x 3 cm.

3. Klik pick tool ke objek persegi yang telah dibuat, kemudian
klik kanan pada mouse. Setelah itu, pilih convert to curve. Jika
kurang mengerti, lihatlah gambar 1.23 danl.24. Setelah itu,
klik pada shape.

Langkah selanjutnya, pilih ellipse tool. Buatlah dua buah
lingkaran. Lingkaran pertama berukuran 1.62 x 1.62 cm dan
lingkaran ke dua berukuran 0.85 x 0.85 cm. Letakkan lingkaran
yang lebih kecil di dalam lingkaran yang lebih besar dengan
pick tool, kemudian letakkan kedua lingkaran itu tepat di atas
objek persegi.

Jika gambar yang kalian buat telah sama seperti gambar 1.26,
kalian boleh melaju ke langkah berikutnya.

Langkah 3:

Saat ini kita akan membuat latar dari logo tersebut. Caranya:

1. Klik ellipse tool.

2. Buatlah objek ellipse dengan ukuran 7.5 x 4.5.

3. Letakkan ellipse tersebut di tengah objek sebelumnya seperti
gambar 1.27.

4.Klik ellipse tool.

5. Buatlah ojek ellipse yang lebih kecil dengan ukuran 5.7 x 3.5
cm.

6. Klik knife tool.

7. Klik satu kali pada kotak kecil yang terdapat pada tengah atas
ellipse, kemudian klik pada kotak kecil yang muncul pada
tengah bawah ellipse sehingga memotong ellipse menjadi
duabagian yang sama luasnya.

Gambar 1.24
Cara mengonversi objek
menjadi sebuah kurva

Gambar 1.25
Cara mengubah
bentuk objek dengan shape tool

©

Gambar 1.26
Posisi peletakan objek
lingkaran dan persegi
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Gambar 1.27
Posisi peletakan objek ellipse

Gambar 1.29
Posisi peletakan ellipse

I TIK SMA Kelas XII

Untuk lebih jelas, lihatlah gambar 1.28

Pertama, klik kota kecil
pada titik pertama,
kemudian geser mouse, dan
klik pada kotak kecil di titik
ke 2.

Gambar 1.28 Cara menggunakan knife tool

. Letakkan ellipse yang telah terpotong ke tengah-tengah

objek sebelumnya, seperti pada gambar 1.29.

. Geser setengah bagian kanan ellipse kecil yang telah

terpotong ke atas, kira-kira sampai di sisi atas ellipse yang
lebih besar. Jika pergeseran ellipse tadi menghasilkan
rongga, tekan ctrl+ tanda panah ke kiri pada keyboard untuk
memperkecil jarak.




Langkah4:

Logo yang kita buat sudah hampir selesai. Langkah selanjutnya
adalah mewarnai dan merangkai objek sehingga bisa terlihat
sebagai suatu objek utuh.

1. Klik objek setengah lingkaran dengan pick tool.

2. Klik kanan pada objek, kemudian klik pada color pallete di
bagian paling atas, lalu klik set fill color untuk mewarnai isi
objek atau set outline color untuk mewarnai garis pada
objek.

3. Setelah itu, ubah warna kedua objek setengah lingkaran
menjadi hitam.

Gambar 1.30
Hasil penggeseran
sebagian ellipse

Gambar 1.31 Cara mewarnai objek
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4. Isi pula warna persegi panjang dan lingkaran di atasnya
dengan warna kuning dan garis kuning.

5. Isi warna lingkaran yang lebih kecil dengan warna putih dan
garis putih.

6. Isi warna ellipse besar di belakang dengan warna orange
dan garis orange.

7. Terakhir adalah membuat objek setengah lingkaran yang
berada di belakang objek persegi.

Klik objek setengah lingkaran dengan pick tool, klik kanan
pada objek tersebut, kemudian pilih order behind.

Setelah itu, akan muncul tanda panah. Letakkan tanda panah itu
pada objek persegi untuk membuat objek setengah ellipse tadi
berada di belakang objek persegi.

® @

Gambar 1.32 Gambar 1.33
Proses pewarnaan objek Proses akhir perwarnaan objek

o

Gambar 1.34

(a) Cara membuat objek di belakang objek yang lain.

I TIK SMA Kelas XII

(b) Hasil pembuatan objek di belakang objek.




Lakukan juga langkah yang sama pada objek setengah ellipse
sebelah kiri sehingga objek menjadi seperti gambar 1.35.

Langkah S:

Pada langkah kelima ini kita akan membuat teks di bawah logo

Incredibles.

1. Klik zext tool.

2. Letakkan text tool di lembar kerja, kemudian ketikan tulisan
“THE INCREDIBLES”. Setelah itu, atur ukuran fext
menjadi 34 dengan jenis text “ ARIAL BLACK”, kemudian
klik pick tool, kemudian klik kanan pada text, lalu pilih
convertto curves.

3. Perpanjang text dengan menarik titik yang berada di tengah
bawah tulisan “THE INCREDIBLES”.

4. Pilih interactive envelope tool, kemudian klik tulisan “THE
INCREDIBLES”.

Gambar 1.35

Hasil objek setelah kedua
potongan ellipse diletakkan
dizbelakan hurufi

2] (o)

Gambar 1.36
(a) Cara memanjangkan teks setelah teks dikonversi menjadi kurva.

(b) Cara mengonversi teks menjadi kurva.
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5. Klik kotak kecil pada tengah atas lalu tarik ke bawah
sehingga text melengkung di tengah.
Selanjutya, tarik panah di pojok kiri atas fext ke tengah-
tengah zext. Demikian juga dengan panah di ujung kanan
atas.

Gambar 1.37
Cara menggunakan envelopes tool

Tarik ujung anak

Q/ panah ke sini
Gambar 1.38

Cara melengkungkan teks

Langkah terakhir, letakkan fext tepat di bawah logo.
Akhirnya, selesai sudah logo yang kita buat. Mudah bukan?

Langkah 6:

Simpan hasil pekerjaan yang telah dibuat. Untuk menyimpan,
klik file, lalu save as atau klik gambar disket. Dapat juga
dilakukan dengan menekan ctrl+S pada keyboard.

Beri nama pada pekerjaan kita, klik Save.

THE INcreDIBLES

Gambar 1.39 Gambar 1.40
Cara melengkungkan teks Hasil akhir logo
dengan envelopes tool

Gambar 1.41 @
Icon Save




Hasil yang tersimpan dalam format corel, tidak bisa dibaca
tanpa menggunakan software corel. Jika kita ingin hasil
pekerjaan kita bisa dilihat dengan sofiware pada umumnya,
simpan dalam citra bitmap dengan format JPEG atau JPG.
Caranya:

1. Klik file.

2.Klik Export.

3. Beri nama pada pekerjaan kita.

4. Save.

Tips and Trick

Agar objek tidak mudah terlepas dan menjadi satu kesatuan yang utuh, kita
dapat melakukan grouping. Caranya, klik pick tool, pilih area gambar yang
akan disatukan dengan menarik pick fool sebesar area yang dipilih. Klik
kanan pada objek, kemudian pilih group.

\ Gambar 1.42
Cara melakukan grouping

2. Membuat Pembatas Buku

Setelah kita belajar membuat logo pada sub bab yang lalu, pada
pertemuan ini dan pertemuan selanjuya kita akan tetap
mempelajari CorelDRAW dengan melakukan aktivitas dan
diharapkan kita mendapat banyak pengetahuan lebih dengan
mempraktikkannya, atau sering disebut dengan “learning by
doing”. Kali ini kita akan membuat sebuah pembatas buku
yang sederhana. 700/ yang digunakan untuk membuat pem-
batas buku seperti gambar 1.43 yaitu:

1. Picktool

2. Rectangle dan Ellipse tool

3. Text tool

4. Shape tool

5. Knife tool

6. Interactive contour tool

7. Freehand tool

8. Interactive drop shadow tool

(o]
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Gambar 1.43
Pembatas buku

Langkah 1:

Bukalah lembar kerja CorelDRAW, kemudian atur posisi kertas
menjadi lanscape dan lebar kertas secara manual sebesar 15 x 3

cm.
Untuk. mengatur Untuk mengatur posisi
panjang dan kertas (portrait atau
lebar kertas landscape)

Gambar 1.44 Cara mengatur ukuran dan posisi kertas

Langkah 2:

1. Buatlah dua garis lengkung dengan freehand tool. Garis
lengkung yang pertama seperti garis di bawah ini.
Kemudian, garis lengkung yang kedua di letakkan di bawah
garis lengkung pertama seperti dibawah ini.

2. Satukan kedua kurva menjadi satu objek baru. Gunakan
pick tool untuk memilih kedua kurva sekaligus dengan
menarik mouse sehingga garis putus-putus yang terbentuk
mengelilingi kedua kurva, kemudian lepaskan mouse.

Gambar 1.45 Gambar 1.46 Gambar 1.47
Pembuatan kurva Posisi kurva kedua Cara memilih kedua kurva
secara langsung

Lihatproperties bar, lalupilih weld.

Gambar 1.48 O
Letak weld dalam

propertise bar




Satukan kedua ujung objek. Letakkan shape tool pada ujung
kurva pertama, kemudian tarik ke ujung kurva kedua. Lakukan
jugapadaujung bagian yang lain.
3.Rapikan objek

Potong bagian yang keluar dari lembar kerja dengan knife

tool.
Kemudian, hapus bagian di luar lembar kerja yang telah
terpotong.
Gambar 1.49 Gambar 1.50 Gambar 1.51
Proses penyatuan Cara memotong objek. Hasil objek setelah dirapikan

wjung-ujung kurva

4. Beri warna biru pada garis dan isi objek pertama.

Langkah 3:

Buatlah persegi panjang berukuran 15x 1.3 cm.

Beri warna ungu pada garis dan isi objek, kemudian letakkan
objek tersebut di belakang objek pertama yang tadi telah kita
buat.

Langkah 4:

1.Buatlah empat buah lingkaran dengan ellipse tool.
Untuk membuat lingkaran, tarik mouse bersamaan dengan
menekan tombol Ctrl.

2. Atur ukuran dan susunlah lingkaran seperti gambar 1.53.

Gambar 1.52 Gambar 1.53
Hasil objek setelah ditambah Letak penyusunan lingkaran
objek persegi dan diberi warna
3.Beri warna kuning pada lingkaran pertama, merah pada
lingkaran ke-2, abu-abu pada lingkaran ke-3, dan merah
muda pada lingkaran ke-4. Atau kalian juga boleh memberi
warna yang berbeda sesuai dengan kreatifitasmu.

4.Letakkan lingkaran
pertama di belakang
objek persegi
panjang. Gambar 1.54

Posisi lingkaran setelah
diberi warna.
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Langkah 5:

1. Buatlah garis lurus ke kanan dengan freehand tool. Klik
mouse satu kali pada satu bagian, kemudian geser mouse ke
kanan tanpa perlu menekan tombol. Jika garis sudah lurus,
klik mouse satu kali lagi.

. Atur ketebalan garis setebal 1,4 mm pada property bar.

. Berikan bayangan menggunakan interactive drop shadow
tool. Klik drop shadow tool, kemudian pada propertise bar
atur warna dengan bayangan menjadi abu-abu yang lebih
muda, lalu serongkan panah ke sebelah kiri seperti pada

W N

gambar 1.56.
Gambar 1.55 Gambar 1.56
Cara mengatur ketebalan garis Cara menggunakan Interactive
melalui propertise bar drop shadow tool

4. Letakkan garis pada belakang lingkaran ke 3.

Gambar 1.57
Posisi peletakan garis

Langkah 6:

1. Buatlah lingkaran dengan ellipse tool, atur ukuran lingkaran
sebesar 1.74 cm dan ketebalan garis setebal 1.0 mm.
Kemudian, isi dengan warna hijau muda dan beri warna
hijau tua pada garisnya.

2. Beri lapisan tambahan pada lingkaran dengan interactive
contour tool. Klik interactive contour tool, atur warna pada
properties sehingga objek lingkaran tadi berubah seperti
lingkaran gambar 1.58.

3. Letakkan lingkaran tersebut dibelakang objek persegi
panjang. Untuk lebih jelas, lihat gambar 1.59.

Gambar 1.58 Gambar 1.59
Cara mengaur warna melalui propertise bar Posisi peletakan lingkaran




Langkah 7:

1. Buatlah tulisan dengan text tool.
2. Ketik kalimatdi bawah ini

“The only person who is educated is the one who has learned
How to learn... and change.” -Carl Rogers

Kalian juga boleh memberi kalimat lain yang kalian ingat.
Dapat berupa kalimat motivasi, ayat-ayat kitab suci atau
yang lain.

3. Letakkan teks di atas garis yang telah kita buat sebelumnya.

4. Atur jenis font dengan huruf yang kalian sukai. Disarankan
menggunakan jenis huruf latin. Atur juga ukuran teks
sehingga dapat ditampilkan dengan baik.

Langkah 8:

Buatlah frame pada pembatas buku kalian agar ketika dicetak,
dapat dipotong dengan mudah.
1. Klik rectangle tool.
Atur ukuran sebesar 15 x 4 cm (sama dengan ukuran lembar
kerja).
Beri garis berwarna hitam dan hilangkan warna persegi jika
ada.

Dengan menambahkan frame pada pembatas buku kita, jadilah

pembatas buku tersebut.
T
‘
- e s

 The only pesson. who is educatid is he one. who how leasred

‘ e only pesson. who i celucatid s the one who fs lonsmaed T 5 .. ancl chang.” Cond B
Fow 25 bovr... mdl chomge.” -Conl Bogors
Gambar 1.60 Gambar 1.61
Hasil pembatas buku setelah Hasil akhir pembatas buku
ditambah dengan teks setelah diberi frame

Tugas 2

—_—

. Buatlah pembatas buku dengan desain yang berbeda.
2. Cobalah membuat pembatas buku tersebut dengan too/ baru yang belum
pernah diajarkan sebelumnya.
2. Simpan pekerjaanmu dalam format corel.
. Buatlah langkah-langkah pengerjaan beserta tool-fool apa saja yang
digunakan dan kesimpulan yang didapat dari tool baru yang digunakan.

(98]
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1.

2.

A.

Pilihlah salah satu jawaban yang paling benar!

Q
2

Desain grafis merupakan media penyampaian informasi melalui bentuk

grafis sebagai aplikasi dari keterampilan seni dan komunikasi.

Gambar atau sering disebut dengan citra grafis sendiri dikelompokkan

menjadi 2 jenis, yaitu gambar dengan format vekfor dan gambar dengan

format bitmap.

. Citra vektor dimodelkan oleh program sebagai deskripsi matematis untuk
menentukan posisi, lebar, dan arah bagaimana sebuah garis digambarkan.
Pada citra vektor, objek dibentuk dari kumpulan garis.

. Citra bitmap terdiri kumpulan titik berwarna yang membentuk suatu
gambar.

. Program Core]DRAW digunakan untuk membuat gambar dengan citra

vektor.

Pengecekan Konsep

O rada jendela CorelDRAW, judul @ Posisi kertas dapat diatur secara

sebuah dokumen yang sedang aktif
ditampilkan dalam. ..

a. Menu bar

b. Window bar

c. Title bar

d. Tool bar

Di bawah ini merupakan fasilitas yang
digunakan untuk membuat kurva,
kecuali ...

a. Freehand tool

b. Interactive envelope tool

c. Beziertool

d. Pen tool

Tool yang sering digunakan untuk
membuat tabel adalah ...

a. Graph paper tool

b. Table tool

c. Rectangle tool

d. Polygon tool

mendatar atau  disebut dengan
posisi ...
a. portait
b. landscape
c. layscape

d. horizontal

Fasilitas yang digunakan untuk
membuat  bayangan pada sebuah
objek adalah. ..

a. Interactive blend tool

b. Interactive shadow tool

c. Interactive contour tool

d. Interactive transparency tool

Program Core/lDRAW digunakan
untuk membuat gambar dengan citra
berformat ...

a. grafis

b. vektor

c. bitmap

d. raser



@ Kelompok tool dalam sebuah toolbox © Untuk menginstall program Corel-

yang ditandai dengan segitiga kecil DRAW, sisa minimal HardDisk yang
disebut ... diperlukan sebesar ...

a.toolbar a.128MB

b. flyout b.250MB

c. propertise bar ¢.250GB

d. menu bar d.200KB

O rasilitas yang berfungsi untuk 10}

Gambar di ing ini dalah
mewarnai isi sebuah objek adalah ... ambar di samping it {5  adala

ok tool icon dari . ..

a. Picktoo a. Interactive countour tool
b. Eyedropper tool b. Shape tool

c. Filltool

c. Interactive envelope tool

d. Qutline tool d. Artistic media tool

B. Pemahaman Konsep

Jawablah pertanyaan dibawah ini!

Sebutkan 2 jenis format gambar dan jelaskan perbedaannya!

Sebutkan dan jelaskan fungsi dari setiap foo/ yang termasuk dalam Interactive tools!
Sebutkan bagian-bagian dari jendela CorelDRAW!

Jelaskan cara untuk membuat dua buah kurva menjadi satu objek baru!

Bagaimana cara membuat sebuah objek berada di belakang atau di depan objek yang
lain?

Sebutkan dua buah pengolah citra atau gambar selain Core/DRAW!
Apa fungsi tombol Ctrl dalam pembuatan sebuah objek?
Jelaskan cara membuat bayangan pada sebuah objek!

Sebutkan kegunaan dari propertise bar!

® 00 60 66060 0 0

Sebutkan fungsi eyedropper tool dan paint bucket tool beserta cara penggunaannya!
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C. Aktifitas Siswa

Buatlah gambar di bawah ini dengan menggunakan program CorelDRAW.

Buatlah setiap objek yang sama bentuknya cukup 1 kali saja lalu copy.
Simpanlah dengan nama: Andrea-Proyek Babl.cdr, misalnya, gantilah
kata Andrea dengan namamu.




Tujuan Pembelajaran:

Setelah mempelajari bab ini diharapkan
siswa mampu:

1. Memahami dan Mengaplikasikan
CorelDRAW lebih dalam

2. Mengerti dan mampu membuat kreasi
desain untuk keperluan sehari-hari.

3. Mampu membuat desain dengan baik

4. Memahami dan mampu meng
gabungkan gambar bitmap dan gambar
vektor dengan baik.

) Dapatkah kamu membuat gambar di
samping ini dengan vector?

Kita dapat membuat gambar vektor sesuai
dengan keinginan kita dengan bantuan
CorelDRAW.

Pada bab ini, kamu akan mempelajari lebih
lanjut mengenai desain grafis dengan
menggunakan CorelDRAW. Pastikan kamu
bisa menggambar seperti contoh di

samping ini.
/
~ KATA KUNCI |
m Bitmap m Vektor m Flyout Fill
m Objek m Eraser Tool B Pointer

B Interactive Extrude Tool ™ Break Curves Apart M Basic Shapes
®m Envelopes Tool B Freehand Tool B Format



Peta konsep

Mengaplikasikan
Desain
Grafis
Vektor

Tingkat
Lanjut

Membuat
Desain
Tingkat Lanjut
dengan
Core]DRAW 12

Menggabungkan
Gambar Vektor

dan
Bitmap

Membuat
Poster

Membuat
Kartu
Undangan




Mengaplikasikan Desain
Grafis Vektor
Tingkat Lanjut

Kita semua tahu bahwa dalam kehidupan kita sehari-hari,
desain grafis tidak pernah lepas dari kehidupan kita. Saat ini,
terdapat berbagai macam aplikasi desain grafis. Berbagai
pembuat sofiware terus bersaing untuk membuat aplikasi grafis
yang dapat memudahkan para pengguna aplikasi untuk
mendesain gambar dan memadukan gambar dengan animasi.
Terdapat beberapa aplikasi grafis yang telah dikenal oleh
komunitas desain grafis seperti CorelDRAW, AutoCAD, 3D-
Max, Adobe (Photoshop, ImageReady, Illustration),
Macromedia (FireWorks, Flash, Director), dan sebagainya.

Pada bab yang lalu, kita telah mengenal Core/DRAW dan
mempraktikkan beberapa desain sederhana. Pada pembahasan
kali ini, kita akan membuat desain grafis lebih lanjut
menggunakan aplikasi grafis CorelDRAW.

Membuat Desain Tingkat Lanjut dengan
CorelDRAW

Pada bab kedua ini, kita akan lebih jauh mengenal Corel DRAW
dan mempraktikkan tool-tool lain yang belum kita gunakan
sebelumnya dengan membuat poster dan kartu undangan. Kita
juga akan menggabungkan citra vektor dengan citra bitmap.

1. Membuat Poster

Poster yang akan kita buat saat ini bertemakan “Anti Narkoba”.
Contoh poster yang akan dibuat seperti gambar 2.1

Jangan biavkan hidupru

Gambar 2.1
Contoh poster “Anti Narkoba”.

BAB 2 Dasar Vektor I




Gambar 2.2
Cara melengkungkan rusuk
persegi panjang

Gambar 2.3
Hasil objek setelah
dipotong dengan knife tool

Gambar 2.4
(a) Cara menghilangkan garis.
(b) Hasil objek

Namun, tidak seperti latihan-latihan sebelumnya, di bab ini
kami hanya akan memberi tutorial tentang pembuatan objek.
Masing-masing dari kalian dapat berkreasi dan menyusun hasil
karya kalian sesuai dengan kreatifitas dan keinginan kalian.

Jadi, seperti terpampang di contoh poster pada gambar 2.1,
kalian akan mengikuti cara membuat kapsul, tablet, dan jarum
suntik saja.

a.
1.

Membuat Kapsul

Buatlah sebuah persegi panjang dengan perbandingan sisi
2:1.

. lengkungkan rusuk persegi panjang tersebut menggunakan

shape tool.

D

. Potong persegi panjang tersebut menjadi dua menggunakan

knife tool. usahakan potongan 1 sedikit lebih panjang seperti
pada gambar?2.3.

. Isi warna potongan 1 dengan warna orange. Kemudian isi,

warna potongan 2 dengan warna hitam. Hilangkan warna
garis pada kedua potongan.




5. Untuk membuat kesan nyata pada objek kapsul yang akan
kita buat, kita perlu mengubah potongan 2 menjadi sedikit
lebih ramping sehingga timbul kesan potongan 2 masuk di
dalam potongan 1. Hasilnya bisa dilihat pada gambar 2.5

6. Objek tersebut sudah hampir jadi. Ada satu langkah lagi
yang perlu dilakukan agar objek tersebut terlihat seperti
objek 3 dimensi. Untuk itu, kita hanya akan memanipulasi
pada bagian warna saja. Pilih potongan 1, kemudian pilih
Sfountain fill dialog pada flyout fill. Setelah itu, akan muncul
kotak dialog seperti pada gambar2.7.

O

Gambar 2.5 Gambar 2.6
Objek kapsul setelah Fountain fill dialog
potongan 2 diperkecil

Gambar 2.7 Gambar 2.8
Kotak dialog fountain fill Jendela fountain fill
setelah color blend

dipilih custom

Lihat option, ubah nilai edge menjadi 270. Lihat color blend,
kemudian pilih custom. Setelah itu, jendela akan sedikit
berubah menjadi seperti berikut.

Letakkan mouse di tengah-tengah kedua kotak kecil di atas
persegi berwarna. Klik di tempat itu sampai muncul tanda
segitiga, kemudian atur position menjadi 50, seperti terlihat
pada gambar 2.9.
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Gambar 2.9

Color blend untuk
membuat titik gradasi
tambahan

Gambar 2.10
Pengaturan warna

Gambar 2.11
Hasil akhir objek kapsul

I TIK SMA Kelas XII

Kita lihat pada gambar 2.9, terdapat tiga tanda, yaitu dua buah
kotak dan satu buah segitiga. Jika kita ingin memilih warna di
pojok kanan, kita harus menekan mouse di bagian kotak kecil
yang paling kanan sampai kotak itu berubah warna menjadi
hitam. Demikian juga ketika kita akan memilih warna di tengah
atau di bagian kiri. [tulah kegunaan tanda-tanda tersebut.

Sekarang, ubahlah warna di bagian kanan sama dengan warna
di bagian kiri (orange). Kemudian, klik bagian tengah (tanda
segitiga), lalu ubah warnanya menjadi orange yang lebih tua.

i

Kemudian, tekan tombol OK. Lakukan juga langkah-langkah
di atas pada potongan 2, tetapi dengan warna yang berbeda
yaitu perpaduan atara warna hitam dan abu-abu. Hasilnya akan
terlihat timbul seperti pada gambar 2.11.

Kalian bisa memperbanyak kapsul tersebut tanpa membuat
dari awal. Caranya, lakukan grouping pada objek kapsul
tersebut, kemudian tekan Ctrl+C, lalu tekan Ctrl +V atau
dengan cara klik kanan pada objek. Langkah berikutnya klik
copy, kemudian klik kanan kembali, lalu pilih paste. Dengan
melakukan langkah tersebut berikut, objek akan terduplikasi.
Hanya saja, kadang mereka tertumpuk sehingga objek baru
yang terbentuk tidak terlihat. Kalian hanya perlu menggeser
objek tersebut menggunakan pick foo/ untuk melihat hasilnya.




b. Membuat Tablet.

1. Buatlah sebuah lingkaran kecil dengan ellipse tool. Jangan
lupa menekan tombol Ctrl agar diameternya sama.

2. Isidengan warna abu-abu pada lingkaran yang terbuat.

3. Pilih interactive extrude tool untuk membuat objek
lingkaran tersebut menjadi 3 dimensi (3D). Kemudian, tarik
titik kecil di atas lingkaran ke kiri bawah sehingga terbentuk
objek 3D.

Q Gambar 2.12

Interactive Extude Tool

Internet Link

Jika kalian ingin belajar Core/DRAW melalui internet,
kalian dapat membukanya di
http://designer-info.com/Draw/corel_draw_tutorial.htm

Gambar 2.13
Cara membuat objek
menjadi 3 dimensi

4. Langkah selanjutnya adalah membuat fablet kita mendatar.
Caranya, klik tanda silang di tengah-tengah objek dengan
interactive extrude tool. Kemudian, akan muncul lingkaran
hijau di sekitar objek. Untuk mengatur sudut pandang
objek, letakkan mouse pada daerah di dalam lingkaran.
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Sedangkan untuk memutar objek, letakan mouse di salah
satu segitiga hijau, kemudian putar objek sampai memenuhi
kondisi yang diinginkan.

O
=]

Gambar 2.14
(a) Posisi peletakan pointer

untuk memunculkan lingkaran.
(b) Gambar objek yang siap
diputar.

(c) Proses pemutaran objek.

(d) Hasil objek setelah diputar. e 0

5. Ubah warna garis menjadi abu-abu muda (lebih muda
daripada warna isi). Ubah pula ketebalan garis sebesar 0.5
mm.

6. Perbanyak objek dengan cara yang sama seperti cara
memperbanyak objek kapsul. Atur posisi objek sehingga
timbul kesan alami.

7. Tambahkan garis di tengah-tengah objek. Buatlah garis
dengan freehand tool, atur warna garis sama persis dengan
warna garis pada tablet. Ubah ketebalan garis menjadi
0.7mm. Letakkan garis tersebut di tengah-tengah tablet
yang telah kita buat tadi. Kemudian, lakukan grouping agar
objek menjadi satu kesatuan.

Gambar 2.15 Gambar 2.16 Gambar 2.17
Bentuk objek setelah diubah Hasil penduplikasian objek Hasil akhir objek tablet
warna dan ketebalan garisnya.

c. MembuatJarum Suntik

1. Buatlah sebuah persegi panjang dengan ukuran 0.5 x 0.9 cm.
Isi dengan warna putih

2. Buatlah persegi panjang kedua dengan ukuran 6 x 1 cm. Isi

dengan warna putih.




3. Buatlah persegi panjang ketiga dengan ukuran 6x 1.5 cm.

4. Gabungkan ketiga persegi seperti Gambar 2.18

gambar 2.18. Penggabungan ketiga
persegi panjang

5. Buatlah ellipse dengan ukuran 0.8 x 2.6 cm. Isi dengan
warna putih.

6. Buatlah persegi panjang dengan ukuran 0.5 x 1 cm. Isi
dengan warna putih.

7. Buatlah ellipse dengan ukuran 0.6 x 1.8 cm. Isi dengan
warna putih.

8. Susun objek-objek tersebut seperti gambar 2.19.

9. Buatlah lengkungan di ujung persegi rusuk persegi dengan
shape tool. Lihat gambar 2.20.

10.Potong badan jarum suntik dengan knife tool sehingga

menjadi dua bagian, kemudian isi warna persegi sebelah
kiri menjadi warna hitam. Lihat gambar2.21.

\j@ o

Gambar 2.19 |
Gambar 2.20 ' .
Letak penyusunan Uju:;-lujau;g yang 0 |
objek-objek

dilengkungkan
L H e Gambar 2.21
11. Buat lengkquan pgda sisi persegi sebelah k1r¥ (a) Bagian objok vang dipoiong
menggunakan interactive envelopes tool untuk memberi menjadi dua bagian.

efek 3 Dimensi pada objek. Lihat gambar 2.22. (b) Hasil objek setelah potongan,
bagian kiri diisi dengan
warna hitam.

12. Buatlah objek jarum dengan rectangle tool berukuran
3x1lcm.

13. Kemudian, letakkan objek di ujung sebelah kiri. Lihat

gambar 2.23
Gambar 2.22 Gambar 2.23
Bagian objek yang sisinya Posisi peletakan Objek

dilengkungkan menggunakan
interactive envelopes tool.
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14. Agar jarum tidak terlihat janggal, letakkan objek tersebut
dibelakang badan jarum suntik. Lihat gambar 2.24.

15. Buatlah ujung jarum menjadi runcing. Caranya, klik kanan
pada objek jarum, kemudian pilih convert to curves.

Kemudian, pilih shape tool, lalu tarik ujung kanan objek ke
kanan. Lihat gambar 2.25.

) ~—a—)

Gambar 2.24
Hasil Jarum suntik setelah objek
Jarum diletakkan di belakang
badan jarum suntik.

Gambar 2.25
Hasil akhir jarum suntik setelah
ujungnya diruncingkan.

16. Warnai jarum suntik dengan warna hitam.

O

17. Buatlah garis pengukur pertama dengan 3 point curve tool.
Caranya:

» Klik mouse di satu titik.
» Tarik ke bawah sepanjang 1 cm (lihat penggaris di

Gambar 2.26
3 Point Curve Tool

3 sebelah kiri).
» Lepaskan mouse.
5 » Geser ke kiri kurang lebih 0.2 cm (lihat penggaris di
bagian atas).
Gambar 2.27 » Klik mouse kembali.
(1) Titik pertama, Lihat gambar2.27

(2) Titik mouse dilepaskan,

(3) titik mouse 18. Duplikasikan kurva tersebut (dengan cara copy dan paste).

setelah digeser ke kiri

19. Hapus setengah bagian untuk kurva pertama, kemudian
hapus 3/4 bagian untuk kurva kedua menggunakan eraser
tool. Lihat gambar 2.28 dan 2.29

/
Q 2] / (0]

Gambar 2.29
Gg:;lsb;rtifls (a) kondisi kurva sebelum
(b) kondisi kurva setelah
dihapus dengan eraser tool
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20. Klik kurva yang pendek, duplikasikan sebanyak tiga kali.
Caranya tekan Ctrl+C, kemudian tekan Ctrl+V sebanyak
tiga kali.

21. Geser hasil penduplikasian di sebelah kanan kurva yang
sebelumnya. Lihat gambar 2.30a.

22. Dari hasil langkah 21, duplikasikan kurva tersebut
sebanyak tiga kali. Untuk memudahkan penduplikasian,
Letakkan hasilnya di sebelah kanan objek sebelumnya .
Tambahkan sebuah garis panjang di sebelah kanan
sehingga menghasilkan gambar 2.30b.

///// /////////////////////

Gambar 2.30a. Gambar 2.30b
Hasil penduplikasian dan Hasil penduplikasian dan
penyusunan kurva penyusunan kurva dari gambar

4. Letakkan hasil dari langkah 22 ke badan jarum suntik. Lihat
gambar?2.31.

' Gambar 2.31

Hasil akhir jarum suntik

Tips and Trick

1. Untuk menyusun poster yang enak dipandang, gunakan warna yang senada
dan serasi.

2. Untuk menarik perhatian dan memberi tanda pada bagian yang ingin
ditonjolkan, kalian dapat menggunakan huruf yang lebih besar atau warna
yang mencolok.

3. Isibagian yang kosong dengan objek-objek atau asesoris yang lain.
Mintalah pendapat pada orang lain sehingga poster kalian semakin indah.

4. Carilah ide dengan banyak melihat poster-poster yang terpampang di jalan.
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Tugas 1

1. Setelah kalian selesai membuat ketiga objek tersebut (kapsul, tablet, dan

jarum suntik), buatlah poster dengan tema “Anti Narkoba

2

menggunakan ketiga objek tersebut.
Kalian bisa menduplikasi objek, memutar dan menyusun objek sesuai
dengan keinginan kalian, ataupun menambahkan objek lain ke dalam poster

tersebut.

2. Tambahkan teks ke dalam poster tersebut sehingga pesan yang kalian
inginkan lewat poster tersebut dapat tersampaikan dengan lebih mudah.

3. Buatlah kesepakatan dengan teman-temanmu untuk mengadakan lomba
desain poster dari tugas ini dan memberi hadiah bagi pemenangnya.

Gambar 2.32
Contoh kartu undangan
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2. Membuat Kartu Undangan

Kalian pasti sering menerima undangan. Satu kartu undangan
dengan yang lain mempunyai desain yang berbeda. Bahkan
kadang mempunyai tema tersendiri yang membedakannya
secara konsep.

Coba lihat gambar 2.32. Di sana terlihat dua buah kartu
undangan dengan desain dari konsep yang berbeda.
Kebanyakan anak-anak menyukai bentuk undangan dengan
desain yang lucu, sedangkan untuk orang dewasa lebih
menyukai desain yang elegan. Karenanya, banyak kartu
undangan pernikahan dibuat dengan
desain yang elegan.

Untuk praktikum kita kali ini, kita
akan belajar membuat desain lucu
kartu undangan empat sisi untuk
keperluan ulang tahun seperti desain
di atas (sebelah kanan). Seperti
pertemuan sebelumnya, kalian bisa
memberi tambahan variasi seperti keinginan kalian. Jadilah
kreatif!

a. Bagian Depan

1. Bukaprogram CorelDRAW 12, kemudian atur kertas dengan
ukuranAS.

2. Buatlah persegi panjang dengan posisi tegak berukuran
kurang lebih 9.5 x 13.5 cm. atur garis dengan ketebalan
l.4mm kemudian berilah warna sesuai dengan
keinginanmu.

3. Buatlah teks bertuliskan “Undangan” dengan ukuran 72.
Gunakan tipe huruf berukuran tebal (contohnya: arial
black).




4. Klik kanan pada teks menggunakan pick tool, kemudian
pilih convert to curves.

5. Klik kanan kembali pada teks, kemudian pilih break curves
apart. Langkah 4 dan 5 dilakukan untuk memecah suatu
objek menjadi per bagian sehingga kita bebas mengubah
tiap huruf. Untuk memecah objek menjadi per bagian,
hanya bisa dilakukan ketika objek tersebut merupakan
sebuah kurva. Oleh sebab itu, pada langkah ke-4 kita
mengubah objek teks tersebut menjadi kurva terlebih
dahulu.

6. Setelah langkah 5 dilakukan, ubah warna huruf menjadi
sembarang warna yang kalian suka. Kita akan mendapati
huruf-hurufyang kehilangan ‘lubang’ nya, seperti huruf ‘a’,
‘d’, ‘g’, dan yang lain. Sebenarnya, ‘lubang’ tersebut tidak
hilang, tetapi tertumpuk. Oleh sebab itu, geser huruf-huruf
tersebut satu per satu sehingga kita bisa melihatnya.
Kemudian, pilih semua lubang dengan pick fool. Klik kanan
pada mouse, kemudian pilih order, pilih in front of layer.
Kemudian, kembalikan lubang-lubang tadi ke atas badan
huruf. Ubah warna lubang menjadi berbeda dengan warna
dasar badan huruf atau boleh langsung diberi warna putih.

O | Undangan

O Undangan: - - -

© (Undangan

Gambar 2.33 Gambar 2.34
Break curve apart (a) Hasil teks setelah dilakukan break apart.

(b) Hasil teks setelah dipisahkan antara lubang dan badan huruf.
(c) Hasil teks setelah lubang dikembalikan ke badan teks
dan warna lubang di ubah.

7. Berilah warna yang berbeda pada tiap huruf. Setelah itu,
kalian dapat melakukan grouping agar huruf dan
‘lubang’nya menjadi suatu kesatuan objek.

8. Setelah itu, atur huruf-huruf tersebut ke tempat dimana
kalian ingin menempatkannya. Kalian juga bisa
memperbesar atau memperkecil, juga memutar huruf-huruf
tersebut agar menjadi lebih indah atau menambah bayangan
seperti contoh pada gambar 2.35.
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Gambar 2.35

9. Buatlah sebuah kurva dengan freehand tool. Atur ketebalan

garisnya, kira-kira 1.4 mm. Lihatcontohpada gambar2.36.

10.Pilih text tool, kemudian letakkan pointer ke kurva yang

telah kalian buat tadi sampai terdapat sebuah garis
melengkung kecil pada pointer. kemudian klik mouse.
Buatlah teks yang mengikuti alur garis tersebut.

(2]

Contoh penyusunan huruf

dalam kartu undangan.

Gambar 2.37

Contoh Posisi penempatan
identitas penerima

kartu undangan

Gambar 2.38
Artistic Media Tool.

(o)

Gambar 2.36
(a) Hasil pembuatan kurva.
(b) Hasil teks yang mengikuti alur kurva.

11. Berilah tempat untuk menuliskan alamat teman yang akan
menerima undangan. Kalian dapat membuat sebuah
persegi lagi dengan ukuran 12 x 5 ¢m , lalu letakkan di
bawah persegi panjang pertama. Kemudian, isikan nama
dan alamat penerima di dalamnya. Lihat gambar 2.37.

12. Agar kartu undangan ini lebih ramai dan menarik,

lericho Valentino
Jalan Pangeran Diponegro 25
Magelang

tambahkan gambar-gambar
menggunakan artistic media
tool. Caranya, pilih artistic
media tool, kemudian lihat
pada propertise bar. Pilih
sprayer (lihat gambar 3.38)
Tarik mouse pada lembar kerja
sehingga menghasilkan garis,
lalu lepaskan mouse. Maka,
dengan sendirinya gambar
akan terbentuk pada layar.

13. Setelah kita menambahkan gambar dengan artistic media

tool, letakkan gambar tersebut di belakang objek yang lain
dengan cara klik kanan pada objek, pilih order, lalu pilih 7o

O

back of page. Akhirnya, dapat
menghasilkan sebuah kartu
undangan yang indah seperti
gambar 2.39.



b. Bagian Dalam Pertama

Jika kita berbicara tentang bagian dalam, itu berarti kita
membuat halaman yang baru. Kalian tidak perlu membuat

halaman baru dalam file yang berbeda.
Namun, kalian dapat membuat halaman
baru di file yang kalian buat sekarang.

Untuk membuat halaman baru, lihat
bagian document navigator, kemudian
klik tanda +.

Setelah tombol tersebut ditekan, maka
di sebelah kanan page 1 akan muncul
page 2. Di lembar baru inilah kalian
dapat menuliskan isi dari bagian dalam
pertama.

Bagian dalam pertama dari sebuah kartu
undangan dapat berisi kata-kata
ungkapan syukur atau ajakan untuk
datang dalam pesta tersebut, atau bisa
jugaberisi kata-kata bermakna.

Gambar 2.39
Hasil bagian depan kartu
undangan

O

Gambar 2.40
Cara menambah halaman.

1. Buatlah sebuah teks untuk menggambarkan pesan tersebut.

Contohnya:

Satu tahun lagi telah kulewati.
Kini saatnya melangkah

di tahun yang baru.

Aku ingin melewatkannya

bersama kalian.

Aku ingin menyambut umurku
yang baru bersama kalian.
Datanglah menemaniku
dan bersukacita bersamaku.

Letakkan teks di bagian dalam kartu undangan. Kemudian,
atur ukuran dan warnanya sesuai dengan keinginanmu.

2. Buatlah teks tersebut rata tengah.

kemudian tekan Ctrl+E.

3. Buatlah teks tersebut lebih indah
dengan mengatur tipe hurufnya.

. Kemudian, hiasi halaman tersebut
dengan gambar-gambar pada artistic
media tool atau dengan objek-objek
seperti rectangle tool, ellipse tool,
atau basic shapes.

Contoh bagian dalam yang sudah
selesai bisa kalian lihat pada gambar
2.41.

Caranya blok teks,

BAB 2 Dasar Vektor

Gambar 2.41
Contoh bagian dalam
pertama
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Gambar 2.42
Contoh desain bagian
dalam kedua

Gambar 2.43
Klik Pagel untuk
melihat halaman 1

I TIK SMA Kelas XII

c.Bagian Dalam Kedua.

Bagian dalam kedua biasanya berisi informasi tentang
diadakannya pesta. Baik tempat, waktu, maupun informasi
lain. Tidak menutup kemungkinan juga diberikan teks lain

dalam halaman ini.

1. Buatlah halaman baru seperti yang kalian buat sebelumnya
padabagian dalam pertama.

Untuk menyambut umurku yang baru,
aku akan mengadakan pesta perayaan.
Datanglah untuk memeriahkan pesta ulang
tahunku
yang akan diadakan pada:

Hari/tanggal:13 Agustus 2009
Tempat: Delicious Resto
Jalan merapi indah 28
Yogyakarta
Pukul: 18.00 WIB
Dresscode: Colorful

Aku sangat menantikan kehadiranmu.
Datang dan ramaikan pestaku.
Terimakasih.

2. Buatlah teks dengan text tool
yang mencakup informasi-
informasi diadakannya pesta
ulang tahun, contohnya
seperti disamping.

3. Letakkan teks yang telah
kalian buat di halaman yang
baru, kemudian atur tipe
huruf dan tata letak dari teks
tersebut.

4. Warnai kata-kata dalam kartu undangan kalian dengan
warna yang bermacam-macam sehingga menjadikan kartu
ini lebih menarik. Hiaslah halaman tersebut seperti kalian
menghias halaman-halaman sebelumnya.

6. Contoh bagian dalam kedua yang sudah selesai dapat kalian

lihat pada gambar 2.42.

i E %
3 Intuk menyambyit ymugktiyang baru,

aku akan mengadakan pesta perayaan.

Pukul
Tema

d. Bagian Belakang

Bagian belakang dalam sebuah
kartu undangan biasanya hanya
berisi desain ringan sebagai
pelengkap agar halaman
belakang ini tidak kosong.
Bagian belakang biasanya juga
berhubungan atau setema dengan
bagian depan.

1. Tambahkan halaman baru
yaitu halaman ke-empat
dalam file kita.

2. Coba lihat bagian depan kartu

undangan. Caranya klik bagian yang bertuliskan page 1.

O




3. Kemudian klik bagian kurva yang kita buat sebelumnya
beserta tulisannya. Lakukan duplikasi dengan cara copy,
kemudian kembalilah ke halaman 4. Lalu, lakukan paste di
sana.

4. Gunakan pick tool untuk membalik kurva tersebut, lalu
letakkan sejajar dengan bagian depan sehingga terlihat
bersambung. Lihat gambar 2.44.

5. Setelah kurva selesai dibalik, buatlah teks yang melalui
jalur kurva tersebut dengan tulisan yang sepadan dengan
bagian depan.

6. Hias bagian belakang dengan desainmu sendiri seperti
halaman-halaman sebelumnya.

(2]
@ and | will Happy
f you
° Gambar 2.45
Gambar 2.44 Contoh teks Gambar 2.46
(a) Titik yang digeser ke kiri untuk Contoh desain bagian
membalik kurva belakang

(b) Cara membalik kurva.
(¢) Hasil kurva setelah dibalik

e. Mencetak Kartu Undangan

Untuk mencetak kartu undangan, kita dapat langsung
mencetaknya sebagai sebuah buku. Jadi, dengan kata lain kita
tidak perlu mencetaknya satu persatu.

Caranya:
1. Bukamenu file.

2. Print preview, kemudian akan muncul sebuah jendela baru.
3. Pilihimposition layout tool.

O

Gambar 2.47 Gambar 2.48
Print Preview Imposition layout tool

BAB 2 Dasar Vektor




4. Pilih boklet untuk membuat tampilan kartu undangan kita

menjadi berbentuk buku.

5. Untuk melihat tampilan kartu undangan kita, pilih kembali

picktool padajendela print preview.

O

Gambar 2.49
Booklet

Gambar 2.50
Pick tool

Kalian lihat bahwa tampilan kita sudah menjadi suatu kesatuan
kartu undangan sehingga kita bisa mencetak perhalaman
dengan mudah.

Jika masih ada kesalahan posisi, kalian juga bisa mengubah
posisi atau letak objek menggunakan pick tool.

Gambar 2.51
(a)Bagian sampul kartu undangan
(b) Bagian dalam kartu undangan
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Untuk mencetak kartu undangan, tekan print pada toolbar
atau tekan Ctrl+P.

Gambar 2.52

Print

Tugas 2

1. Buatlah kartu ucapan untuk temanmu yang berulang tahun ke-
17 dengan posisi kartu yang membentuk tenda.

2. Tulislah di kertas bagaimana cara kalian mencetak kartu
undangan tersebut.

Menggabungkan Gambar Vektor dan Bitmap

Pada bab pertama, kita telah mengenal dua macam format citra,
yaitu format vektor dan bitmap. Gambar yang dihasilkan
dengan program CorelDRAW akan menghasilkan gambar
dengan format vektor. Akan tetapi, perlu kalian ketahui bahwa
kita dapat memasukkan gambar dengan citra bifmap atau
mengubah gambar berformat vekfor menjadi bitmap
menggunakan CorelDRAW. Oleh sebab itu, kita bisa
memasukkan foto dan gambar dengan format lain ke dalam
lembar kerja kita. Hanya saja, gambar dengan format bitmap
tersebut tetap tidak akan berubah menjadi format vektor.

Untuk mempelajari cara mengambil dan membuat
penggabungan antara format vektor dan bitmap, kita akan
menghias foto dengan Core/DRAW.

1. Menghias Foto

1. Siapkan sebuah file foto yang kalian sukai. Foto tersebut bisa

berupa foto pribadi maupun pemandangan.

2.Bukalah CorelDRAW 12 pada komputermu.

3.

4.

Aturlah ukuran kertas menjadi A3 dengan posisi mendatar
atau landscape.

Ambillah file foto yang telah kalian siapkan sebelumnya.
Untuk mengambil file tersebut.

Klik menu file, kemudian pilih

import atau tekan Ctrl+I.

Sesudah itu, akan muncul

sebuah kotak dialog. Temukan

file yang kalian simpan, lalu

tekan import. (2] 0

Gambar 2.53
(a) Import
(b) Jendela import
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Gambar 2.57
Hasil pengolahan gambar
bitmap dengan Corel DRAW.

5. Sesuaikan ukuran foto kalian dengan lembar kerja. Jika
resolusi foto yang dimasukkan kecil, jangan diperlebar
karena akan mengakibatkan foto tersebut pecah. Kalian bisa
menyiasatinya dengan memasukan lebih dari satu foto yang
berbeda. Akan tetapi, jika foto kalian mempunyai resolusi
yang besar, kalian boleh memperkecilnya.

6. Sesudah kalian menyusun foto-foto tersebut, beri variasi
terhadap foto tersebut. Misalnya, memberi bayangan atau
menghias foto tersebut sesuai dengan tema foto yang kalian
buat.

Gambar 2.54 Gambar 2.55
Contoh penyusunan foto Contoh foto yang telah diberi variasi
7. Kemudian, kalian bisa memberi variasi tambahan berupa
teks yang dapat memberi informasi tambahan tentang foto
tersebut.

Contoh pengolahan foto dengan CorelDRAW bisa dilihat pada

gambar 2.57.

Simpan foto kalian dengan cara save, kemudian buka file
tersebut lewat windows exploler.
Klik dua kali dengan mouse
kalian, lalu bandingkan hasilnya
dengan gambar dengan format
bitmap yang diklik dua kali juga.
Apa yang terjadi?Apa
perbedaannya? Pastilah gambar
hasil pengolahan menggunakan
CorelDRAW (.CDR) hanya bisa

dibuka dengan software CorelDRAW. Akan tetapi, gambar

dengan format bitmap (JPEG / .JPG) dapat dilihat tanpa harus

menggunakan Sofitware CorelDRAW.

Untuk itu, kita akan belajar menyimpan gambar tersebut
dengan format bitmap.

8. Klik menu file, kemudian pilih export. Lalu, setelah muncul
sebuah kotak dialog, lakukan penyimpanan seperti biasa.
Tekan exportuntuk mengakhiri.

9. Setelah tombol export ditekan, akan muncul kotak dialog,
convert to bitmap. Di sini kalian bisa mengatur ukuran dan
melakukan pengaturan lain terhadap file bitmap yang akan
dibuat. Tekan OK jika pengaturan sudah dirasa cukup.




2] [ o]

Gambar 2.58 Gambar 2.59
(a) Export Kotak dialog convert to bitmap
(b) Jendela export

10. Kemudian, akan muncul kembali sebuah kotak dialog
JPEG Export. Di sini, kalian dapat mengatur hasil gambar
yang akan dihasilkan seperti menghaluskan gambar atau
melakukan kompresi pada gambar sehingga ukuran file
menjadi lebih kecil. Jika kalian tidak mau mengubah
pengaturan apapun, tekan OK.

Dengan melakukan proses seperti di atas, kalian akan

mendapatkan sebuah file gambar berformat bitmap. Gambar 2.60
Kalian dapat membuka gambar tersebut tanpa harus  Kotak dialog JPEG Export
menggunakan software CorelDRAW.

Tugas 3

Buatlah frame foto sesuai
dengan kreatifitasmu.
Sebagai contoh, bisa kalian
lihat pada gambar 2.61.

File contoh ini dapat kamu
unduh (download) dari CD
lampiran dengan nama:
[Drive]:\lampiran\bab2\tuga
s3.cdr

Gambar 2.61
Contoh frame foto




Sekilas Info

Sejarah Pembangunan CoreIDRAW

Pada 1985, Dr. Michael Cowpland mendirikan Corel untuk menjual sistem
desktop-publishing berbasis Intel.

Pada 1987, Corel merekrut beberapa pengembang software (programmer)
untuk membangun sebuah software grafis berbasis vektor untuk dijadikan satu
dengan paket desktop-publishing Corel. Program itu, akhirnya diberi nama
CorelDraw, pertama kali diluncurkan pada tahun 1989. Program itu diterima
luas oleh masyarakat dan pada akhirnya corel hanya focus pada pengambangan
software.

CorelDraw dibuat untuk Windows  bersamaan dengan diluncurkanya
Windows 3.1. Dengan dimasukkannya TrueType Font ke dalam Windows 3.1
menjadikan Corel sebagai program ilustrasi yang mampu menggunakan fonts
yang ada tanpa membutuhkan software tambahan seperti Adobe TypeWriter.

Sumber : http://di2tdrifter.wordpress.com/2008/03/29/coreldraw/

ngkum
Q° %

1. Pada saat membuat vektor lingkaran, saat menekan tombol Ctrl dapat
membuat diameternya sama.

2. Interactive extrude tool dapat membuat sebuah objek menjadi 3 dimensi (3D).

3 Shape tool digunakan untuk membuat lengkungkan rusuk persegi panjang.

4. Knife tool digunakan untuk memotong gambar menjadi beberapa bagian.

5. Untuk membuat lingkaran, gunakan ellipse tool. Agar diameternya sama,
Jangan lupa menekan tombol Ctrl.

6. Untuk memperbanyak suatu gambar, tekan tekan Ctrl+C kemudian tekan Ctrl

+V.
7. Untuk membuat garis dan kurva, gunakan freehand tool.
Untuk menyimpan gambar, klik menu file, kemudian pilih export. Lalu,
setelah muncul sebuah kotak dialog, lakukan penyimpanan.

go




A. Pengecekan Konsep
Pilihlah salah satu jawaban yang paling benar!

© 7ol yang dapat digunakan untuk @ Tool dalam jendela print preview yang

membuat gradasi warna adalah. ..
a.Smartfill tool

b. Fill color dialog

c. Fountain fill dialog

d. Outline tool

Tool yang diperlukan untuk membuat
hiasan artistik adalah ...

a. Freehand tool

b. Artistic media tool

¢. Smart drawing tool

d. Banner shapes

Bagian jendela CorelDRAW yang bisa
digunakan untuk membuat halaman
baru adalah ...

a. Toolbar

b. Document navigator

c. Status bar

d. Propertise bar

Sebuah text dapat dibuat menjadi rata
tengah. Tombol yang dapat melakukan
fungsi tersebut adalah ...

a. Ctrl+R

b. Ctrl+L

c. Ctrl+C

d. Ctrl+E

Berikut ini merupakan tiga contoh
satuan ukuran yang disediakan oleh
program CorelDRAW  kecuali. ..

a. Decimeters, points, didots

b. Points, didots, feet

c. Feet, kilometers, inches

d. Yards, inches, pixels

memperbolehkan kita mencetak lebih
dari satu halaman dalam selembar
kertas adalah ...

a. Set layout tool

b. Imposition layout tool

c. Mark placement tool

d. Picktool

Untuk mengambil gambar dengan
format lain ke dalam lembar kerja
CorelDRAW, kita bisa menggunakan
fungsi. ..

a.Open

b. Export

cImport

d. Revert

Ketika seseorang ingin membuat
kubus dari sebuah persegi, tool yang
harus ia gunakan adalah ...

a. Interactive drop shadow tool

b. Interactive blend tool

c.3Dtool

d. Interactive extrude tool

Fungsi yang digunakan untuk
memperlihatkan hasil pekerjaan
sebelum dicetak adalah ...

a. Print preview

b. Print

c. Open

d. Print setup

Tipe file berformat vektor yang
dihasilkan oleh sofiware Corel DRAW
adalah ...

A.CDR

b.JPG

c.JPEG

d.PSD

BAB 2 Dasar Vektor
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B.

Pemahaman Konsep

Jawablah pertanyaan di bawah ini!

(1)
2]

0 06 606 60

S/

C.

Buatlah gambar di bawah ini dengan
menggunakan Corel Draw.

Jelaskan fungsi dari break curve apart.

Bagaimana cara membuat suatu teks mengikuti bentuk dari sebuah kurva seperti
pada gambar di bawah?

Jelaskan cara memasukkan gambar dengan format bitmap!

Jelaskan langkah-langkah penyimpanan gambar dalam format bitmap!
Jelaskan perbedaan Eraser tool dan Knife tool!

Jelaskan cara melakukan duplikasi pada sebuah objek!

Artistic media tool mempunyai lima macam bentuk penggunaan salah satunya
adalah Sprayer. Sebutkan empat macam lagi dan analisislah kegunaannya!

Sebutkan empat macam tipe gradasi yang bisa digunakan untuk mewarnai objek!
Sebutkan kelima fungsi dari properties bar dibawah ini!

a b c d e

Fill tool mempunyai 5 macam jenis pewarnaan. Sebutkan fungsi kelima jenis
pewarnaan tersebut!

Aktifitas Siswa

Simpanlah dan beri nama:
[namamu]-Bab2.cdr.




Tujuan Pembelajaran:

~ KATA KUNCI |

B Photoshop
B Channel
B Option Bar

B Layer
B Opacity
B Pixels

Setelah mempelajari bab ini diharapkan
siswa mampu:

1. Memahami dan mengetahui spesifikasi
dan kegunaan Photoshop.

2. Mengetahui komponen-komponen pada
Photoshop.

3. Mengerti dan mampu membuat kreasi
desain dengan Photoshop.

Amatilah gambar disamping, kemudian
cari perbedaan antara satu burung dengan
burung yang lain. Apakah ada bedanya?
Semua burung tersebut tidak mempunyai
perbedaan karena sebenarnya hanya ada
satu gambar burung dan gambar burung
tersebut dimanipulasi sedemikian rupa
sehingga terlihat seperti terdapat beberapa
burung. Menarik bukan? banyak hal lain
yang dapat kita lakukan dengan
menggunakan Photoshop. Tidak hanya
seperti contoh gambar disamping.

B Tool Box B Pallete
B Zoom In B Marge Down
B Zoom Out B Marge Visible



Peta konsep

Mengenal Toolbox

Aplikasi
Photoshop

Pallete

Mengenal
Lingkungan




Mengenal Aplikasi
Photoshop

Pemahaman dan Kegunaan Photoshop

Photoshop adalah sebuah aplikasi yang digunakan untuk
membuat atau memodifikasi gambar. Sampai saat ini,
Photoshop masih menjadi aplikasi yang paling banyak
digunakan dalam hal image editor. Versi terbarunya adalah
Adobe Photoshop (CS4, tetapi untuk saat ini kita akan
menggunakan Adobe Photoshop 7.0.

Untuk membuka aplikasi Photoshop,
klik tombol Start, kemudian pilih A/l
Program dan klik Adobe Photoshop
7.0. Atau jika kalian belum memiliki
Adobe Photoshop 7.0, kalian dapat
melakukan instalasi terlebih dahulu.

Setelah kita mengetahui apa itu
Photoshop, lalu apa kegunaannya?
Pada dasarnya, Photoshop digunakan
untuk melakukan manipulasi gambar
atau image, manipulasi itu meliputi
manipulasi teks, manipulasi benda, dan
juga manipulasi foto. Dalam kehidupan
nyata, photoshop digunakan untuk
membuat poster, membuat design
background sebuah halaman web, edit

foto, dan masih banyak lagi.
Gambar 3.1
Membuka Adobe Photoshop 7.0

Tahukah Kamu

Adobe Photoshop 7.0 adalah aplikasi yang dapat berjalan pada Sistem Operasi
Windows dan Machintos. Untuk menjalankan aplikasi ini kalian harus
memenuhi spesifikasi yang disarankan, yaitu:

» Prosesor minimal Intel Pentium III

» RAM minimal 256 MB

» Kapasitas kosong pada Harddisk paling tidak 120 MB

o BAB 3 Mengenal Aplikasi Photoshop Im




Gambar 3.2

Contoh poster yang
menggunakan

Adobe Photoshop 7.0

Ayo Cari Tahu

Soal 1

1. Jelaskan apa yang
kamu ketahui tentang
photoshop!

Penerapan aplikasi photoshop dalam kehidupan kita sangat banyak sekali. Ayo
cari contoh poster atau apapun yang menggunakan Adobe Photoshop. Jika
kalian sudah menemukannya, kalian simpan itu dalam komputer atau rak buku
kalian, nanti setelah kita mempelajari Photoshop lebih lanjut kalian dapat coba
membuat poster atau apapun yang telah kalian simpan tadi, oke.

Mengenal Lingkungan Photoshop 7.0

Seseorang yang akan membangun sebuah rumah pasti akan
melihat serta mempelajari lingkungan di mana dia akan
membangun rumah tersebut. Begitu juga ketika akan
menggunakan program Photoshop, kita harus mempelajari
lingkungan dari Photoshop terlebih dahulu sebelum
menggunakannya lebih lanjut. Tentunya seorang yang telah
mempelajari lingkungan Photoshop akan menjadi lebih mudah

M;e’nu Bar Option Bar Palette Well

Toolbox

Gambar 3.3
Tampilan awal Adobe Photoshop 7.0

Palette

untuk membuat sesuatu atau
mengedit sesuatu daripada
orang yang belum
mempelajarinya.

Ada banyak ftool dan panel
yang akan kita pelajari saat
menggunakan Photoshop.
Pada sub bab ini kita akan
mempelajari bagian-bagian
penting pada Photoshop.
Berikut ini adalah tampilan
awal ketika kita membuka
aplikasi Photoshop 7.0.



Nama Keterangan
Berisi menu-menu atau perintah-perintah yang disediakan
Menu B Photoshop untuk menyimpan, memanipulasi gambar, dan lain-
enu ar lain. Pada Photoshop 7, menu bar terdiri atas Menu, Edit, Image,
Layer, Select, Filter, View, Window, dan Help.
Adalah panel-panel yang dapat kita gunakan untuk memonitor
Palette dan memodifikasi gambar.
Merupakan kumpulan fool-tool yang kita gunakan untuk
Toolbox membuat dan memanipulasi gambar atau teks.
Bar ini merupakan sarana baru untuk menampilkan peraturan
Option Bar tambahan/khusus dari foolbox yang dipilih atau aktif. Option

Barbaru diperkenalkan pada Photoshop 6.

Pallete yang terdapat pada Palette Well akan tetap digunakan
sewaktu-waktu, tetapi akan tersembunyi sehingga tidak
memakan tempat pada layar monitor.

Palette Well

Tabel Daftar tombol toolbar beserta fungsinya.

1. ToolBox

Kalian pernah melihat seorang dokter dengan membawa tas
dokternya? Atau pernah melihat tukang kayu dengan kotak
peralatannya? Atau seorang anak sekolah dengan ranselnya?
Mereka semua bekerja sesuai dengan profesi mereka masing-
masing dengan mengguna-
kan alat-alat yang ada di

tas/kotak mereka. Demikian

—>Menuju ke Adobe Online

. e M <« Move Tool
juga Photoshop memiliki aruee ——> ove 100

Lasso Tool€— —>Magic Wand Tool
Toolbox atau kotak peralatan, Crop Tool €— S Siice Tool
di sini tersedia semua alat- Healing Tool€— — S Paintbrush Tool
alat yang kalian perlukan Clone Stamp <— ——> History Brush Tool
untuk melakukan manipulasi Erasor Tool< 3 Gradient Too
. g <« —>Dodge Too
1mage. Nah’ pada saat ini kita Path Selection Tool €— —> Type Tool
akan melihat alat-alat apa Pen Tool €— —S Shape Tool
saja yang disediakan Annotation Tool €— —>Eyedropper Tool

Hand €— —>Zoom Tool

Photoshop untuk melengkapi
kita dalam melakukan
manipulasi image. Di
samping ini adalah gambar
Toolbox pada Photoshop 7
beserta keterangannya.

Foreground Color €—

——>Background Color

Gambar 3.4
Toolbox pada Photoshop 7.0
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Tahukah Kamu

Jika kalian perhatikan lebih teliti zool-fool pada Toolbox, kalian akan menemukan
perbedaan, ada beberapa foo/ dengan tanda panah hitam di ujung kanannya dan
adabeberapa tool yang tidak ada.

Tool dengan tanda hitam di ujung kanannya merupakan submenu dari too/
tersebut. Submenu dari foo/ digunakan untuk penggunaan yang lebih spesifik,
nanti kita akan pelajari.

Kalian dapat klik kanan pada tool yang terdapat submenunya.

Gambar Keterangan

Marquee Tool
Keduanya digunakan untuk melakukan selection / seleksi.

Move Tool
Digunakan untuk memindahkan suatu elemen-elemen, seperti
gambar, layer, dan garis.

Magic Wand Tool
Berfungsi untuk memilih daerah dengan warna yang sama.

Lasso Tool
Membuat seleksi dengan melakukan pemilihan yang berbentuk
bebas.

Polygon Lasso (Submenu dari Lasso Tool)
Digunakan untuk membuat seleksi dengan bentuk lurus.

Magnetic Lasso (Submenu dari Lasso Tool)
Menyeleksi sesuatu pada perbatasan pixel.

Crop Tool

Merupakan alat yang menyeleksi gambar berbentuk segiempat,
kemudian memotongnya dengan klik kanan di atas hasil seleksi,
lalu pilih crop.

Slice Tool
Digunakan untuk membelah gambar.

Slice Selection Tool (Submenu Slice Tool)
Untuk memilih belahan-belahan gambar.

Paintbrush Tool
Untuk menggambar seperti menggambar dengan kuas.




&

Pencil Tool (Submenu Paintbrush Tool)
Digunakan untuk menggambar dengan sisi yang tajam seperti
menggambar menggunakan pensil.

Healing Tool
Digunakan untuk memperbaiki gambar.

Patch Tool (Submenu dari Healing Tool)
Memperbaiki ketidaksempurnaan bagian gambar dengan sample
atau pola.

Clone Stamp Tool
Mengganda sebuah gambar.

Pattern Stamp Tool (Submenu Clone Stamp Tool)
Menggambar pola dengan menggandakan pola gambar yang lain.

History Brush Tool
Mengembalikan bagian image ke kondisi semula sebelum kita
melakukan paintbrush.

Art History Brush Tool (Submenu History Brush)
Mengembalikan bagian gambar ke kondisi awal.

Gradient Tool
Mengisi seleksi warna dengan warna gradient (campuran warna).

Paint Bucket Tool (Submenu Gradient Tool)
Mengisi seleksi dengan warna foreground.

Eraser Tool
Untuk menghapus area tertentu pada gambar kita.

Background Eraser Tool (Submenu Eraser Tool)
Menghapus bagian-bagian gambar sehingga menjadi transparan.

Magic Eraser Tool (Submenu Eraser Tool)
Menghapus suatu daerah warna menjadi transparan dengan 1 kali
klik.

Blur Tool
Mengaburkan sisi gambar yang tajam.

Sharpen Tool (Submenu Blur Tool)
Menegaskan atau menajamkan sisi gambar yang kabur.
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Smudge Tool (Submenu Blur Tool)
Meratakan atau mengaburkan bagian gambar tertentu.

Dodge Tool
Menerangi bagian-bagian gambar tertentu.

Burn Tool (Submenu Dodge Tool)
Menggelapkan bagian-bagian gambar tertentu.

— Sponge Tool (Submenu Dodge Tool)
| E‘:;J Mengubah saturasi warna pada daerah tertentu.

Type Tool
Untuk membuat huruf atau tulisan.

Vertical Type Tool (Submenu Text Tool)
Untuk membuat tulisan secara vertikal.

Path Selection Tool
Membuat pemilihan dengan bentuk bebas dengan bantuan titik,
garis, serta titik arah.

Pen Tool
Untuk menggambar path dengan sisi yang halus.

Free Form Pen Tool (Submenu Pen Tool)
Untuk menggambar path secara bebas.

Shape Tool
Digunakan untuk menggambar sebuah bantuk (segiempat, segi-
lima, dan lain-lain).

Eyedropper Tool
Mengambil warna dari gambar lain.

Color Sample Tool (Submenu Eyedropper Tool)
Untuk membuat sampel warna yang akan diambil.

Measure Tool (Submenu dari Eyedropper Tool)
Untuk menghitung jarak, lokasi, dan sudut.

Annotation Tool (Note)
Untuk membuat catatan pada gambar kita.




Annotation Tool (Suara)
Untuk membuat catatan berupa suara.

o Hand Tool
F Menggerakkan gambar dalam jendela gambar.

Zoom Tool
Untuk memperbesar atau memperkecil tampilan gambar.

Foreground dan Background Tool
Untuk mengatur warna foreground dan background.

Tips and Trick

Ada cara lain supaya kita dapat memilih submenu dari sebuah tool. Selain kita
dapat klik kanan pada tool tersebut, kita juga dapat melakukannya dengan menahan
tombol alt pada keyboard, kemudian kita klik kiri pada tool tersebut. Mudah
bukan? Ayo kita coba cara yang kedua ini.

2. Palette

Apabila kita menggunakan tool-tool pada Toolbox saja, tentu
tidak cukup. Seperti pisau membutuhkan batu pengasah, begitu
juga tool-tool pada Toolbox membutuhkan Palette ini. Palette
ini berfungsi untuk memonitor dan memanipulasi gambar
dengan lebih spesifik.

Ada banyak palette yang terdapat dalam Photoshop, di
antaranya:

1. Navigator Palette

2. Color Palette

3. History Palette

Pada bagian kiri jendela Photoshop akan muncul kumpulan
Palette seperti di atas. Palette-palette tersebut dikelompokkan
berdasarkan kegunaannya.

Navigator Palette

Berfungsi untuk melihat bagian dari gambar. Pada bagian
bawah dari Palette ini terdapat slide untuk memperbesar atau
memperkecil tampilan gambar. Palette ini akan sangat terasa
manfaatnya ketika tampilan gambar lebih besar daripada

jendelawindows kita.

Info Palette

Pada palette ini kita akan mendapatkan informasi mengenai Gambar 3.5
posisi kursor, ukuran elemen yang dipilih, serta presentasi If;‘gf;;‘;lf"?“o
warna RGB atau CMYK. v
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Gambar 3.6
Navigator Palette dan
Info Palette

l-vuu-r!m! v

Tips and Trick

Untuk menyembunyikan Palette dari layar, kalian dapat melakukannya
dengan klik pada setiap palette. Cara yang lain adalah dengan menahan
tombil Shift pada keyboard, kemudian tekan 7ab, begitu juga untuk
memunculkannya kembali.

Gambar 3.7
Color Palette, Swatches Palette,
dan Styles Palette

Kumpulan palette di atas digunakan untuk merubah warna,
mulai dari warna biasa sampai warna-warna yang telah
dimanipulasi sehingga menjadi style.

Color Palette

Digunakan untuk mengatur warna foreground dan background.
Gambar dua buah persegi di bagian kiri palette ini digunakan
untuk memilih foreground atau background, sedangkan warna
yang akan kita gunakan dapat kita pilih pada bagian bawah
palette.

Swatches Palette

Berisi tabel warna yang dapat kita gunakan, kita dapat
mengambil warna-warna di sini dengan menggunakan
Eyedropper Tool.

Styles Palette

Berisi pattern atau style-style yang telah disediakan oleh
Photoshop untuk dapat kita gunakan sebagai pengganti warna
pada gambar kita.

History Palette

Pada Palette ini kita dapat melihat langkah-langkah apa saja
yang telah kita lakukan. Kita juga dapat kembali ke langkah
sebelumnya (undo) dengan mengklik langkah tersebut.




Action Palette

Pada Photoshop, kita dapat mengelompokkan perintah-
perintah ke dalam sebuah aksi. Paletfe ini berfungsi untuk
merekam dan memainkan aksi tersebut.

Gambar 3.8 History Palette Gambar 3.9 Action Palette
Tool Presets Palette

Pada Palette ini, kita dimungkinkan untuk menyimpan
pengaturan pada tool dan memakainya kembali. Kita dapat
membuat, mengedit, atau memakai /ibraries dari tool presets.

Seseorang yang bermain-main dengan Photoshop akan sering
menggunakan Layer untuk memanipulasi gambar. Kita dapat
mengatur layer dengan Layers Palette.

Layers Palette

Pallete ini digunakan untuk memanipulasi Layer (Lapisan
Gambar). Photoshop memungkinkan kita untuk membuat lebih
dari satu lapisan gambar. Di belakang akan dijelaskan lebih
lanjut untuk penggunaan /layer.

Gambar 3.10 Tool Presets Palette Gambar 3.11 Layers Palette

Channels Palette

Palette ini berguna untuk memonitor efek edit yang telah kita
lakukan. Informasi yang dapat kita peroleh adalah RGB, Red,
Green, dan Blue. Channel tersebut dapat kita non-aktifkan
sesuai kebutuhan kita.

Paths Palette

Palette ini me-list nama dan gambar dari setiap path yang
disimpan, current work path, dan current vector mask.
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Gambar 3.15
Dua cara mengakses Layer

Gambar 3.12 Gambar 3.13
Channels Palette Paths Palette

3. Dasar-Dasar Layer

Layer adalah salah satu kemampuan Photoshop yang membuat
banyak orang menggunakan aplikasi ini. Dengan Layer, kita
dapat memanipulasi gambar sesuka kita.

Layer seperti sebuah lapisan kertas mika (kertas yang terbuat
dari bahan plastik dan tembus pandang). Masing-masing kertas
mika tersebut bebas kita gambar
dan warnai sesuai keinginan kita.
Jika kita menumpuk semua kertas
mika yang telah kita gambar
menjadi satu tumpukan maka kita
dapat melihat semua gambar
yang kita gambar terlihat dari satu
sisi. Demikian juga pada
Photoshop, kita dapat memiliki

Sumber lebih dari satu /ayer dan masing-
R —— masing layer dapat kita edit atau
manipulasi tanpa memengaruhi
Gambar 3.14 1 lai
Layer pada Photoshop ayeryang lain.

Untuk membuat, menghapus, dan memanipulasi /ayer kalian
dapat melakukannya dengan dua cara, yaitu melalui Layer
Palette dan melalui pilihan Layer pada menu bar. Kedua-
duanya akan kita butuhkan.




Sekarang mari kita coba untuk membuat poster sederhana
mengenai pencemaran lingkungan dengan menggunakan
beberapa gambar dan beberapa layer.

1. Sekarang coba kalian buat untuk membuat halaman baru
dari photoshop dengan masuk ke pilihan File > New, lalu
ubah nama menjadi Poster Pencemaran dan atur Presets
Sizes menjadi A4.

Jika pada komputer kalian telah keluar tampilan seperti di
atas, kalian dapat mengatur nama dan jenis kertas yang akan
kita gunakan. Kita juga dapat mengatur sendiri besar kertas
yang akan kita gunakan.

2. Sekarang kita open gambar yang telah di sediakan pada CD
>Bab.3 > pabrik.png. Kalian dapat melakukan open melalui
Menu Bar, File > Open, atau dengan menahan Ctrl, lalu
menekan O.

3. Ada dua halaman yang
terbuka, halaman pertama
adalah halaman Poster
Pencemaran, kemudian
halaman yang kedua
adalah gambar yang tadi
kalian open. Lalu kalian
coba klik kiri di gambar
yang telah kalian buka itu,
jangan di lepas, tapi
ditahan. Kalian lepas klik itu tepat di atas halaman yang tadi
kita buat. Cara tersebut lebih dikenal dengan istilah drag.

Tips and Trick

Kalian dapat melakukan cara lebih mudah untuk
membuka halaman baru, yaitu dengan menahan tombol
“Ctrl”, lalutekan “N”.

Kalian lihat, gambar pada halaman Poster Pencemaran akan
terlihat sangat kecil, padahal kita tidak mengubah-ubah besar
gambarnya. Ini karena

tampilan kanvas yang kita

gunakan berbeda. Coba

kalian lihat bagian atas dari

setiap gambar, baik

pabrik.png ataupun Poster

Pencemaran.psd.

Gambar 3.16
Tampilan saat membuka
halaman baru

Gambar 3.17

Tampilan ketika kita telah
men-drag gambar ke
halaman lain.
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Gambar 3.18
Perbedaan dari tampilan kanvas.

Gambar 3.19
Pilihan untuk Zoom In
atau Zoom Out.

Tahukah Kamu

Sekarang, mari kita samakan tampilan kanvas untuk
membuktikan bahwa gambar yang kita copy tadi adalah sama.
Pertama kalian klik Zoom Tool pada Toolbox. Setelah itu,
kalian lihat pada Option Bar bagian kiri, ada gambar Zoom Tool
dengan tanda + dan ada gambar Zoom Tool dengan tanda -.
Tanda + disebut Zoom In, digunakan untuk memperbesar
tampilan layar, sedangkan - disebut Zoom Out, gunakan untuk
memperkecil. Sekarang kita pilih yang bertanda -. Pastikan
yang kalian Zoom Out adalah Pabrik.png.

Setelah itu, kalian klik terlebih dahulu halaman gambar
pabrik.png, lalu klik lagi di atas gambarnya sambil
memperhatikan persentase tampilan kanvas pada bagian atas
gambar. Kalian klik beberapa kali sampai persentase tampilan
kanvas Pabrik.png sama dengan tampilan layar Poster
Pencemaran.psd yaitu 16.7%.

Coba kalian perhatikan apa yang terjadi jika kalian menahan tombol “Alt” pada
keyboard ketika kalian melakukan klik pada gambarnya? Lalu, apa yang terjadi

jika pada Option Bar

kalian pilih tanda +, kemudian melakukan hal yang sama,

yaitu menahan tombol “Alt” sambil klik pada gambar?

Gambar 3.20
Zoom In dan Zoom Out melalui
Navigator Palette.

Sekarang kalian tahu bahwa kedua gambar tersebut sama.
Bagaimana jika kita menginginkan gambar pabrik.png yang
lebih besar? Kita dapat melakukannya dengan mengatur /mage
Size terlebih dahulu pada gambar pabrik.png menjadi
1024 x 703 pixel.




Tips and Trick

Kalian juga dapat melakukan Zoom In dan Zoom QOut dengan
memanfaatkan Navigator Palette, seperti gambar di samping.

Cara mengubah /mage Size, pertama kalian klik pada halaman
pabrik.png, lalu pada Menu Bar kalian pilih /mage, kemudian
pilih Image Size. Setelah keluar jendela /mage Size, kita atur
Width dan Height menjadi 1024 pixels dan 703 pixels.

Gambar 3.21
Jendela Image Size

Setelah itu, kita drag kembali gambar Pabrik.png ke halaman
Poster Pencemaran.png. Kalian akan melihat tampilan seperti
dibawah ini.

Coba kalian lihat bagian Layer Palette, kalian akan lihat ada
tiga layer di sana. Layer paling bawah adalah Background, lalu
Layer [ dan Layer 2. Kalian dapat menghapus Layer I dengan
memilih Layer I dengan klik di atas tulisan Layer I, setelah itu
klik lagi pada gambar tempat sampah pada bagian bawah kanan
dari Layer Palette.

Setelah kalian klik gambar tempat sampah
tersebut, akan muncul pertanyaan untuk
memastikan, Delete the “Layer 1?7, kalian pilih
KGYeS”‘

Selain melalui Layer Palette, kalian juga dapat
menghapus layer melalui Menu Bar dengan

memilih Layer> Delete> Layer. Gambar 3.22

Hasil setelah kita melakukan
drag ulang gambar pabrik.png ke

Setelah itu, kita rename Layer 2 menjadi Pabrik, caranya kalian halaman Poster Pencemaran.psd.
klik kanan di atas tulisan Layer 2, lalu pilih Layer Properties.

Setelah itu. akan muncul jendela Layer Properties, di situ

kalian ubah Name dari Layer 2 menjadi Pabrik, kemudian klik

OK.
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Gambar 3.23
Menghapus Layer melalui
Layer Palette.

Tips and Trick

Ada cara yang lebih mudah, yaitu dengan melakukan double klik (klik kiri
dua kali) tepat di atas tulisan Layer 2, lalu ganti tulisan Layer 2 menjadi

Pabrik.

4. Kita dapat menutup gambar Pabrik.png yang tadi kita Open.
Kemudian, kita klik kembali layer Pabrik, setelah itu
kembali ke halaman Poster Pencemaran kita, lalu drag
gambar pabrik itu ke ujung paling kiri bawah.

5. Lalu, kalian buat beberapa layer lagi yang berisi gambar
yang sama, yaitu gambar pabrik. Caranya kalian klik kanan
pada Layer Pabrik, kemudian pilih Duplicate Layer.
Setelah itu, akan muncul jendela Duplicate Layer, pada
jendela itu kalian beri nama Pabrik1.

Gambar 3.24
Duplicate Layer

6. Kalian lakukan hal sepeti di atas

sampai sebagian besar layer

Background tertutupi oleh gambar-

gambar. Kalian dapat mencari

gambar sendiri di internet atau

mengambil gambar yang telah di

sediakan pada CD buku ini.

Gambar 3.25
Gambar dengan lebih
dari 2 layer




Tahukah Kamu

Ketika kalian menambahkan layer, urutan penambahan berpengaruh pada tampilan
gambar yang akan dihasilkan, yang terakhir ditambahkan akan berada di paling atas.
Seperti gambar di samping, gambar asap merupakan gambar/layer yang
ditambahkan terakhir sehingga ada di atas gambar lainnya.

7. Kalian dapat mengubah urutan layer dengan cara men-drag
layer yang akan kalian ubah ke posisi yang kalian inginkan
pada Layer Palette.

Kalian juga dapat mengatur
tingkat transperansi sebuah
layer dan juga mengatur
banyaknya pixels dalam
sebuah /ayer. Untuk
mengatur tingkat
transparansi, kalian dapat
mengatur Opacity, semakin
sedikit Opacity maka Layer
akan semakin transparan.
Sedangkan untuk mengatur
banyaknya pixels pada

Gambar 3.26 sebuah layer kalian dapat
Gambar saat kita men-drag layer. mengatur Fi 1] pa da lay er,
semakin rendah Fill maka

akan semakin sedikit

Tips and Trick

Kalian juga dapat melakukannya melalui Menu Bar. Kalian pilih Layer,
kemudian Arrange. Di situ akan ada empat pilihan, yaitu:

» BringtoFront.  » Bring Backward.

» Bring Forward  » Bringto Back.

Gambar 3.27
Perbandingan gambar
setelah menggunakan
Opacity dan Fill.
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Gambar 3.28
Pilihan untuk Marge Down
atau Marge Visible

Gambar 3.29
Pilihan Type Tool

Pada contoh gambar 3.27, kita akan atur agar gambar sampah
tetap terlihat walaupun tertutup gambar asap. Pertama kita klik
layer asap, lalu pada bagian atas Layer Palette kita atur Opacity
menjadi 65% dan Fill menjadi 70%.

Setelah kalian mengedit semua /ayer sesuka kalian dan kalian
yakin akan posisi dan hasil edit tersebut, kalian dapat
menjadikan beberapa layer bahkan semua /ayer menjadi satu
layer. Tetapi konsekuensinya, jika kalian edit satu gambar
maka gambar lain yang ada di layer tersebut juga terkena
dampaknya.

Kalian coba pilih Layer pada Menu Bar, kemudian di bagian
bawah ada Marge Down dan Marge Visible. Itu adalah dua cara
untuk melakukan penggabungan /ayer, cara pertama hanya
untuk menggabungkan beberapa, yaitu dengan menggunakan
Marge Down. Sedangkan cara yang kedua untuk secara
langsung menggabungkan semua layer, yaitu dengan Marge
Visible, syaratnya semua layer harus visible (terlihat). Sebuah
Layeryang visible akan ada simbol mata di bagian kirinya.

4. Text

Kalian tidak mungkin membuat sebuah poster tanpa ada satu
kata pun di situ. Setidaknya pasti ada kata-kata untuk
memberitahu maksud dari gambar yang ada di poster tersebut.

Pada Photoshop, untuk membuat teks tidak susah, kalian cukup
pilih submenu pada Type Tool di Toolbox.

Pertama, kita akan mempelajari Horizontal Type Tool dan
Vertical Type Tool. Keduanya sama-sama digunakan untuk
menulis sesuatu pada Photoshop, bedanya pada tampilan yang
dihasilkan.

Seperti gambar di samping, Horizontal Type Tool digunakan
untuk menulis secara horizontal, sedangkan Vertical Type Tool
digunakan untuk menulis secara vertikal.

Pada Photoshop ada dua kategori Teks, yaitu: Point Type dan
Paragraph Type. Point Type digunakan untuk menulis teks
yang hanya berisi satu kata atau satu baris kalimat. Sedangkan
Paragraph Type digunakan untuk menulis lebih dari satu baris
kalimat atau paragraf.




Gambar 3.30 Gambar 3.31
Horizontal dan Vertical Type Tool Membuat Paragraph Type Tool

a.Point Type

Untuk membuat Point Type, kalian cukup klik Horizontal atau
Vertical Type Tool pada Toolbox. Lalu, kalian klik bagian
halaman yang akan kita tulis sesuatu.

b. Paragraph

Untuk Paragraph Type, ada sedikit perbedaan pada saat kalian
men-klik di bagian halaman yang akan kalian tulis. Setelah
kalian memilih Horizontal atau Vertical Type Tool, kalian harus
men-klik, lalu menahan klik tersebut sampai persegi yang
dihasilkan sesuai dengan perkiraan besar paragraf yang akan
kalian tulis.

Setelah kita mempelajari tentang Horizontal dan Vertical Type
Tool, kita akan mempelajari mengenai bagaimana cara
mengubah tampilan teks. Kalian cukup mengenal Option Bar
saat kalian telah memilih Type Tool.

Gambar 3.32 Option Bar untuk Type Tool

- Mengubah Orientasi Teks
. i. Jika kalian klik tombol ini, orientasi akan berubah dari
Horizontal menjadi Vertical atau sebaliknya.

Mengubah Jenis Font
Pada pilihan ini, kalian dapat mengubah font yang kita suka.

Mengubah Ketebalan Teks
Untuk mengatur seberapa tebal teks yang kita inginkan.

Mengubah Ukuran Font
Tool yang digunakan untuk mengubah besar/ukuran font.
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Mengubah Kehalusan Font
Digunakan untuk mengatur kehalusan yang dimiliki oleh font.

Mengubah Warna Teks
Kita juga dapat mengubah-ubah warna pada teks menggunakan
Tool ini.

Mengatur Penjajaran
Seperti pada Microsoft Word, kita dapat mengatur teks kita
menjadi rata tengah, kiri, atau kanan.

y Warp Text
1 Dapat membuat teks menjadi melengkung atau membentuknya
D seperti gelombang dan lain-lain.

Tahukah Kamu

Kalian dapat mengubah tampilan teks sebelum membuat teks maupun sesudah
membuat teks. Tetapi yang perlu diingat jika kalian mau mengubah tampilan
teks setelah membuat teksnya, kalian perlu mem-blok terlebih dahulu bagian
teks yang akan dirubah tampilannya.

Photoshop juga menyediakan dua Palette khusus yang
digunakan berhubungan dengan teks, yaitu Character Palette
dan Paragraph Palette. Di situ kalian dapat melakukan lebih
banyak hal daripada sekedar mengandalkan Option Bar.

Untuk menampilkan Character dan Paragraph Palette, kalian
dapat memilih Window pada Menu Bar, lalu kalian cukup pilih
salah satu antara Character atau Paragraph. Setelah itu, akan
muncul satu jendela baru dengan dua Palette langsung, yaitu
Character dan Paragraph Palette.

Sebagai Layer, Teks juga dapat dimanipulasi. Kalian dapat
melakukannya dengan men-klik #. pada bagian bawah Layer
Palette. Setelah itu, kalian dapat memilih manipulasi apa yang
kalian inginkan.

Gambar 3.33
Character Palette dan
Paragraph Palette




Ayo Cari Tahu

Coba kalian cari tahu, apa saja yang dapat dilakukan melalui Character dan
Paragraph Palette? Dibandingkan melalui Option Bar, mana yang lebih
lengkap?

Kalian masih ingat? Dari empat submenu Type Tool, kita baru
mempelajari dua submenu, yaitu Horizontal dan Vertical Type
Tool. Sekarang kalian akan tahu kegunaan dua Type Tool yang
lain, yaitu Horizontal dan Vertical Type Mask. Kedua Tool ini
berfungsi untuk membuat mask/seleksi yang berbentuk huruf.

Untuk lebih memahami kegunaan 700/ ini, mari ikuti panduan
membuat teks dengan menggunakan Horizontal Type Mask.

-----

”:_: ? Horizontal Type Mask Taool T

(anay . Gambar 3.34
l“ 1{¥Vertical Type Mask Tool T Horizontal dan

Vertical Type Mask.

Pertama, buka gambar apapun yang kalian ingini atau jika
kalian mau, kalian dapat mengmbil gambar tree.jpg pada CD.
Tentunya kalian buka melalui Photoshop dengan cara klik File,
lalu Open, atau menahan tombol “Ctrl” dan menekan
huruf “O”.

Setelah itu, kalian klik Type Tool pada Toolbox dan memilih
Horizontal Type Mask. Aturlah jenis, ukuran, dan lain-lain jika
perlu, kemudian kalian klik pada gambar. Setelah kalian klik
pada gambar, gambar akan memasukki mode masking, lalu
kalian tulis “TREE”. Setelah itu, klik Commit di bagian Option
Bar.

Gambar 3.35
Tree. JPG

Tahukah Kamu

Setelah kalian klik Commit, kalian tidak dapat melakukan edit lagi pada Teks, jadi
telitilah sebelum klik Commit.
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Gambar 3.36
Hasil tulisan menjadi Mask

Tahukah Kamu

Jika kalian melakukannya dengan benar, pada gambar akan
muncul tulisan “TREE” yang berbentuk mask (bidang yang
terseleksi).

Kemudian, kalian pilih Select pada Option Bar, lalu pilih
Transform Selection.

Transform Selection digunakan untuk menjadikan teks tersebut menjadi suatu
objek yang dapat diperbesar atau diperkecil.

Gambar 3.37
Saat mengubah ukuran
menggunakan Transform

Setelah kalian klik, akan muncul persegi kecil di setiap ujung
dan tengah masing-masing sisi pada gambar. Persegi tersebut
dapat digunakan untuk merubah ukuran teks tersebut dengan
cara klik kiri pada persegi tersebut, ditahan, lalu klik
dilepaskan saat ukuran gambar telah sesuai keinginan kalian.

Setelah kalian menemukan ukuran
yang tepat, jangan lupa kalian
Commit terlebih dahulu.
Kemudian, kalian dapat men-
copy, memotong, atau
menggandakan hasil bidang
seleksi/mask yang telah kita buat
tadi. Dengan cara memilih Layer pada Option Bar, lalu pilih
New. Lihat bagian bawah ada 2 pilihan, yaitu Layer via Copy
dan Layervia Cut. Kalian dapat pilih salah satu.

Sekarang kalian lihat Layer Palette, ada dua layer di sana,
Layer Background dan Layer 1. Untuk melihat hasilnya, kalian
dapat membuat Layer Background tidak terlihat dengan men-
klik gambar mata di sebelah layer Background pada Layer
Palette.

Jika kalian mau, kalian dapat menambahkan tulisan
“TREE” tersebut ke dalam Poster Pencemaran yang
sebelumnya pernah kalian buat ketika belajar mengenai
Layer. Kalian cukup membuka file Poster Pencemaran
tersebut, lalu men-drag tulisan tadi ke atas gambar yang
sudah ada.




Kalian juga dapat mengubah ukuran tulisan tadi dengan
memilih Edit pada Option Bar, lalu pilih Free Transform,
caranya sama seperti ketika kalian mengubah ukuran melalui
Select> Transform Selection.

Gambar 3.38
Saat membuat layer tidak
terlihat

Tahukah Kamu

Apa perbedaan Free Tansform pada Edit dan Transform Selection pada Select?
Kalian akan tahu jawabannya ketika mencoba mengubah ukuran teks “TREE”
saatkalian belajar Horizontal Type Mask.

Selain itu, kalian juga dapat memutar tulisan “TREE” tersebut
sesuai keinginan kita. Dengan cara sama seperti merubah
ukuran, tapi kita arahkan kursor ke ujung tulisan seperti gambar
di samping. Lalu klik kiri dan ditahan, sampai kalian
menemukan posisi yang tepat.

Sekarang kita akan mencoba

membuat teks menjadi lebih

menarik dengan mengguakan

efek-efek yang telah

disediakan oleh Photoshop.

Kali ini kita akan belajar agar

Teks yang kalian tulis menjadi &“ﬁ,ﬂiﬁﬁ,}iﬁ tulisan
seperti Es yang mencair.

Pertama, kalian buat Foreground menjadi putih dan
Background menjadi hitam. Caranya kalian cukup klik pada
Toolbox bagian yang warna seperti di samping. Klik persegi
yang di atas untuk mengubah warna Foreground dan klik
persegi yang di bawah untuk mengubah warna Backgroud.

Kemudian, buat halaman baru dengan nama “Es” dan dengan
jenis kertas “A4”. Setelah itu, kalian buat Channels baru,
caranya klik “Create a New Channel” pada bagian bawah
Channel Palette (berada bersamaan dengan Layer Palette).
Jika Channel Palette belum ada, kalian dapat membukanya
dengan pilih “Window” pada Menu Bar, lalu klik Channel.
Pastikan Channel Palette menjadi seperti di berikut ini.
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Gambar 3.40
Poster Pencemaran.psd
setelah kita tambahkan

Tulisan TREE dengan
menggunakan Horizontal
Type Mask.

Tahukah Kamu

Setelah itu, kalian dapat memilih

o Horizontal atau Vertical Type Tool, lalu

tuliskan “Save The Earth”. Lalu atur jenis

dan ukuran font sesuka kalian. Kemudian

.J klik Move Tool untuk memindah-mindah
tulisan kita ke tempat yang kita sukai.

Gambar 3.41
Toolbox Warna.

Kemudian, klik “/mage” pada Menu Bar, lalu pilih “Rotate
Canvas” dan pilih yang 90 derajat CW, maka tampilan akan
seperti pada gambar 3.43.

Gambar 3.43
Gambar 3.42 Hasil gambar setelah
New Channel. Rotate Canvas.

Ketika kalian memilih Rotate Canvas, mungkin kalian sempat bertanya-tanya,
apa bedanya antara CW dan CCW. CW adalah kependekan dari Clock Wise, atau
dengan kata lain searah jarum jam. Sedangkan CCW adalah kebalikan dari CW,
yaitu berlawanan arah jarum jam.

Sekarang kita mulai memberi efek-efek pada tulisan yang telah
kita buat. Pertama kita beri efek Wind, caranya klik “Filter”
pada Menu Bar, kemudian pilih Stylize dan pilih Wind. Maka
akan muncul jendela seperti pada gambar 3.44.

Ubah Method menjadi Wind dan Direction menjadi From The
Right. Lakukan hal ini sampai 2 atau 3 kali agar efek yang
diperlihatkan menjadi lebih terasa. Setelah itu, tulisan “Save
The World” menjadi seperti ada tinta yang mencair. Untuk
lebih jelasnya kalian dapat melakukan Zoom. Jika kita sudah
merasa puas dengan hasilnya kita dapat memutar kanvas
kembali seperti semula. Cukup dengan memilih Rotate Canvas
lalu pilih 90 derajat CCW.




Agar tampak lebih nyata, kita akan
memberi efek lagi dengan distort. Caranya,
pada Menu Bar Filter kalian pilih Distort,
lalu pilih Ripple maka akan muncul jendela
Ripple. Kalian atur Amount menjadi 110%
dan size Medium. Gambar akan menjadi
seperi pada gambar 3.45.

Ini masih belum selesai, kita harus

memberi satu efek lagi untuk membuat  G,mpar3.44
kesan air lebih nampak. Sekarang kalian  Jendela Wind
pilih Filter, Sketch, lalu Stamp. Berikutnya

atur Light/Dark Balance menjadi 1 dan Smoothness menjadi 5.
Maka gambar akan menjadi lebih seperti air.

Gambar 3.45
Hasil setelah memberi
efek Wind dan Distort >Ripple

Setelah itu, kita perlu lakukan Load Selection untuk membuat "
tulisan yang sudah kalian buat tadi menjadi Selection. Caranya Internet Link

kalian pilih Select, lalu Pilih Load Selection. .
Kalian dapat

mengikuti
perkembangan
desain Photoshop

Kemudian, kalian boleh menghapus channel “Alpha 1” karena
kita sudah tidak membutuhkannya lagi. Setelah itu, kalian beri
warna putih/white pada Selection kita. Klik Edit pada Menu

Bar,lalupilih Fill. dengan_ mengikut@

komunitasnya di
Sekarang kita buat agar tulisan www.photoshop
menjadi seperti 3 dimensi, 21.com

caranya dengan memilih Bas

Relief pada Filter lalu Sketch.

Setelah keluar jendela Bas

Relief, aturlah sendiri sehingga Gambar 3.46

kesan 3 dimensi lebih terasa. Jendela Load Selection

Pada gambar 3.47, Bas Relief
diatur dengan Detail 7, Smoothness 8, dan Light Direction
Bottom.

Jika kalian mau, kalian dapat memasukkan Teks “Save The

Earth” tadi ke dalam Poster Pencemaran.psd yang pernah
kalian buat sebelumnya.
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Gambar 3.47
Gambar setelah di atur Bas Reliefnya

Gambar 3.48
Poster Pencemaran.psd
setelah diberi manipulasi teks

Tahukah Kamu

Tulisan yang kalian buat memiliki warna dasar hitam dan putih. Jika kalian
menghendaki warna yang berbeda, kalian dapat mengaturnya pada Foreground dan
Background Color. Lalu, saat kalian beri Fill pada selection, kalian juga dapat
menggunakan warna Foreground ataupun Background.

Ku m
@(\g S
& 2

1. Photoshop adalah sebuah aplikasi yang digunakan untuk membuat atau
memodifikasi gambar.

2. Ada 5 bagian yang harus diperhatikan dari Jendela Photoshop, yaitu Menu
Bar, Option Bar, ToolBox, Palette, dan Palette Well. Masing-masing memiliki
kegunaannya masing-masing.

3. ToolBox adalah kotak peralatan yang kita gunakan untuk melakukan segala

sesuatu dalam Photoshop, mengedit, menggambar, dan sebagainya.

. Palette digunakan untuk memonitor dan memanipulasi gambar lebih spesifik.

. Layer dapat digambarkan seperti kertas transparan yang dapat kita gambar,
nantinya kertas tersebut dapat ditumpuk menjadi satu.

D




A. Pengecekan Konsep

Pilihlah salah satu jawaban yang paling benar!

@ Berikut ini yang bukan merupakan © Perintah “Duplicate Layer” digunakan

kegunaan dari aplikasi Adobe
Photoshop adalah...

a. membuat poster

b. mengedit foto

c. menghias foto

d. menulis cerita

Bagian dari Photoshop yang
menampilkan peraturan khusus dari
tool box yang aktif disebut ...

a. Palette c. Menu Bar

b. Option Bar d. Palette Well

Kegunaan dari Slice Tool adalah . . .
a. untuk melakukan seleksi

b. untuk membelah gambar

c. untuk memberi warna

d. untuk memperbaiki gambar

Berikut ini bukan merupakan Palette
yang terdapat pada  Photoshop
adalah ...

a. Text Palette
b. Color Palette

c. Swatches Palette
d. Brush Palette

Palette yang berisi tabel warna, untuk
mengambil warna-warna dengan
menggunakan  Eyedropper Tool
adalah ...

a. Text Palette

b. Color Palette

c. Swatches Palette

d. Brush Palette

Dalam Photoshop, untuk membuka
halaman baru cukup menggunakan ...
a.Ctrl + N c. Shift+ N

b. Ctrl + O d. Shift+ O

(9]

10

untuk . ..

a. membuat layer baru

b. mengganti nama sebuah layer

c. mengaktifkan sebuah layer

d. membuat copy-an dari sebuah layer

Pilihan yang tepat mengenai Marge

Down dan Marge Visible adalah. . .

a. Marge Down untuk menggabung
kan dengan layer di bawahnya,
sedangkan Marge Visible untuk
menggabungkan semua layer

b. Marge Visible untuk menggabung
kan dengan layer di bawahnya,
sedangkan Marge Down untuk
menggabungkan semua layer

c.tidak ada perbedaan antara Marge
Down dan Marge Visible, sama-
sama untuk menggabungkan layer

d.Marge Down untuk menggabung
kan dengan layer di bawahnya,
sedangkan Marge Visible untuk
menggabungkan semua layer yang
visible (terlihat)

.l.‘

Gambar di atas merupakan simbol
dari...

a. Type Tool c. ipe Mask

b. Warp Type d. Point Type

Di bawah ini yang merupakan tipe
rotate searah jarum jam adalah ..
a.CCW c.CW

b.CWW d.CWC
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B. Pemahaman Konsep

Jawablah pertanyaan di bawah ini!

Tuliskan apa yang kalian ketahui mengenai Menu Bar pada Photoshop.
Sebutkan minimal 10 macam tool dari 700! Box pada Photoshop!
Sebutkan dan jelaskan mengenai Blur Tool beserta submenunya!
Apayang kalian ketahui mengenai Channels Palette?

Sebutkan cara-cara untuk mengakses layer (membuat, menghapus, serta
memanipulasi)!

Pada Zoom Tool, terdapat Zoom In dan Zoom Out. Apa yang dimaksud dengan Zoom
Indan Zoom Out?

Apakah Opacity dan Fill pada Layer Palette sama? Jika tidak, berikan penjelasan
apabedanya?

Untuk membuat Paragraph Type berbeda dengan menggunakan Point Type,
bagaimana cara menggunakan Paragraph Type? Jelaskan!

Apakegunaan dari Transform Selection?

0 ©0 © © 606006000

Apayang membedakan Type Tool dan Type Mask Tool?

C. Aktifitas Siswa

Buatlah salah satu bentuk gambar di bawabh ini.
Ambillah beberapa gambat clipart di internet, lalu gabungkan dengan menggunakan
Photoshop sehingga menjadi salah satu contoh gambar di bawah ini.




Tujuan Pembelajaran:

Setelah mempelajari bab ini diharapkan
siswa mampu:

1. Memahami dan mengetahui teknik
memotong dan membuat seleksi

2. Mengetahui dan mengenal bentuk-
bentuk vektor dan brush

3. Mengetahui lebih jauh layer

Bagaimana cara menggambar Gatot Kaca
menggunakan komputer?

Dapatkah sebuah foto dimodifokasi dengan
komputer sehingga tampak seperti lukisan /
kartun?

Software Photoshop adalah salah satu
jawabannya.

Banyak hal yang dapat kita buat dengan
Photoshop. Salah satunya adalah poster
semacam gambar di samping ini.

Pada bab ini, kita akan mempelajari lebih
dalam lagi mengenai Photoshop.

~ KATA KUNCI |
B Seleksi B Brush B | evels B Blend
B Crop Tool B Image B Clipping Path M Rasterize
B Marquee Tool ™ Lasso Tool B Gradien B Free Transform

B Pen Tool B Magic Wand Tool ™ Adjustments



Peta konsep

Teknik
Memotong
dan
Membuat
Seleksi

. Mengenal
Berkreasi Bentuk

dengan Vektor
Photoshop dan
Brush

Lebih
Jauh
Mengenal
Layer




Berkreasi dengan
Photoshop

Teknik Memotong dan Membuat Seleksi

Sebagian besar karya yang dihasilkan menggunakan
Photoshop tidak akan lepas dalam menggabung-gabungkan
dari banyak gambar. Yang jadi permasalahan adalah
bagaimana jika kita tidak
membutuhkan seluruh
gambar, hanya sebagian saja.
Maka kita harus me-
motongnya atau membuat
seleksi. Seperti dalam
peperangan, teknik me-
motong dan seleksi serta
penggunaan layer adalah
. . Gambar 4.1
senjata utama dari Photoshop. Gambar foto perdamaian di
Pada kesempatan kali ini, kita Aceh
akan mempelajari mengenai
bagaimana kita dapat menyeleksi sebuah benda, lalu
memotongnya atau memindahnyake halaman yang lain.

Jika kalian akan memotong bagian gambar yang berbentuk
persegi, itu sangat mudah. Seperti gambar di samping, jika
kalian akan memotong sebuah gambar, kalian cukup
menggunakan Crop Toolpada Toolbox.

Caranya, kalian buka dulu damaiaceh.bmp pada Photoshop
kalian. Setelah itu, kalian pilih Crop Tool pada Toolbox. Lalu
blok gambar dengan Crop Tool tersebut dengan cara menahan
klik kiri, lalu gerakan mouse ke bagian akhir gambar yang
akandipotong.

— —

Gambar 4.2
Cara menggunakan
Crop Tool
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Tahukah Kamu

Setelah itu, kalian dapat memotongnya dengan klik kanan
pada seleksi tersebut kemudian pilih Crop. Jika kalian ingin
memindahkan hasil potongan gambar tersebut ke halaman
baru, kalian tidak dapat langsung men-drag ke halaman baru,
itu dikarenakan layer pada gambar tersebut masih dikunci.
Kalian harus buka dulu dengan double klik pada layer
tersebut, setelah itu baru kalian drag ke halaman baru.

Setelah kita menggunakan Crop Tool, akan muncul seleksi sebelum dipotong,
bagaimana caranya jika kalian ingin memutar hasil seleksi tersebut?

Mudah bukan melakukan seleksi dan memotong
menggunakan Crop Tool? Tetapi, tidak semua gambar yang
akan kita potong memiliki bentuk persegi, tetapi sangat
mungkin kita harus memotong gambar yang berbentuk
segitiga atau bahkan tidak berbentuk sama sekali, misalnya
gambar pulau atau muka seseorang.

Ada banyak teknik yang dapat kita gunakan untuk
melakukan seleksi, yaitu:

1. Marquee Tool

2. Pen Tool

3. Lasso Tool

4. Magic Wand Tool

Jika kita akan menyeleksi bagian yang bentuknya mudah
seperti lingkaran atau persegi panjang, kita cukup
menggunakan Marquee Tool dan submenunya. Pada kali ini
kita akan mempelajari dua teknik lain, yaitu Lasso Too! dan
Magic Wand Tool.

1. Menggunakan Lasso Tool

Pada CD, tersedia sebuah gambar bernama peace.jpg, kalian
buka menggunakan aplikasi Photoshop. Gambar tersebut akan
kita seleksi bagian pulaunya, kita akan menyeleksi dengan
menggunakan teknik Lasso maupun Magic Wand.

Setelah kalian buka gambar tersebut, pertama pilih Polygon
Lasso Tool (submenu dari Lasso Tool). Kemudian, kita lakukan
seleksi dengan meng-klik setiap ujung dari gambar pulau
tersebut dengan memperhatikan lika-likunya.

Langkah pertamanya, pilih titik awal yang akan menjadi
seleksi kita dengan klik kiri pada titik tersebut. Kemudian, pilih




titik berikutnya dengan klik kiri lagi. Lakukan seperti itu terus
dengan sampai kembali ke titik awal. Ingat, pilihlah titik yang
merupakan ujung-ujung dari pulau.

Seperti kalian ketahui, Lasso Tool ada tiga macam, yaitu Lasso
Tool, Polygon Lasso Tool, dan Magnetic Lasso Tool. Ketiga-
tiganya berfungsi sama, yaitu untuk membuat seleksi. Lasso
Toolberguna untuk membuat seleksi dengan bebas, tetapi untuk
menggunakan tool ini membutuhkan ketelitian serta
keterampilan tangan yang baik dalam menggerakkan mouse.
Sedangkan, untuk kasus seperti ini, kalian juga dapat
menggunakan Magnetic Lasso Tool, yaitu menyeleksi
berdasarkan perbedaan pixel. Untuk menggunakan Magnetic
Lasso Tool, kalian cukup menggerakkan mouse mengelilingi
gambar pulau tersebut tanpa harus melakukan klik berkali-kali
dan memperhatikan lika-liku gambar pulau tersebut.

Gambar 4.3 Gambar 4.4
Gambar yang akan kita seleksi. Setelah kita sampai di titik
Sumber: www.ranesi.nl awal, gambar pulau akan terseleksi

Gambar 4.5 adalah seleksi menggunakan Magnetic Lasso Tool.
Kalian dapat mencobanya dengan melakukan Duplicate Layer,
lalu melakukan seleksi lagi dengan Magnetic Lasso Tool.

Gambar 4.5 Gambar 4.6
Seleksi gambar menggunakan Gambar hasil seleksi pada
Magnetic Lasso Tool halaman Perdamaian
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Tahukah Kamu

Setelah itu, kalian buat halaman baru dengan nama
Perdamaian, lalu atur Preset Size menjadi “640 x 480 dan
Contents menjadi “Transparent”. Kemudian pada peace.jpg,
kalian klik Move Tool untuk memindahkan seleksi gambar ke
halaman Perdamaian, maka akan muncul gambar hasil seleksi
kalian pada halaman Perdamaian.

Jika diperhatikan sekilas, Gambar 4.5 dan Gambar 4.6 terlihat sama. Akan tetapi
jika diperhatikan lebih detail, akan tampak berbeda hasil seleksi menggunakan
Magnetic Lasso Tool dan menggunakan Polygon Lasso Tool. Seleksi
menggunakan Polygon Lasso Tool terlihat lebih detail daripada menggunakan

Magnetic Lasso Tool,

tetapi jika dilihat dari penggunaannya jauh lebih mudah

menggunakan Magnetic Lasso Tool.

Gambar 4.7
Channel Palette
dengan semua warna aktif

Gambar 4.8

Hanya memilih warna Red
saja yang aktif.

Sumber: pol2.wordpress.com

2. Menggunakan Magic Wand Tool

Ada beberapa langkah untuk melakukan seleksi yang baik
menggunakan Magic Wand Tool. Seperti kalian ketahui
pada bab sebelumnya, Magic Wand Tool digunakan untuk
memilih gambar dengan warna yang sama, karena itu kita
harus mengatur pencahayaan dan warna gambar agar
semakin sempurna seleksi kita.

Langkah pertama, kalian buka UL.JPG melalui Photoshop.
Kemudian, perhatikan Channel Palette, di situ kalian dapat
mengetahui bahwa semua warna terlihat.

Sekarang kalian coba untuk
mengaktifkan hanya salah satu
warna, Red atau Green atau Blue.
Kemudian, kalian bandingkan
kekontrasan warna antara bagian
yang akan di seleksi dan bagian
yang tidak akan terseleksi. Dalam
kasus kita kali ini, kita akan
membuat seleksi berupa tangan serta bola dunianya. Pilih
warna yang kontrasnya paling terlihat. Saya memilih hanya
Red sajayang aktif.




Tips and Trick

Untuk mengaktiftkan atau menon-aktifkan warna, kalian cukup klik pada
gambar mata sebelah kiri dari masing-masing warna.

Setelah itu, kalian lakukan Duplicate Channel pada warna
yang telah kita pilih. Caranya, kalian klik kanan pada
Channel warna tersebut, pilih Duplicate Channel, lalu klik
OK dengannama “Red Copy”.

Ayo Cari Tahu

Mengapa kita harus melakukan Duplicate Channel? Mengapa kita tidak
menggunakan Channel Red tersebut untuk kita edit?

Sebelum memasuki ke langkah selanjutnya, pastikan bahwa
Channel yang aktifadalah Red Copy yang telah kita buat tadi.
Kemudian, langkah selanjutnya adalah mengatur Level
cahaya dari gambar sehingga antara gambar yang akan kita
seleksi dan gambar yang tidak akan kita seleksi menjadi
lebih kontras.

Pertama, kita pilih /mage
pada Menu Bar lalu pilih
Adjustments, kemudian
Levels. Maka akan
keluar jendela Levels
seperti gambar di
samping. Kalian atur

Gambar 4.9
Input Level yang berada Jendela Levels untuk
pada bagian atas jendela mengatur Level warna

tersebut, atau kalian juga

dapat mengaturnya

melalui panel yang berada di grafik seperti gambar di bawah.
Sayamengatur Input Level menjadi “0, 1.00,32”.

Tahukah Kamu

Ada 3 segitiga pada panel yang di lingkari. Panel paling kiri adalah untuk
mengatur tingkat kegelapan, panel paling kanan adalah untuk mengatur
tingkat keterangan, dan yang di tengah adalah untuk mengatur kontrasnya.

Maka gambar akan menjadi lebih kontras antara hitam dan
putih. Masalah berikutnya adalah ketika kita menggunakan
Magic Wand yang menyeleksi berdasarkan warna maka ada
sebagian warna hitam pada bola dunia seperti gambar di
samping yang tentunya akan membuat seleksi kita kurang

sempurna.
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Gambar 4.10
Gambar setelah di atur level
cahayanya.

Gambar 4.11
Master Diameter
pada Brush

Tahukah Kamu

Oleh karena itu, kita perlu melakukan satu langkah lagi

sebelum melakukan seleksi menggunakan Magic Wand Tool.
Langkah tersebut adalah
memastikan bahwa daerah
yang akan kita seleksi
berwarna putih dan daerah
yang akan tidak seleksi
berwarna hitam. Kita
melakukannya menggunakan
Brush Tool.

Untuk menggunakan Brush Tool, kalian

cukup klik Brush Tool pada Tool Box.

Setelah itu, atur pada Option Bar

sehingga Master Diameter menjadi
“10px”, lihat gambar di samping.

Semakin besar Master Diameter pada Brush maka akan semakin besar lingkaran
untuk melakukan brush. Oleh karena itu, jika kalian ingin hasil yang detail, akan
lebih baik menggunakan Master Diameter yang kecil, sebaliknya kalian dapat
menggunakan Master Diameter besar jika gambar yang akan kita brush tidak

detail.
Gambar 4.12
Gambar setelah kita
brush putih

I TIK SMA Kelas XII

Warna brush di ambil dari warna Foreground kita, karena itu
sebelum melakukan brush kalian harus ubah warna
Foreground-nya. Atur Foreground menjadi putih, kemudian
lakukan brush dengan cara menahan klik kiri pada daerah
yang akan kalian brush. Lakukan terus sampai semua daerah
yang akan kita seleksi menjadi putih seperti gambar4.12.

Apakah sudah selesai? Apakah semua sudah selesai di
brush? Jika kalian teliti, kalian akan menemukan satu bagian
lagi yang harus di-brush, yaitu bagian tulisan yang ada di kiri
bawah. Kalian brush bagian tersebut menjadi hitam, karena
tulisan tersebut termasuk bagian yang tidak akan terseleksi.

Setelah selesai, gambar telah siap untuk di seleksi

menggunakan Magic Wand. Kalian cukup klik Magic Wand
Tool yang ada di Tool Box, lalu
kalian klik bagian gambar yang
akan kita seleksi. Maka akan
terlihat garis putus-putus di
pinggir warna putih yang
menunjukkan bahwa gambar
telah terseleksi.




Tips and Trick

Jika pada gambar kalian yang terseleksi adalah bagian luarnya atau
bagian yang hitam, kalian dapat melakukan /nverse dengan cara klik
kanan pada gambar, lalu pilih Select Inverse.

Kemudian, pindahkan hasil seleksi ke halaman
Perdamaian.psd yang pernah dibuat. Akan tetapi,
sebelumnya ada dua hal yang harus diperhatikan. Yang
pertama, klik Move Tool pada Too!l Box, dan yang kedua, klik
tepat di atas tulisan RGB pada Channel RGB, ini
menunjukkan bawa kita mengaktifkan sekaligus akan
melakukan sesuatu pada Channel RGB. Setelah kedua itu
dipenuhi, maka kita dapat
memindahkan gambar ke halaman
Perdamaian.psd dengan di- drag.
Kalian ingat pelajaran tentang
Layer bukan? Setelah men-drag

. Gambar 4.13
gambar tangan dan bola dunia, Perdamaian.psd setelah di-
kalian boleh memberi nama Layer drag gambar tangan dan
bola dunia

dan mengaturnya sesuaikeinginan

Mengenal Bentuk Vektor dan Brush

Bagai kupu-kupu dengan sayapnya yang cantik, begitu pula
Photoshop tidak cukup hanya menggunakan layer dan teks
saja untuk membuat gambar menarik. Kita juga
membutuhkan gambar-gambar tambahan lain yang dapat
membuat halaman kita menjadi lebih menarik. Di antaranya
dengan menggunakan bentuk-bentuk vektor dan brush.

Pada awal bab, kalian telah mempelajari Desain Grafis
menggunakan CorelDRAWI2, desain yang kalian buat
tersebut merupakan bentuk vektor. Bentuk vektor tidak hanya

dibuat menggunakan CorelDRAW saja, Photoshop juga
menyediakan bentuk vektor. Memang lebih sederhana di
banding dengan CorelDRAW, tetapi itu sudah cukup untuk
membuat gambar kitamenjadi lebih menarik.

Bentuk vektor sendiri ada dua
macam, yaitu bentuk Vektor
Geometris dan bentuk Vektor
Khusus. Bahkan kita dapat
membuat bentuk vektor sendiri Gambar 4.14

menggunakan Pen Tool. Macam-macam
bentuk Vektor
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Ayo Cari Tahu

Kalian tentu pernah mendengar mengenai bentuk yang Geometris dan Non-
Geometris pada pelajaran Matematika. Apa yang membedakan antara bentuk
Geometri dan Non-Geometri?

Gambar 4.15
Bentuk Vektor Geometri

Tips and Trick

Untuk membuat bentuk Vektor, kalian dapat klik Rectangle
Tool pada Tool Box. Jika kalian klik kanan pada Rectangle
Tool maka akan keluar banyak submenu dari Rectangle Tool,
seperti gambar di bawah. Semuanya adalah bentuk Vektor,
tetapi hanya yang di dalam persegi merah saja yang
merupakan bentuk Vektor Geometris.

Setelah kalian klik Rectangle Tool pada Tool Box, pilih

bentuk vektor mana yang akan dibuat. Kalian dapat memilih

melalui submenu pada 7ool Box atau melalui Option Bar.
Kemudian, pilih titik
awal di mana kalian akan
membuat bentuk
tersebut, tahan klik kiri
di titik awal, lalu
gerakkan mouse ke titik
akhir bentuk yang akan
kalian buat.

Gambar 4.16 Gambar 4.17
Membuat Bentuk Vektor GeometrMembuat bentuk Vektor
Geometri yang proporsional

Saat kalian membuat bentuk Vektor Geometris, kalian harus membuat
gambar menjadi lebih proporsional. Kalian dapat melakukannya dengan
menahan tombol “Shift” pada Keyboard saat menggerakkan mouse. Maka
bentuk Vektor yang dihasilkan menjadi lebih proporsional seperti gambar di

bawabh.

Sekarang bagaimana dengan bentuk Vektor Khusus/Non-
Geometris? Penggunaannya sama saja dengan Vektor
Geometris, hanya saja pada Vektor Khusus kita akan
menjumpailebih banyak bentuk daripada Vektor Geometris.

Untuk menggunakannya, kalian harus memilih Custom
Shape Tool melalui Tool Box maupun melalui Option Bar.
Kemudian, untuk memilih bentuknya, kalian klik Shape pada
Option Bar seperti gambar4.18.




Kalian juga dapat memberi warna berbeda pada bentuk
Vektor yang telah kalian buat.

Coba perhatikan Option Bar

bagian kanan, di situ ada warna

yang dapat diubah jika kalian

klik.

Gambar 4.18
Bentuk Vektor Khusus

Tahukah Kamu

Ada dua cara untuk mengganti warna, yaitu mengganti warna sebelum kalian
buat bentuk vektornya dan yang kedua setelah kalian buat bentuk vektornya.
Dengan cara kedua, kalian harus memastikan terlebih dahulu bahwa layer yang
aktifadalah layer vektor yang akan diubah warnanya. Kalian juga dapat mengisi
dengan Gradient menggunakan Gradient Tool.

Jika kalian memperhatikan Layer Palette, maka ada yang
berbeda antara Layer yang terbentuk karena kita membuat
bentuk Vektor dan Layer yang biasanya.

Isi Layer Clipping Path

Nama Layer Gambar 4.19
Layer yang terbentuk

dari membuat bentuk Vektor

Yang paling kiri adalah isi /ayer yang diisi warna atau
gradient yang diberikan pada bentuk vektor yang kita buat.
Clipping Path merupakan bentuk vektor yang telah kita buat.
Danyang paling kanan adalah nama dari /ayer tersebut.

Tahukah Kamu

Coba kalian buat lebih dari satu bentuk vektor, maka setiap kali kalian membuat
satu bentuk vektor akan membentuk satu /ayer baru. Mengapa demikian? Ini
karena pengaruh Shape Layers.

Seharusnya, sebelum membuat bentuk vektor terlebih
dahulu kalian memilih sifat bentuk vektor yang akan kalian
buat. Untuk memilih sifat tersebut kalian dapat
melakukannyamelalui Option Bar.

Masing-masing sifat di atas tentunya akan memengaruhi
bentuk vektor yang tercipta. Shape Layer akan membuat
bentuk vektor pada layer baru. Paths akan membuat bentuk
vektor dengan Path Seleksi ke dalam Paths Layer.
Sedangkan Fill Pixel akan membuat bentuk vekfor pada
layer yang sedang aktif atau dengan kata lain tidak membuat

bentuk vektorbaru.
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Gambar 4.20
Sifat dari Bentuk Vektor yang
terletak pada Option Bar

Gambar 4.21
Membuat bentuk
Vektor mnggunakan Pen Tool

Tahukah Kamu

Seperti yang pernah

Paths dikatakan pada awal
Shape pembahasan, bahwa
Layer Fil bentuk Vektor juga dapat

Pixel | kita buat sendiri

menggunakan Pen Tool.

Sekarang kalian akan

belajar membuat bentuk

vektor yang kalian buat sendiri menggunakan Pen Tool.

Kalian dapat membuatnya dengan 2 cara, yaitu dengan Pen
Tool atau FreeForm Pen Tool.

Buatlah halaman baru dengan nama Vektor, lalu atur Preset
Size menjadi “640 x 480" dan Contents menjadi White.
Setelah itu, kalian klik Pen Tool lalu mulailah menggambar
seperti gambar di samping. Akan tetapi, jangan lupa atur
dahulu warna bentuk vektor menjadi putih supaya mudah
untuk dilihat, juga pastikan sifat Shape Layer yang dipakai.

Jika dirasa gambar yang kalian buat perlu diperbaiki, jangan kuatir! Sebab
Photoshop telah menyediakan 7ool/ untuk menambahkan dan menghapus titik-
titik pada gambar. Kalian dapat memakainya dengan klik kanan pada Pen Tool,
pilih “Add Anchor Point Tool” untuk menambahkan dan “Delete Anchor Point
Tool” untuk menghapus, lalu klik pada gambar.

Ayo Cari Tahu

Apa yang terjadi ketika kalian membuat seleksi, kalian tahan klik kiri pada
gambar menggunakan Pen Tool?

Bukan hanya warna maupun Gradient saja yang dapat
mengisi bentuk vektor kita, kita juga dapat mengisinya
dengan gambar lain atau foto. Kita akan memasukkan foto
damaiaceh.bmp pada bentuk vektor yang telah kita buat.
Akan tetapi, sebelumnya kita harus merasterize bentuk
vektor terlebih dahulu supaya layer vektor tersebut dapat kita
perlakukan seperti /ayer pada umumnya. Caranya pilih /ayer
pada Menu Bar,lalupilih Rasterize dan Fill Content.

Setelah itu, kalian buka damaiaceh.bmp lalu drag ke halaman
bektor. Jika gambar terlalu kecil, kalian dapat mengubah
ukurannya dengan Free Transform. Maka pada Layer Palette
akan ada 3 /ayer, lalu letakkan bentuk vektor tersebut tepat di
atas gambar damaiaceh seperti gambar berikut ini.




Kemudian, kalian klik Layer yang
berisi gambar damaiaceh, lalu pilih
Layer pada Menu Bar, setelah itu pilih
“Group with Previus”. Ini akan
membuat gambar damaiaceh menyatu
dengan Layer sebelumnya, yaitu
Layer yang berisi bentuk Vektor kita.
Maka pada halaman Vektor akan
seperti di samping.

Setelah kalian mengikuti langkah-
langkah di atas, kalian masih dapat
menggerak-gerakkan gambar
damaiaceh. Jika kalian ingin hasil
yang lebih baik, kalian dapat
melakukannya dengan
menggabungkan Layer yang berisi
damaiaceh dan Layer yang berisi
Vektor. Jika kalian lupa, kalian dapat
membuka kembali pembahasan
mengenai Basic Layer.

Tahukah Kamu

Gambar 4.22
Halaman Vektor
setelah kita drag
damaiaceh.bmp

Gambar 4.23
Halaman Vektor setelah kita
drag damaiaceh.bmp

Jika kalian tidak melakukan Rasterize, maka dapat dilakukan Marge Down. Oleh
karena itu, setelah kita yakin dengan bentuk Vektor yang kita buat, kita harus
melakukan Rasterize pada Layer Vektor tersebut supaya Layer tersebut menjadi

Layerpadaumumnya.

Jikakalian mau, kalian dapat menambahkan gambar tersebut
ke dalam halaman Perdamaian yang pernah kita buat
sebelumnya. Kalian dapat mengatur ukuran serta letaknya
sesuai keinginan kalian.

Photoshop bukan hanya menyediakan alat untuk
memanipulasi gambar, tetapi juga menyediakan alat-alat
untuk menggambar, yaitu Brush Tool dan Pencil Tool. Saat
ini kita akan membahas cara penggunaan Brush Tool untuk
menghias gambarkita.

Brush Tool digunakan seperti kita menggunakan kuas.
Seperti halnya kuas yang memiliki

berbagai macam jenis Brush Tool

jugamemiliki berbagai macam jenis

kuas yang disediakan, seperti

gambar di bawah ini. Kalian dapat

klik Brush Tool pada Tool Box, lalu

pilihjenis Brush pada Option Bar.

Gambar 4.24

Halaman Perdamaian.psd
setelah kita drag gambar
dari halaman Vektor.psd
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Di samping jenis-jenis tersebut, selalu tertera angka yang
merupakan tingkat ketebalan goresan yang dihasilkan.
Kalian dapat menentukan ketebalannya melalui Master

Diameter yang pernah kita

Gambar4.25 ™ /Eﬁrusthol B bahas sedikit ketika

Brush Tool dan Pe;lcié j pEeIT oo g melakukan seleksi dengan
oo ' Magic Wand Tool.

Memang tidak ada teknik khusus, tetapi kalian dapat
melakukan banyak hal melalui Option Bar dan Brush Tool.
Jika kalian perhatikan pada Option Bar, kalian dapat
mengatur Mode, Opacity, dan Flow.

Mode digunakan untuk menentukan cara mencampurkan
goresan Brush Tool dengan gambar di belakangnya.

Opacity digunakan untuk mengatur tingkat transparansi atau
tembus pandang sapuan Brush Tool.

Gambar 4.26 Flow digunakan untuk mengatur seberapa cepat warna yang

Jenis Brush dan dioleskan terserap ke kanvas atau gambar.
ketebalannya
Photoshop juga menyediakan Palette khusus yang dapat kita
gunakan untuk mengatur Brush. Jika Brush Palette belum
terlihat, kalian dapat klik Window pada Menu Bar, lalu pilih
Brush sehingga muncul Brush Palette. Di situ kalian dapat
membuat kuas yang kalian bentuk sendiri.
Gambar 4.27

Mode, Opacity, dan
Flow pada Brush Tool

Internet Link

Untuk mendapatkan informasi
dan tutorial photoshop, kalian
dapat membukanya di
www.photoshopgurus.com

Gambar 4.29
Perdamaian.psd di hias
dengan Brush Tool

Gambar 4.28
Brush Palette

Ayo Cari Tahu

Sekarang coba kalian hias Perdamaian.psd dengan Brush Tool, kalian dapat hias
sesuka kalian. Tapi perlu di ingat, dalam menghias kalian harus memperhatikan
Layer mana yang kalian hias.




Lebih Jauh Mengenal Layer

Apa yang kalian ketahui mengenai Layer pada bab
sebelumnya belum cukup untuk membuat Layer kalian
menjadi menarik. Photoshop menyediakan efek-efek yang
dapat diterapkan pada Layer yang kalian

buat. Opacity dan Fill yang telah kalian

pelajari merupakan efek dasar dari Layer.

Kali ini kita akan mempelajari efek-efek
Layermenggunakan Mode Blend.

Pada dasarnya, Mode Blend merupakan
cara yang digunakan untuk
mencampurkan warna pada layer yang
aktif dengan gambar atau /ayer yang ada
dibelakangnya.

Untuk dapat menentukan Mode Blend,

kalian dapat melakukannya dengan tiga

cara. Cara pertama, kalian dapat memilih

padakotak pilihan yang ada di bagian kiri

Layer Palette, tepat sebelah kiri Opacity.

Atau cara kedua, kalian klik kanan pada

Layer, lalu pilih “Blending Option”.

Sedangkan cara ketiga yaitu dengan klik

pada bagian bawah Layer Palette,

kemudianklik “Blending Option™. A(ilz:ineb;lre‘:zjo

Jika kalian perhatikan ada 22 macam
Mode Blend yang disediakan oleh
Photoshop, marikita lihat kegunaannya satu per satu.

Ayo Cari Tahu

Sewaktu kalian membaca tabel di bawah ini mengenai macam-macam Mode
Blend, kalian coba praktikkan pada Perdamaian.psd sehingga kalian lebih
memahami perbedaan satu mode dengan mode yang lain.

Nama Keterangan

Setiap Pixel pada gambar ditampilkan sesuai dengan warna
Normal aslinya. Mode ini sering juga disebut Mode Threshold.

Beberapa pixel ditampilkan secara acak yang digantikan dengan
warna dasar atau warna campuran (blend).
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Pixel-pixel yang berwarna lebih ringan atau terang daripada
Diariee warna Blend akan diganti, sedangkan pixel-pixel yang
berwarna lebih gelap daripada warna Blend tidak akan diganti.

Mode ini akan mengalikan warna dasar dengan warna Blend. Jika
warna dikalikan dengan warna hitam maka hasilnya akan hitam.
Multiply Jika warna dikalikan dengan warna putih maka hasilnya adalah
warna itu sendiri. Sedangkan jika dikalikan denga warna selain
hitam atau putih maka hasilnya adalah warna yang lebih gelap.

Menggelapkan warna untuk merefleksikan warna blend dengan

Color Burn meningkatkan kontrasnya.

Menggelapkan warna untuk merefleksikan warna blend dengan

Linear Burn mengurangi kontrasnya.

Pixel-pixel yang berwarna lebih gelap dari pada warna Blend
Lighten akan diganti, sedangkan pixel-pixel yang berwarna lebih
terang dari pada warna Blend tidak akan diganti.

Mode ini akan mengalikan kebalikan warna dasar dengan warna
Blend. Biasanya menghasilkan warna yang lebih terang atau

Screen ringan. Jika warna dikalikan dengan warna hitam maka hasilnya
akan warna itu sendiri. Jika warna dikalikan dengan warna putih
maka hasilnya adalah putih.

Menambahkan terang warna dasar untuk merefleksikan warna

Color Dodge blend dengan mengurangi kontras.

Linear Dodee Menambahkan terang warna dasar untuk merefleksikan warna
& blend dengan meningkatkan brightness.

Mode ini akan mengalikan atau menyaring warna dengan

bergantung pada warna dasarnya. Warna highlight dan bayangan

Overlay dari warna dasar tetap dipertahankan. Sedangkan warna dasar

dicampur dengan warna blend untuk merefleksikan terang warna

asli.

Menggelapkan atau menerangkan warna bergantung pada warna
Soft Light blend. Efeknya akan seperti lampu sorot yang lembut pada
gambar.

Mengalikan atau menyaring warna bergantung pada warna

Hard Light blend. Efeknya akan seperti lampu sorot yang keras pada gambar.




Membakar atau menggelapkan warna dengan meningkatkan

Ve il atau mengurangi kontrasnya.
e AT Membakar gtaq mengge_:lapkan warna dengan meningkatkan atau
mengurangi brightness-nya.
Mengganti warna bergantung pada warna blend. Jika warna
Pin Lioht blend lebih ringan 50% daripada abu, maka pixel yang lebih gelap
& daripada warna blend akan diganti dan warna yang lebih terang
tidak akan diganti.
) Mengurangi warna blend dari warna dasar atau warna dasar dari
Difference warna blend, bergantung pada warna mana yang lebih terang.
) Hampir sama dengan mode Difference, hanya dengan kontras
Exclusion yang lebih rendah.
Membuat warna akhir yang berasal dari luminasi dan saturasi
Hue warna dasar serta hue dari warna blend.
) Membuat warna akhir yang berasal dari luminasi dan hue warna
Saturation dasar serta saturasi dari warna blend.
Membuat warna akhir yang berasal dari luminasi warna dasar,
Color hue, dan saturasi warna blend.
L Membuat warna akhir yang berasal dari hue dan saturasi warna
Luminosity

dasar serta luminasi warna blend.

Bagaimana? Menakjubkan bukan efek-
efek Layer dengan menggunakan Mode
Blend. Tidak hanya sampai di sini, ada
beberapa hal lagi yang dapat kalian
lakukan untuk membuat Layer kalian
semakin sempurna.

Jika kalian masuk pada Blending
Option, kalian akan mendapati
tampilan seperti di samping. Dari sini
kalian dapat mengatur banyak hal

mengenai Layerkalian.

Beberapa hal penting yang perlu

diperhatikan adalah perbedaan antara Gambar 4.31
Opacity dan Fill Opacity. Bedanya, jika Fill Opacity tidak Blending Option

akan memengaruhimode Blend yang digunakan.
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Gambar 4.32
Monitor Layer
melalui Layer Palette

Gambar 4.33
Perdamaian.psd setelah
diberi efek pada Layer

Tahukah Kamu

Kalian juga dapat menggunakan Blend If. Pertama tentukan
channel untuk menentukan blending pada channel warna
tersebut. Lalu, atur This Layer untuk menentukan daerah
pixel pada layer aktif yang akan di-blend dan Underlying
Layer untuk menentukan daerah pixel pada layer di bawah
layer aktifyang akan di-blend.

Selain itu, kalian juga dapat menggunakan Layer Style yang
telah disediakan oleh Photoshop. Jika kalian perhatikan
bagian kiri dari tampilan Blending Option, ada pilihan Drop
Shadow, Inner Shadow, dan lain-lain, itu adalah macam-
macam Layer Style pada Photoshop. Kalian dapat
mengaturnya, lalu mengaktifkan salah satu atau beberapa
dari style-style tersebut. Setelah kalian memberi efek pada
sebuah Layer, akan muncul tanda
pada Layer Palette yang membuat
kita mengetahui sebuah Layer
dikenai efek apa saja.

Pada pilihan Blend If, pilihan Grey adalah untuk mencampurkan semua Channel

warna.

Selain itu, ada beberapa macam Layer yang tidak dapat dikenai Layer Style,
yaitu Layer Background, Layer yang terkunci, dan Layer Set.

aNOKUM

Q.

%

1. Kitadapat menggunakan Crop Tooluntuk memotong bagian dari gambar.
2. Ada 4 teknik untuk membuat seleksi, yaitu menggunakan Marquee Tool,
menggunakan Pen Tool, menggunakan Lasso Tool, dan menggunakan

Magic Wand Tool.

3. Bentuk Vektor adalah suatu bentuk yang terbuat dari titik-titik yang disebut
titik Anchor dan dihubungkan dengan segmen-segmen.

4. Dalam Photoshop, kita juga dapat menggambar karena Photoshop
menyediakan Brush Tool dan Pencil Tool untuk menggambar.

5. Mode Blend digunakan untuk membuat efek-efek khusus pada Layer kita.

6. Photoshop juga menyediakan Layer Style yang dapat kita terapkan langsung
pada Layer kita. Akan tetapi, ada beberapa jenis /ayer yang tidak dapat kita
terapkan Layer Style-nya, yaitu Layer Background, Layer yang terkunci,

dan Layer Set.




A. Pengecekan Konsep
Pilihlah salah satu jawaban yang paling benar!

@ Tool di bawah ini yang tidak dapat kita @ Tool yang bukan merupakan Submenu

gunakan  untuk membuat seleksi dari Pen Tool adalah ...
adalah ... a. Convert Point Tool
a. Pen Tool c. Magic Wand Tool b. Edit Anchor Pint Tool

b. Healing Tool  d. Lasso Tool
Submenu dari Lasso Tool yang kita
gunakan untuk menyeleksi
berdasarkan perbedaan pixel adalah ...
a. Magnetic Lasso Tool

b. Lasso Tool

c. Polygon Lasso Tool

d. Magic Lasso Tool

Kegunaan dari Magic Wand Tool

adalah...

a. untuk melakukan seleksi

b. untuk melakukan seleksi berdasar
kan pixel

c. untuk melakukan seleksi berdasar
kan warna

d. untuk melakukan seleksi
berdasarkan ukuran

Pada Brush Tool, bagian yang kita
gunakan untuk memperbesar ukuran
kuas adalah ...
a. Mode

b. Opacity d. Brush Palette

Di bawah ini yang bukan merupakan
bentuk Vektor Geometris adalah ...

a. Rounded Rectangle Tool

b. Rectangle Tool

c. Polygon Tool

d. Circle Tool

Agar bentuk Vektor kita lebih
“proporsional” maka kita dapat

menahan tombol . . . ketika membuat
bentuk Vektor.

a.Alt c.Ctrl

b. Tab d. Shift

c. Master Diameter @)

c.Add Anchor Pint Tool
d. Delete Anchor Pint Tool

Pilihan yang paling tepat mengenai
macam-macam Mode Blend pada
Layeradalah. ..

a. Mode Normal = beberapa Pixel
pada gambar ditampilkan sesuai
dengan warna aslinya. Mode ini
sering juga disebut Mode
Threshold.

b. Mode Color Burn = Menggelapkan
warna untuk merefleksikan warna
blend dengan meningkatkan
kontrasnya.

c. Mode Linear Dodge =
Menambahkan terang warna dasar
untuk merefleksikan warna blend
dengan meningkatkan brightness.

d. Mode Vivid Light = Membakar atau
menggelapkan warna dengan
meningkatkan atau mengurangi
kontrasnya.

Layer berikut ini yang dapat

menggunakan Layer Style adalah. ..

a. Layer yang terkunci

b. Layer Set

c. Layer Background

d. Layer Vektor

Berikut merupakan Layer Style yang
telah disediakan oleh Photoshop 7.0,
kecuali ...

a. Drop Glow c. Inner Glow

b. Drop Shadow  d. Inner Shadow
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B. Pemahaman Konsep

Jawablah pertanyaan di bawah ini!

6000000 OO

C.

Jelaskan kegunaan masing-masing dari Lasso Too/ dan submenunya!

Mengapa ketika kita menggunakan Magic Wand Tool, awalnya kita harus memilih
Channel yang kontrasnya paling terlihat?

Levels pada Adjustment kita gunakan untuk mengatur apa?

Saat gambar telah terseleksi, apa yang terjadi jika kita melakukan /nvers?
Tuliskan apa yang kalian ketahui mengenai bentuk Vektor!

Ada 3 sifat bentuk Vektor, sebutkan dan jelaskan!

Mengapa Layer Vektor sebaiknyakita Rasterize?

Jelaskan mengenai Mode, Opacity, dan Flow pada Option Bar Brush Tool!
Apayang membedakan pada Mode Blend Color Dodge dan Linear Dodge?
Apakegunaan Blending, Option, dan Fill Opacity?

Aktifitas Siswa

Isilah Teka Teki Silang di bawah ini yang terdiri atas 5 soal mendatar dan 5 soal menurun.

1

Mendatar :

| 2 | | | | | 2. Perintah yang digunakan untuk merubah
Layer Vektor menjadi Layer pada

umumnya

Untuk memotong

Mengatur tingkat cahaya pada gambar

Salah satu sifat Vektor
0. Kita sering menjumpai RGB, Red, Green,

— 0 W

Blue pada Palette ini

Menurun :

—— 1. Untuk menggambar kita dapat

menggunakan . . . Tool dan Brush Tool

| 7 — | 3. Tool yang kita gunakan untuk membuat
| | | seleksi

il

Non-Geometris (lawan kata)
Mengatur tingkat tembus pandang

0

Beberapa pixel ditampilkan secara acak
— — dan digantikan dengan warna dasar atau warna
campuran
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A. Pengecekan Konsep
Pilihlah salah satu jawaban yang paling benar!

@ Salah satu bagian jendela CorelDRAW

yang menampung koleksi warna
disebut dengan...

a. color bar c. color window
b. color collection d. color pallete

Tool dalam program Corel DRAW yang
diwakili dengan gambar di bawah ini
disebut dengan...
a. pen tool

b. polyline tool

c. freehand tool
d. drawing tool

Untuk mewarnai sebuah objek, kita
bisa mewarnai hanya dengan satu
warna, warna gradasi bahkan dengan
pola tertentu. Tool yang digunakan
untuk menghasilkan warna gradasi
adalah...

a. paint bucket tool

b. pattern fill dialog

c. fountain fill dialog

d. texture fill dialog

Corel DRAW merupakan program
penghasil citra berformat vektor.
Tetapi kita juga bisa menghasilkan
gambar dengan format bitmap dengan
melakukan...
a. export

b. import

c. save as bitmap
d. save file

Tool dalam jendela print preview yang
memperbolehkan kita mencetak lebih
dari satu halaman dalam selembar
kertas adalah...

a.zoom tool

b. mark placement tool

c. imposition layout tool

d. picktool

Berikut ini adalah bukan bagian dari
lingkungan Photoshop 7.0 adalah ...

18]
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c. Toolbox
d. Option Bar

a. Palette
b. Dock

Di bawah ini merupakan penyataan

yang tepat dari Layer pada Phothoshop

adalah ..

a. Layer adalah mika transparan yang
terdapat pada Photoshop

b. Layer memungkinkan kita dapat
membuat gambar menjadi bergerak

c. Urutan Layer tidak mempengaruhi
gambar yang dihasilkan

d. Layer akan menjadi transparan jika
kita mengatur Opacity menjadi
rendah

Jika kalian akan mengatur tingkat

pencahayaan dari gambar, hal yang

kalian lakukan adalah...

a. Mengatur Fill dan Opacity pada
Layer Palette

b. Masuk ke Select 1alu memilih Color
Range untuk mengaturnya

c. Melalui Image pada Menu Bar, lalu
memilih Adjustments, lalu pilih
Levels

d. Menggunkan Define Brush pada
Edit

Di bawah ini yang bukan merupakan

bentuk Vektor adalah ...

a. Teks

b. Gambar yang dihasilkan mengguna

kan Brush Tool

Gambar Hati

. Gambar yang dihasilkan mengguna

kan Pen Tool

ao

Berikut merupakan Layer Style
yang telah disediakan oleh
Photoshop 7.0, kecuali...

a. Outer Shadow c. Inner Shadow
b. Outer Glow  d. Inner Glow




B. Pemahaman Konsep

Jawablah pertanyaan dibawah ini!

Sebutkan 2 jenis cara menjalankan program Core/DRAW !
Sebutkan kegunaan export dan import!

Sebutkan 4 saja tool yang terdapat dalam flyout curve!

Sebutkan perbedaan cara menggunakan rectangle tool dan 3 point rectangle tool

0000

Sebutkan nama bagian jendela CorelDRAW yang ditunjuk dengan huruf a-¢ !
(Lihat gambar dibawah).

@ Apa yang membedakan antara Color Palette dan Swatches Palette?

@ Ada 4 submenu dari Type Tool, Sebutkan dan jelaskan masing-masing!

©® Apa yang membedakan antara Crop Tool dan Lasso Tool?

© Apasaja yang dapat kita lakukan melalui Brush Palette?

@ Apa yang dilakukan pada Mode Blend “Screen?

a

e

Gambar: untuk soal no.5
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Tujuan Pembelajaran:

Setelah mempelajari bab ini diharapkan
siswa mampu:

1. Mengetahui dan memahami menu dan
ikon yang terdapat dalam perangkat
lunak pembuat presentasi

2. Mengetahui cara menggunakan dan ikon
yang terdapat dalam perangkat lunak
pembuat presentasi

3. Membuat presentasi teks dengan variasi
tabel, grafik, gambar dan diagram.

Kalian pernah melakukan presentasi
seperti gambar di samping?

Presentasi pada gambar itu menggunakan
tampilan yang menarik karena pada
gambar tersebut materi presentasinya
menggunakan software Presentasi
semacam PowerPoint.

Pada bab ini kamu akan mempelajari lebih
lanjut tentang  bagaimana membuat
presentasi menjadi lebih menarik dengan
menggunakan PowerPoint.

.~ KATA KUNCI |
B Shared Workspace ™ Hyperlink ™ Presentasi B Table
B Smart Tag B View B Audience ®m Slide

B Task Pane = Chart B Teleconference ™ Display



Peta konsep

Menggunakan
Perangkat
Lunak
Presentasi
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Menunjukkan
Menu dan Ikon
yang terdapat
dalam
Perangkat lunak
Pembuat
presentasi

Menggunakan
Menu dan Ikon
yang Terdapat
dalam Perangkat
lunak Pembuat
presentasi

Membuat
Presentasi Teks
dengan
Variasi Table,
Grafik, Gambar,
dan
Diagram




Menggunakan Perangkat
Lunak Presentasi

Pengantar

Pernahkah kamu mendengar kata presentasi? atau mungkin
kalian pernah menyaksikan suatu presentasi?

Presentasi merupakan suatu kegiatan “berbicara” di depan
orang lain untuk menyampaikan pesan. Presentasi memiliki 3
komponen utama, yaitu:

» Orang yang menyampaikan pesan (presenter),
» Media atau perangkat pendukung,
» Pendengar atau penerima presentasi (audience).

Tujuan dari presentasi dapat bermacam-macam, misalnya:

» Sarana untuk memasarkan suatu barang atau jasa. Presentasi
semacam ini biasanya disertai alat peraga, gambar ataupun
contoh produk yang akan dijual. Presentasi dengan tujuan
semacam ini juga umum terjadi dikalangan bisnis, misalnya
saat peluncuran produk baru untuk diperkenalkan ke
masyarakat umum

Tahukah Kamu

Indonesia merupakan pengguna program Presentasi PowerPoint ini lebih besar
dari pada program yang lain, program ini merupakan program yang paling
mudah digunakan dalam membuat presentasi yang menarik.

» Memberikan informasi, misalnya presentasi materi pelajaran
yang diberikan oleh dosen dalam kuliah atau seminar.

» Meyakinkan pendapat orang lain. Presentasi seperti ini
biasanya dilakukan sebagai reaksi atas suatu kejadian atau
pendapat dan presenter ingin meyakinkan pendapatnya
kepada para audience.

Konsep presentasi berdasarkan interaksi dengan audience
setidaknya dapat dibedakan menjadi dua, yaitu presentasi

langsung dan presentasi tidak langsung.
o BAB 5 Menggunakan Power Point I




Ayo Cari Tahu

Apa saja bedanya
antara program
PowerPoint
dengan program
aplikasi
Microsoft Office
lainnya?

Gambar 5.1
Contoh Microsoft
PowerPoint
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> Presentasi langsung terjadi saat presenter dan audience

berkomunikasi secara langsung pada saat yang sama (real/
time). Untuk menampilkan presentasi pada tipe ini, dapat
digunakan media seperti makalah, poster, slide, ataupun file
presentasi. Tidak ketinggalan papan tulis, proyektor, dan
komputer sebagai alat bantu pendukung presentasi. Pada
jenis presentasi ini, komunikasi dapat dilakukan dua arah,
misalnya dalam menanggapi presentasi ataupun saat
mengajukan pertanyaan. Teleconference juga dapat
dikategorikan sebagai presentasi langsung karena presenter
maupun audience dapat berkomunikasi secara langsung
menggunakan media jaringan internet sebagai perangkat
pendukung. Peralatan yang semakin canggih saat ini
memungkinkan fteleconference dilakukan lebih interaktif
tanpa penundaan (delay) yang berarti. Selain ditunjang
dengan jaringan internet berkecepatan tinggi, peralatan
jaringan maupun presentasi terkini seperti TV, proyektor,
kamera video, maupun komputer memungkinkan hal ini
terjadi. Kehadiran teknologi 3G atau bahkan 3,5 G
misalnya, menjadi salah satu contoh media yang cukup
efektif dalam melakukan feleconference.

Presentasi secara tidak langsung seperti TV, koran, tabloid,
ataupun CD tutorial merupakan contoh presentasi tidak
langsung. Belakangan situs internet maupun e-learning
menjadi salah satu media presentasi tidak langsung yang
cukup berkembang. Presentasi ataupun makalah presentasi
dapat disajikan interaktif secara onl/ine. Media yang satu ini
belakangan banyak digunakan kalangan bisnis untuk
meningkatkan pengetahuan karyawan karena dipandang
jauh lebih murah dan efektif.

Untuk membuat presentasi dalam
bentuk file, digunakan perangkat
lunak presentasi. Perkembangannya
pun cukup cepat karena banyaknya
tuntutan yang harus dipenuhi untuk
menyempurnakan presentasi. Bila
dahulu aplikasi semacam ini hanya
terbatas untuk menampilkan teks
ataupun gambar, saat ini perangkat
lunak aplikasi sudah melangkah jauh
dengan makin beragamnya
kemampuan yang dimiliki, seperti
kemampuan untuk menampilkan

slide show, mengacu ke aplikasi lain, hingga kemampuan
untuk menampilkan animasi. Kebutuhan akan perangkat lunak




presentasi ini pada dasarnya dilandasi oleh sifat manusia itu
sendiri yang lebih mudah mempelajari sesuatu lewat tampilan
baru yang memikat. Oleh sebab itu, tidak heran bila perangkat
lunak aplikasi ini menjadi salah satu perangkat lunak yang
paling berkembang, baik dari sisi fasilitas maupun aplikasinya.
Semua aplikasi presentasi yang ada saat ini berusaha disajikan
semenarik mungkin sehingga pesan yang ingin disampaikan
dalam presentasi lebih jelas dan mudah dimengerti.

Beberapa perusahaan software terkemuka di dunia juga turut
meramaikan pasar program presentasi, di antaranya Microsoft
dengan produk yang bernama Microsoft PowerPoint (yang
pasar software nyamencapai diatas 50 % dari seluruh pengguna
komputer di seluruh dunia), atau Sun Microsystem dengan
produk lisensi gratisnya yaitu StarOffice Impress.

Di Indonesia, penggunaan program Presentasi PowerPoint
lebih besar dari pada program presentasi yang lain. Oleh karena
itu, semua contoh latithan dalam buku ini menggunakan
program aplikasi PowerPoint. Pembelajaran pada buku ini
difokuskan pada Microsoft Office PowerPoint 2003, walaupun
saat ini sudah dikembangkan lebih lanjut menjadi versi 2007.

Untuk menjalankan PowerPoint 2003, spesifikasi komputer
minimal yang diperlukan adalah sistem operasi Windows 98
atau lebih tinggi, pentium 233 Mhz (dianjurkan Pentium 3),
RAM 64 MB(dianjurkan 128 MB), Disk Space 245 MB
termasuk 115 harus tersedia pada harddisk dengan sistem
operasi.

Microsoft PowerPoint merupakan salah satu perangkat lunak
yang sangat populer dalam menunjang kegiatan presentasi.
Sejak diperkenalkan dalam Microsoft Office 1.0 Versi Beta,
aplikasi ini langsung menyedot perhatian praktisi dalam
merancang slide presentasi yang saat itu didominasi oleh Lotus.
Software serupa antara lain Corel Presentation yang
dikeluarkan oleh Corel dan Lotus Professional yang berisikan
aplikasi office dari Lotus dan sebagainya.

Beberapa fasilitas baru yang terdapat pada PowerPoint 2003,

antara lain :

1. Peningkatan kemampuan untuk berintegrasi dengan
berbagai jenis aplikasi media sehingga dengan kemampuan
ini, kita dapat menjalankan file-file movie secara full screen
pada PowerPoint. Hal ini dapat dilakukan karena
PowerPoint mendukung beberapa format file media, di
antaranya ASX, WMX, M3U, WVX, WAX, dan WMA.

2. Sistem navigasi slideshow yang baru sehingga dengan
bantuan sistem nevigasi ini, kita dapat melihat slideshow
pada saat merancang presentasi.
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3. Dukungan smart tag sehingga dalam proses pembuatan
animasi slide lebih banyak template dan dukungan financial
simbol yang lebih optimal.

4. Untuk transfer image, PowerPoint 2003 dapat menjaga
resolusi bitmap dengan lebih baik.

5. Fasiltas Document Workspace, dalam PowerPoint 2003
akan memudahkan proses editing dengan melibatkan co-
authoring.

Beberapa fitur baru diimplementasikan pada PowerPoint 2003
oleh Microsoft. Di samping persoalan kopatibelitas dengan
aplikasi office lainnya, seperti kemampuan Instant Messaging,
berbagi area kerja (shared workspace), Smart Tag (yang
tersedia sejak awal PowerPoint), sehingga menjadikan
PowerPoint sebagai aplikasi presentasi yang powerfull sejak
pertama kali diperkenalkan, kemudian fitur-fitur ini terus
dikembangkan sejalan dengan perkembangan Microsoft
PowerPoint itu sendiri.

Baberapa fitur-fitur baru yang unik pada PowerPoint 2003,

antara lain :

» Packaging presentations. Pada edisi PowerPoint XP dan
edisi sebelumnya, untuk melakukan proses Packing ke
dalam bentuk Autorun Presentation CD harus dilakukan
dalam beberapa tahap, namun saat dijalankan pada sistem
lain, maka terlebih dahulu harus dilakukan instalasi
PowerPoint Viewer sebagai sarana untuk menjalankan s/ide
presentasi tanpa PowerPoint. Jika pada sistem tersebut tidak
terdapat Microsoft PowerPoint, maka dengan kekurangan
tersebut pada edisi 2003 ini dilakukan langkah
penyempurnaan terhadap proses packing presentations
sehingga seorang user tidak harus dipusingkan lagi dengan
langkah yang panjang karena proses tersebut dapat
dilakukan dalam satu langkah mudah. Dengan fasilitas
Package for CD, semua kebutuhan untuk membuat sebuah
autorun presentation CD telah disatukan ke dalam satu
kesatuan yang utuh sehingga presentasi s/ide yang dibuat
dapat dijalankan pada sistem user yang lain sekalipun tanpa
PowerPoint.

» Slide show annotations. Dengan fasilitas ini memungkinkan
bagi seorang Presenter untuk menambahkan catatan tangan
pada slide pada saat presentasi tengah berlangsung, atau
menyimpannya menjadi catatan slides pada presentasi
berikutnya.

» Improved navigation tools. Slide Navigator diganti dengan
dengan yang lebih mudah dalam penggunaanya yang
ditempatkan pada foolbar untuk berpindah ke presentasi
slide lainnya.
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» Larger movie display. Pada PowerPoint 2003, kita dapat
menampilkan file movie yang ditumpangkan pada
PowerPoint slide secara full screen.

Memulai Program PowerPoint 2003

Untuk mengaktifkan program Presentasi Microsoft
PowerPoint 2003, ikuti langkah-langkah sebagai berikut:
1. Klik Tombol Start pada Taskbar
Windows.
2.Klik A/l Pograms.
3. Cari Microsoft Office.
4. Kemudian, Pilih Microsoft Office
PowerPoint 2003.

Menjalankan Slide

Untuk menjalankan slide presentasi
dapat dilakukan langkah sebagai
berikut.

1. Klik menu Slide Show -> View
Show, atau dengan menekan
tombol F5.

Langkah ini dilakukan jika akan
menjalankan slide show dari
halaman pertama.

2. Klik Tombol

Gambar 5.2
Start pada Taskbar

(Slide Show) yang terdapat pada Slide Viewer atau dengan
menekan tombol Shift + F5 untuk menjalankan slide show
dari lokasi pointer berada.

Untuk keluar dari halaman aplikasi PowerPoint, langkahnya
adalah pilih menu File, lalu klik tombol Exit.

Ayo Cari Tahu

Menurut kalian, apa

saja kelebihan dari

program PowerPoint

ini, selalg untuk Gambar 5.3
membantu kita dalam Tampilan Lembar Kerja
hal presentasi. PowerPoint 2003
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Mengenal Lebih Dekat PowerPoint 2003

Pepatah mengatakan “Tak Kenal Maka Tak Sayang”.

Oleh karena itu, kita juga akan berkenalan dengan fasilitas
yang terdapat dalam Microsoft Power Point 2003. Fasilitas-
fasilitas tersebut, yaitu:
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1.

7.

8. Drawing Toolbar:

9.

Title Bar

. Menu Bar

Toolbar

Slide Tab

. Outline Tab

Task Pane

Slide Pane

Notes Pane

: Merupakan komponen yang berisi tema

dari file dan nama aplikasi yang
dijalankan dalam hal ini adalah
Microsoft PowerPoint.

: Merupakan komponen yang berisi

menu-menu yang berisi perintah-
perintah yang ada pada Microsoft
PowerPoint.

:Merupakan komponen dari

Microsoft PowerPoint yang berisi icon-
icon yang merepresentasikan perintah-
perintah yang diwakilinya.

Merupakan bagian dari Microsoft
PowerPoint yang menampilkan
halaman presentasi dalam bentuk s/ide.

: Merupakan komponen dari Microsoft

PowerPoint yang me-nampilkan
outline dari halaman presentasi.

: Merupakan komponen dari Microsoft

PowerPoint yang me-mungkinkan
pengguna melakukan beragam
pekerjaan tanpa menutup file presentasi
yang sedang dijalankan. Task Pane ini
merupakan alat bantu untuk beberapa
keperluan. Microsoft PowerPoint
memiliki 12 pekerjaan yang dapat
dilakukan menggunakan Task Pane.
Beberapa pekerjaan juga dapat
dilakukan sekaligus dengan
menggunakan 7ask Pane ini dalam
kondisi-kondisi tertentu.

: Merupakan bagian isi dari presentasi

yang akan disajikan.

Merupakan bagian dari Microsoft
PowerPoint yang dapat digunakan
untuk mengatur posisi maupun bentuk
dari presentasi yang akan disajikan.

: Merupakan bagian yang dapat

digunakan sebagai catatan pendukung
berbasis teks dari sebuah halaman
presentasi.



10. Status Bar : Merupakan bagian dari
Microsoft PowerPoint
yang berfungsi untuk
mengidentifikasi status
dan kondisi yang sedang
terjadi pada halaman yang
sedang aktif.

—>Q
—0
—»0
—»0
(-]
—>0
.-’0

Keterangan Menu Jendela Program PowerPoint

: Ikon menu

: Tombol pengatur tampilan jendela program
: Baris judul (7itle Bar)

: Baris menu (Menu Bar) Gambar 5.4

: Baris alat standar (Standard Tool bar) Ta”%ife%i%%f; e
: Baris alat format (Formating Tool bar)

: TaskPane

: Tombol tampilan (Showing Buttons)

: Catatan (Notes)

: Baris status (Status Bar)

: Jendela presentasi

<
<

Q<

'y
© o
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Mengenal Ikon Microsoft PowerPoint 2003

Ikon adalah sebuah simbol yang dibuat untuk mempermudah
penggunaan perintah pada Menu bar. Biasanya, ikon ini berisi
perintah-perintah yang sering diakses oleh pengguna. Ikon-
ikon tersebut akan dikelompokkan dalam suatu bar yang
bernama tool bar.

Pada Microsoft PowerPoint secara default (umum), terdapat
dua buah Tool bar yaitu 'Standard Tool bar' dan 'Formatting
Tool bar' yang sudah dalam keadan aktif. Dua buah Toolbar ini
secara tampilan dapat diubah-ubah sesuai dengan keinginan
dengan cara melakukan click and drag. Berikut ini adalah
beberapa perintah pada toolbar Standard.

**éé**** YVVV V V VVYVY VYVVY ¥ 4
112) 606000 OO0 & & TTPITEPDEIZ B 2D
Tampilan tool b(f);”a;;:zl;adl;zf f’owerPoint 2003

1. New : Menampilkan file presentasi baru.
2. Open : Menampilkan file presentasi yang

telah dibuat sebelumnya.

o BAB 5 Menggunakan Power Point I




Internet Link

Kunjungi alamat
http://www.slide
share.net untuk
menambah
wawasan tentang
PowerPoint.
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3. Save

4. Permission :

5. Email

6. Print

7. Print
Preview

8. Spelling

9. Cut

10. Copy

11. Paste

12. Format
Painter

13. Undo

14. Redo

: Menyimpan file presentasi yang aktif. Jika

dokumen presentasi baru saja dibuat, menu
ini akan menampilkan kotak dialog 'Save As'
yang memungkinkan dilakukannya
penyimpanan file dokumen presentasi yang
sedang aktif.

Memungkinkan dilakukannya pengendalian
hak untuk membuka atau mengganti
dokumen beserta dengan batas waktu akses
yang diijinkan.

: Memungkinkan pembuatan pesan e-mail

dimana file presentasi yang sedang aktif akan
dimasukkan sebagai file attachment.

: Memungkinkan dilakukannya pencetakan file

presentasi yang sedang aktif menggunakan
printer standar (defaultf) yang diatur pada
komputer yang digunakan.

: Menampilkan presentasi yang sedang aktif

dalam mode preview sebelum dicetak.
Nantinya pencetakan dokumen presentasi
akan terlihat persis seperti yang terlihat pada
tampilan Print Preview ini.

: Memungkinkan dilakukannya pemeriksaan

ejaan dan gaya dari file presentasi yang
sedang aktif.

: Memungkinkan dilakukannya cut atau

menggunting teks ataupun objek yang dipilih
dan menyimpannya dalam clipboard atau
memori sementara pada dokumen. Jika teks
atau objek ingin ditampilkan kembali pada
lokasi lain, digunakan perintah 'Paste'.

: Memungkinkan dilakukannya penggandaan

teks ataupun objek pada lokasi yang lain.
Perintah ini akan menyimpan teks atau objek
dalam memori sementara/clipboard dokumen
dan jika kita ingin menggandakannya,
digunakan perintah 'Paste’'.

: Perintah untuk menempelkan teks ataupun

objek hasil penggandaan (copy) atau
pengguntingan (cuf) pada lokasi yang telah
ditentukan dalam dokumen.

: Memungkinkan dilakukannya penggandaan

format dari teks ataupun obyek terpilih dan
mengimplementasi-kannya pada objek yang
lain yang sejenis.

: Membatalkan tugas/perintah yang telah

dijalankan sebelumnya.

: Memungkinkan dilakukannya kembali



tugas/perintah yang telah dibatalkan
sebelumnya.

15. Insert Chart:Memungkinkan diaktifkannya 'Microsoft
Graph' yang selanjutnya akan menyisipkan
objek grafik pada halaman presentasi yang
sedang aktif.

16. Insert Tuble: Memungkinkan penyisipan sebuah tabel pada
halaman presentasi yang sedang aktif.

17. Tables and : Menampilkan toolbar 'lTables and Borders'

Borders yang digunakan untuk memformat tampilan
table.

18. Insert : Membuka kotak dialog 'Hyperlink' yang

Hyperlink memungkinkan dimasukkannya sebuah
hyperlink atau tautan kesebuah situs, alamat e-
mail, dokumen lain, atau file presentasi
lainnya. Untuk mengaktifkan icon ini, aplikasi
harus berada pada sebuah halaman s/ide aktif.

19. Insert : Menempatkan sebuah worksheet excel pada
Microsoft  slide yang sedang aktif.
Excel
Worksheet

20. Show : Menampilkan format teks dalam 'Outline
Formatting Pane'.

21. Show/ : Menampilkan atau menyembunyikan grid atau

Hide Grid  garis putus-putus yang dapat berfungsi
sebagai acuan pada file presentasi.

22. Color : Membuka sebuah menu yang memungkinkan

Grayscale dilakukannya preview presentasi yang sedang
aktif dalam warna, grayscale, ataupun warna
standar.

23. Zoom : Memungkinkan pembesaran atau pengecilan
ukuran tampilan halaman sesuai dengan
persentase besar tampilan yang dimasukkan.

24. Microsoft : Membuka task pane 'Help' untuk melihat

PowerPoint infomasi ataupun keterangan yang dibutuhkan
Help seputar Microsoft PowerPoint.

Berikut ini adalah beberapa perintah tool bar Formating.

4 4 éé** YV vV YVy vy v v v
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Gambar 5.6 Tampilan tool bar Formating PowerPoint 2003

1. Font Name: Menampilkan jenis font yang bisa dipilih.
2. FontSize : Menampilkan ukuran font yangbisa dipilih.
3. B : Menebalkan huruf.

4. 1 : Memiringkan huruf.

5. U : Menggaris bawahi huruf.

6. S : Memberi efek bayangan pada huruf.
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Gambar 5.7
Tampilan Menu
File PowerPoint 2003
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= =0

0.
1.
12.

13.

14.
15.

16.

Left Justify: Meratakan tulisan di sebelah kiri.
Center  : Meratakan tulisan di tengah.

Right : Meratakan tulisan di sebelah kanan.
Numbering : Memberikan urutan penomoran tulisan.

Bullets  : Memberikan urutan dengan menggunakan
simbol.

Increase : Membesarkan ukuran font yang dipakai.

FontSize

Decrease : Memperkecil ukuran font yang dipakai.
Font Size
Font Color :
Slide
Design
New Slide : Menambahkan slide baru.

Memberikan warna pada huruf.
: Membuat design pada slide yang dipakai.

Selain toolbar di atas, program Microsoft PowerPoint juga
menyediakan toolbar yang lain. Kalian bisa melihat toolbar
tersebut dengan cara klik menu lalu pilih View -> Toolbar.
Kemudian, pilih toolbar sesuai dengan daftar yang ada.

Mengenal Menu dan SubMenu Microsoft
PowerPoint 2003

Menu FILE

Menu File berisi kumpulan perintah standar yang berlaku
untuk seluruh dokumen.

Keterangan SubMenu File

>

>

New : Perintah yang digunakan untuk
membuat fi/e baru.

Open : Perintah yang digunakan untuk
membuka file yang pernah dibuka
sebelumnya.

Close : Perintah yang digunakan untuk
menutup file yang sekarang dibuka

Save : Perintah yang digunakan untuk
menyimpan file.

SaveAs : Perintah yang digunakan untuk
menyimpan file dalam format yang
berbeda.

Save as Web Page : Perintah yang digunakan untuk
menyimpan file dalam bentuk web.

File Search Perintah yang digunakan untuk

mencari file yang pernah disimpan.




Permission

Package for CD

Web Page Preview :

» Package for CD

A\

YV VYV VY VY

Y

Web Page Preview :

Page Setup
Print Preview
Print

Send To

Properties

Recent File

Exit

Menu EDIT

: Perintah yang digunakan untuk

menetapkan akses yang bisa
memodifikasi atau membuka file
persentasi yang dibuat.

: Perintah yang digunakan untuk

membuat paket CD Presentasi.
Perintah yang digunakan untuk
melihat tampilan file dalam bentuk
halaman Web yang dibuat.

: Perintah yang digunakan untuk

membuat paket CD Presentasi.
Perintah yang digunakan untuk
melihat tampilan file dalam bentuk
halaman Web.

: Perintah yang digunakan untuk

mengatur halaman.

: Perintah yang digunakan untuk

melihat tampilan dari file yang dibuat

: Perintah yang digunakan untuk

mencetak.

: Perintah yang digunakan untuk

mengirim file melalui media yang
disediakan berupa email.

: Perintah yang digunakan untuk

melihat properti file yang dibuat.

: Perintah yang digunakan untuk

membuka file yang pernah dibuka
sebelumnya.

: Perintah yang digunakan untuk

Keluar dari Program.

Menu Edit berisi perintah-perintah pengeditan dokumen yang
sering dilakukan.

Keterangan SubMenu Edit

>

>

>

Can t Undo

Repeat Slide
Design

Cut

: Perintah yang digunakan untuk keluar

dari program.

: Perintah yang digunakan untuk

mengulangi desain dari side yang
pernah dibuat.

: Perintah yang digunakan untuk

memotong.

BAB 5 Menggunakan Power Point I

Gambar 5.8
Tampilan Menu Edit
PowerPoint 2003
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> Copy
> Office Clipboard

» Paste

» Paste Special

» Pasteas Hyperlink :

Clear
Select All
Duplicate

Delete Slide

YV V VYV V V¥V

Find

» Replace

» Goto Property

» Links

> Object

Menu VIEW

: Perintah yang digunakan untuk

mengkopi.

: Perintah untuk memunculkan

kata/kalimat yang pernah dikopi ke
dalam presentasi yang dibuat.

: Perintah yang digunakan untuk

menaruh hasil kopian.

: Perintah yang digunakan untuk

menaruh hasil kopian dengan metoda
khusus.

Perintah yang digunakan untuk
menaruh hasil kopian dalam bentuk
link.

: Perintah yang digunakan untuk

menghapus tulisan yang dibuat.

: Perintah yang digunakan untuk

memilih semuanya.

: Perintah yang digunakan untuk

menggandakan slide.

: Perintah yang digunakan untuk

menghapus slide.

: Perintah yang digunakan untuk

mencari suatu kata/kalimat/tulisan
dalam presentasi yang dibuat.

: Perintah yang digunakan untuk

mengganti suatu kata/kalimat/tulisan
dalam presentasi yang dibuat.

: Perintah yang digunakan untuk

menuju ke properti suatu objek.

: Perintah yang digunakan untuk

menghubungkan suatu objek dalam
presentasi.

: Perintah yang digunakan untuk

menambahkan objek dalam
presentasi yang dibuat.

Menu View berisi pengaturan tampilan menu-menu aplikasi

PowerPoint.

Keterangan SubMenu View

» Normal

Gambar 5.9
Tampilan Menu View
PowerPoint 2003
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Perintah yang digunakan untuk
melihat presentasi yang dibuat dalam
tampilan normal.



Slide Sorter

Slide Show

Notes Page

Master

Color/Grayscale

Task Pane
Toolbars

Ruler

Grid and Guides

Header and Footer :

Markup

Zoom

: Perintah yang digunakan untuk

melihat seluruh slide yang dibuat.

: Perintah yang digunakan untuk

melihat presentasi yang dibuat
sebagai presentasi elektronik dan
dapat dilihat tampilannya dalam satu
layar penuh.

: Perintah yang digunakan untuk

melihat presentasi yang dibuat dalam
tampilan Catatan.

: Perintah yang digunakan untuk

melihat presentasi yang dibuat dalam
tampilan utama.

: Perintah yang digunakan untuk

melihat presentasi yang dibuat dalam
tampilan Warna atau abu-abu.

: Perintah yang digunakan untuk

menampilkan jendela perintah.

: Perintah yang digunakan untuk

menampilkan toolbar.

: Perintah yang digunakan untuk

menampilkan penggaris untuk
membantu dalam perapihan tulisan.

: Perintah yang digunakan untuk

menampilkan grid dan garis panduan

Perintah yang digunakan untuk
menampilkan catatan atas dan catatan
bawah.

: Perintah yang digunakan untuk

memanipulasi yang telah dibuat.

: Perintah yang digunakan untuk

membesarkan tampilan presentasi
yang dibuat.

Menu INSERT

Menu Insert berisi perintah-perintah untuk menyisipkan slide
serta objek-objek presentasi.

Keterangan SubMenu Insert

» New Slide : Perintah yang digunakan untuk
menambah slide baru.

: Perintah yang digunakan untuk

Gambar 5.10
Tampilan Menu Insert

> Duplicate Slide PowerPoint 2003
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Gambar 5.11
Tampilan Menu Format
PowerPoint 2003
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Slide Number

Date and Time

Symbol

Comment

Slides from Files

Slides from Outline :

Picture

Diagram
Text Box
Movies and Sounds:
Chart
Table

Object

YV V VYV Y ¥V V VYV V

Hyperlink

Menu FORMAT

Menu Format berisi perintah untuk mengatur teks,

: Perintah yang digunakan

: Perintah yang digunakan

: Perintah yang digunakan
: Perintah yang digunakan
: Perintah yang digunakan

: Perintah yang digunakan

melakukan duplikasi dari model slide
yang sudah ada.

: Perintah yang digunakan untuk

menampilkan nomor slide.

: Perintah yang digunakan untuk

menampilkan tanggal dan jam pada
slide yang dibuat.

: Perintah yang digunakan untuk

memasukkan simbol pada slide.

: Perintah yang digunakan untuk

menambahkan komentar pada slide
yang dibuat.

: Perintah yang digunakan untuk

menambahkan slide dari slide file
yang sudah ada.

Perintah yang digunakan untuk
menambahkan slide dari tampilan
outline.

: Perintah yang digunakan untuk

menambahkan gambar.

untuk
memasukkan diagram.

untuk
memasukkan text box.
Perintah yang digunakan
menambahkan film dan suara.

untuk

untuk
memasukkan chart.

untuk
menambahkan tabel.

untuk
menambahkan objek.

untuk
membuat hyperlink.

layout,

background, dan sebagainya.

Keterangan SubMenu Format

» Font :

Perintah yang digunakan  untuk

memformat huruf



» Bullets and . Perintah yang digunakan untuk
Numbering memformat bullets / numbering.

> Alignment : Perintah yang digunakan untuk
mengatur letak tulisan.

» Line Spacing . Perintah yang digunakan untuk
mengatur jarak antar tulisan.

» Change Case : Perintah yang digunakan untuk
merubah hurufawal tulisan.

» Replace Fonts . Perintah yang digunakan untuk
menggantikan font yang dipilih
dengan font yang lain.

» Slides Design : Perintah yang digunakan untuk
mendesain slide.

» Slides Layout : Perintah yang digunakan untuk
mengatur tampilan slide.

» Background : Perintah yang digunakan untuk
mengatur latar belakang.

» Object : Perintah yang digunakan untuk
mengatur objek.

Menu TOOLS

Menu 7ools berisi perintah pengaturan menu, pemeriksaan
ejaan, pemilihan bahasa, dan sebagainya.

Keterangan SubMenu Tools

> Spelling : Perintah yang digunakan untuk
melakukan pengejaan tulisan.

» Research : Perintah yang digunakan untuk
meneliti kata yang ada.

> Thresaurus : Perintah yang digunakan untuk
melakukan koleksi kata.

» Language : Perintah yang digunakan untuk
menentukan pengaturan bahasa.

> Speech : Perintah yang digunakan untuk Gambar 5.12
membaca tulisan pada PowerPoint Tampilan Menu Tools
oleh komputer. PowerPoint 2003

»  Shared Workspace : Perintah yang digunakan untuk
berbagi lembar kerja.

> Compare and : Perintah yang digunakan untuk

Merge membandingkan presentasi yang kita

buat dengan yang lain dan
menggabungkannya.
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Gambar 5.13
Tampilan Menu Slide Show
PowerPoint 2003
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»  Online
Collaboration

»  Macro
»  Add-Ins

» AutoCorrect
Options

»  Customize

: Perintah yang digunakan untuk
menggabungkan presentasi secara
online.

: Perintah yang digunakan untuk
membuat program makro.

: Perintah yang digunakan untuk
menambahkan add-ins.

: Perintah yang digunakan untuk

mengatur pembetulan secara
otomatis.

: Perintah yang digunakan untuk

mengatur program sesuai dengan
keinginan.

> Option : Perintah yang digunakan untuk
mengaktifkan option.
Menu SLIDE SHOW

Menu Slide Show berisi perintah pengaturan transisi antar
slide, animasi, objek presentasi, dan lain sebagainya.

Keterangan SubMenu Slide Show

> View Show

v

Set Up Show

v

Rehearse Timings
Recors Narration
Action Buttons
Action Settings

Animation
Schemes

YV VvV YV V VY

> Slide Transition

: Perintah yang digunakan
: Perintah yang digunakan
: Perintah yang digunakan
: Perintah yang digunakan
: Perintah yang digunakan
: Perintah yang digunakan

Custom Animation

: Perintah yang digunakan untuk

melihat presentasi dalam bentuk
slide show.

untuk
mengatur tampilan.

untuk
mengatur waktu.

untuk
merekam.

untuk
memasukkan tombol aksi.

untuk
mensetting aksi.

untuk
menentukan scheme animasi/
Perintah yang digunakan untuk
menentukan animasi sesuai
keinginan.

. Perintah yang digunakan untuk

menentukan transisi pada slide.



> Hide Slide : Perintah yang digunakan untuk

menyembunyikan slide.

» Custom Shows : Perintah yang digunakan untuk
menentukan tampilan sesuai
keinginan.

Menu WINDOW

Menu Window berisi fasilitas untuk berpindah antar dokumen
presentasi dan membuka beberapa dokumen presentasi.

Keterangan SubMenu Window

» New Windows : Perintah yang digunakan untuk
membuka jendela tampilan yang
baru.
> ArrangeAll : Perintah yang digunakan untuk
mengatur keseluruhan jendela.
» Cascade : Perintah yang digunakan untuk
membuka jendela secara bertumpuk Gambar 5.14
» Next Pane : Perintah yang digunakan untuk pergi  Tampilan Menu Windows
ke pane yang lain. PowerPoint 2003
» Active File : Perintah yang digunakan untuk
membuka file aktif.
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Menggunakan Menu dan lkon yang Terdapat
dalam Perangkat Lunak Pembuat Pesentasi

Jika Kalian ingin membuat PowerPoint dengan menggunakan
AutoContent Wizard, ikuti petunjuk di bawah ini:

1. Pilih from AutoContent Wizard, maka akan muncul menu
AutoContent Wizard yang dapat dipilih opsinya oleh
desainer. Seperti terlihat pada Gambar di bawah ini.

Gambar 5.15
Tampilan Form AutoContent Wizard
PowerPoint 2003

2. Dari menu awal AutoContent wizard, kemudian klik
tombol Next, lalu akan dilanjutkan dengan memilih tipe
presentasi.

Gambar 5.16
Tampilan Menu Awal AutoContent
Wizard PowerPoint 2003

3. Tentukan salah satu tipe presentasi yang akan digunakan,
yang dikelompokkan ke dalam empat kelompok tipe
presentas:
> All, menampilkan semua tipe presentasi yang ada pada

PowerPoint 2003.

» General, menampilkan tipe-tipe presentasi yang umum
digunakan.

» Corporate, menampilan tipe-tipe presentasi untuk
presentasi perusahaan, Project, digunakan untuk tipe
presentasi proyek, Sales/Merketing, digunakan untuk tipe
presentasi perdagangan dan pemasaran.

» Pilih salah satu, kemudian tekan tombol Next.
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4. Selanjutnya, tentukan model presentasi yang akan
digunakan. Terdapat beberapa opsi pilihan, antara lain :
» On-Screen Presentation, digunakan untuk presentasi
pada layar komputer atau data display.
» Web Presentation, digunakan untuk presentasi melalui
web, semisal feleconference.
» Black and White Presentation, digunakan untuk
membuat sl/ide dalam format hitam dan putih.
» Color Overheads, jika akan menggunakan presentasi
dengan Overhead projector, semisal OHP.
> 35 mm slide, untuk membuat slide ukuran film slide.
5. Selanjutnya, berikan identitas dari slide presentasi. Lalu
tekan tombol Next.
6. Akhiri dengan menekan tombol Finish.

Gambar 5.17 Gambar 5.18
Tampilan Menu AutoContent Wizard Tampilan Menu AutoContent Wizard
PowerPoint 2003 PowerPoint 2003

Ayo Cari Tahu

Dalam merancang presentasi slide dengan PowerPoint, ada beberapa kaidah yang
harus diperhatikan, antara lain:

1. Clear, utamakan kejelasan dalam mendesain sebuah Slide PowerPoint yang

dapat memenuhi kaidah estetika dan ergonomis, seperti:

a. Penggunaan warna hurufyang tidak terlalu tajam.

b. Terlalu banyak warna warni, hal ini dapat menimbulkan kelelahan mata
audien.

c. Pemilihan warna depan dengan background yang tidak tepat.

d. Penggunaan tipe huruf dengan desain yang terlalu unik, misalnya kaligrafi,
sehingga audien yang berada pada jarak yang jauh dari layar akan kesulitan
untuk menangkap makna tulisan.

2. Consistent
a. Konsisten dalam menggunakan ukuran huruf dalam satu halaman slide yang
sama.
b. Konsisten dalam pengaturan warna.
c. Isislide tidak bermakna Ambigous, sehingga membingungkan audien.
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3. Big
a. Gunakan hurufyang besar dan jelas.
b. Gunakan gambar yang besar dan jelas.

4. Progressive
a. Halaman slide dapat diakses dengan mudah.
b. Jangan menggunakan animasi yang berlebihan.
c. Pilihlah animasi yang sesuai sehingga audiens tidak terkesan menunggu
animasi selesai.
d. Strukturisasi materi tersusun dengan baik sehingga mempermudah proses
pembuatan Link.

5. Simple
a. Satu file presentasi mengandung satu makna content.
b. Satuhalaman presentasi hanya mengandung satu jenis informasi atau ide.
c. Jangan menggunakan animasi yang berlabihan dalam satu halaman karena
hal ini tidak akan menarik lagi untuk dilihat oleh audiens.

Sekilas Info

PowerPoint Juga Dahsyat untuk Mendongeng

JAKARTA, MINGGU - Perkembangan
teknologi mulai membuat orang mengubah
cara mereka mendongeng. Dulu, orang
menyampaikan dongeng secara verbal,
kemudian berkembang dengan menggunakan
potongan-potongan gambar. Sekarang, orang
mulai melirik mendongeng dengan
menggunakan PowerPoint, aplikasi komputer Gambar 5.19
yang biasa digunakan untuk presentasi. Tampilan dongeng gadis
penjual korek api
Cara mendongeng dengan PowerPoint
dicontohkan pendongeng asal Brunei
Darusalam, Haji Kifli Bin Haji MD. Zain (43), saat mengisi salah satu sesi
dongeng dalam Festival Bercerita ASEAN 2008 dan Seminar Cerita Rakyat
ASEAN di Bentara Budaya Jakarta, Minggu (4/8). Anggota Dewan Bahasa dan
Pustaka Brunei tersebut membawakan cerita rakyat Nakhoda Manis yang mirip
cerita Malin Kundang, seorang yang durhaka terhadap ibunya dan dikutuk
menjadi patung.

Cara penyampaian mendongeng dengan PowerPoint sebenarnya sama saja.




Namun, perbedaannya yaitu sambil membacakan narasi cerita. Kifli
menampilkan potongan-potongan gambar-gambar di PowerPoint yang
dipantulkan LCD proyektor ke tembok putih. Gambar-gambar tersebut sengaja
berupa lukisan untuk membantu visualisasi anak-anak.

"Di Brunei, kami sering menggunakan PowerPoint untuk mendongeng,"
katanya kepada Kompas.com. PowerPoint memudahkan pendongeng
menyiapkan materi karena tidak perlu membawa lembaran-lembaran gambar.
Selain itu, pendongeng dapat berkeliling dan anak-anak tetap dapat
membayangkan dengan melihat gambar di depannya.

Ayu Desi Putri Asiva (12), salah seorang yang mengikuti dongeng Nakhoda
Manis mengaku senang mengikuti sesi dongeng tersebut. "Gambarnya lebih
bagus dan menarik," kata pelajar kelas VI SD Kartika, Jakarta.

Hal yang sama diungkapkan oleh Davina Siranidita Budiarto (9). Asyik,
ceritanya jadi lebih bisa dipahami, kata pelajar kelas IV SDK Sang Timur,
Jakarta. (C9-08)

<sumber: http://tekno.kompas.com, 3 Agustus 2008>

Bekerja dengan Slide

Dalam bekerja dengan menggunaan slide, ada beberapa
alternatif tampilan yang sudah disediakan oleh pembuat
program, yang disebut dengan TEMPLATE. Template
diistilahkan sebagai tampilan slide dalam bentuk format yang
sudah ada dan digunakan untuk memberikan latar
belakang/background.

Cara penggunaan femplate:
- Pada jendela Task Pane, pilih Form Desain Template

Gambar 5.20
Tampilan pilihan desain template
PowerPoint 2003
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Setelah itu akan muncul pilihan-pilihan template yang ingin
dipakai.

Jika template sudah kalian pilih, akan muncul kotak Drop
Down yang berisi pilihan-pilihan sebagai berikut:

1.

Tugas 1

Apply to all slides

Pilihan ini digunakan untuk memasang desain template ke
seluruh slide yang kalian buat.

Apply to Selected Slides

Pilihan ini digunakan untuk memasang desain template
hanya pada slide tertentu saja.

. Show Large Previews

Pilihan ini digunakan untuk menampilkan pilihan template
dalam ukuran yang lebih besar.

MEMBUAT TEMPLATE SENDIRI
Pernahkah kamu melihat penggunaan template yang didesain khusus oleh

pembicara?

Ternyata tidaklah sulit untuk membuat template tersebut, caranya adalah sebagai

berikut:

1. Buka file baru PowerPoint
2. Kemudian masuk ke bagian Master dengan cara klik menu

View -> Master-> Slide Master.

r

Gambar 5.21
Tampilan file baru \
PowerPoint 2003

~N

I TIK SMA Kelas XII




Gambar 5.22
Tampilan Edit Master
PowerPoint 2003

3. Masukkan gambar sesuai keinginan kamu dengan cara klik
menu Insert -> Picture ->From File atau ClipArt.

Gambar 5.23
Tampilan proses pemasukan file gambar

4. Simpan template yang telah kamu buat dengan ekstensi
*
.pot
5. Untuk melihat hasil karya kamu, klik Desain Template,
kemudian browse, pilih file yang kamu buat.
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Gambar 5.24
Tampilan proses penyimpanan file

Gambar 5.25
Tampilan proses untuk melihat karya yang telah dibuat

1. Memasukkan Gambar/Clip Art
ke dalam Tampilan Slide

Untuk memasukkan gambar ke dalam Slide dilakukan

dengan cara:

a. Insert-> Picture -> Clip Art

b. Pilih Organizer Clip pada Task Pane bagian bawah
sehingga akan tampil kotak dialog Microsoft Clip
Organizer.

c. Untuk memasukkan gambar, gunakan perintah Copy dan
untuk menempelkan objek tersebut, gunakan perintah
Paste.

Atau kamu juga bisa menggunakan menu yang tersedia
dalam menu Task Pane, seperti yang ditunjukkan dalam
gambar berikutnya ini.
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Gambar 5.26 Gambar 5.27
Tampilan proses Tampilan proses memasukkan gambar
memasukkan gambar menggunakan Task Pane

2.Menyisipkan Slide Baru

Untuk menyisipkan sl/ide baru, gunakan langkah-langkah

sebagai berikut:

a. Klik ikon New Slide pada taskbar atau gunakan menu:
Insert-> New Slide, atau gunakan shortcut Ctrl + M.

b. Setelah salah satu tipe s/ide dipilih, gunakan double click
untuk memasukkan s/ide ke dalam tampilan presentasi

yang dibuat.
Gambar 5.28 Gambar 5.29
Tampilan cara Tampilan cara memasukkan slide baru
penyisipan slide baru dengan dengan menggunakan fungsi yang ada
menggunakan menu pada menu Task Pane

3.Menggandakan Slide

Untuk menggandakan sl/ide, gunakan perintah menu: /nsert
-> Duplicate Slide, atau dengan menggunakan perintah
pada keyboard yaitu: Ctrl+Shift+D
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4 Memasukkan Teks dalam Tampilan
Slide View

Untuk memasukkan judul teks dalam tampilan slide dapat
dilakukan dengan cara:

a. Klik kotak teks pada bagian Click to Add Title dan ketik
teks yang kamu inginkan.

b. Pada bagian Click to Add Subtitle, ketikkan teks lain

5.Mengatur Format Slide

a. Halaman (Page Setup)
Sebelum memulai merancang sebuah halaman sl/ide,
sebaiknya dilakukan pengaturan terhadap halaman s/ide
tersebut untuk mendapatkan tampilan s/ide yang sesuai
dengan kebutuhan desainernya.
Langkah-langkah pengaturan halaman s/ide, yaitu:

L.

Gambar 5.30

Pilih Menu File, kemudian klik sub menu Page Setup
sehingga tampil halaman page setup, seperti terlihat
pada gambar di bawah ini.

Pada opsi Slides sized for, tentukan ukuran slide yang
akan digunakan, terdapat beberapa pilihan tipe
halaman slide show, seperti diperlihatkan pada
gambar di bawah ini:

Gambar 5.31

Tampilan menu Page Setup Tampilan untuk mengatur
ukuran slide
3. Pilihan Number slide from digunakan untuk
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4,

penomoran halaman s/ide

Opsi Orientation digunakan untuk mengatur
tampilan s/ide secara umum. Opsi Slide digunakan
untuk mengatur arah tampilan sl/ide dan opsi Notes,
handout & ouline digunakan untuk mengatur
tampilan ketiga komponen tersebut.

b. Rancangan Slide (Slide Design)
Rancangan slide dapat dikonfigurasi dari awal, hal ini
dimungkinkan karena tersedianya fasilitas template
untuk kebutuhan ini. Untuk mengaktifkan slide design
dapat dilakukan langkah sebagai berikut.




1.

Klik menu Format -> Slide Design, atau dengan
mengklik ikon yang terdapat pada halaman
toolbar sehingga jendela slide design akan tampil
pada sisi kanan halaman kerja, seperti terlihat pada
gambar di samping ini:
Pada menu Slide Design terdapat tiga pilihan
komponen, masing-masing yaitu Design Templates
untuk mengaktif template yang ada dalam
PowerPoint 2003, Color Schemes, digunakan untuk
mengatur skema warna yang akan digunakan pada
slide dan Animation Scheme, untuk mengatur
tampilan animasi pada saat s/ide dijalankan. Masing-
masing dapat dijelaskan sebagai berikut.
a) Design Template
1) Pada opsi Design Template, ditampilkan pilihan
desain template yang tersedia. Seorang desiner
dapat menggunakan salah satu design template
yang tersedia ini sebagai tampilan halaman
slidenya dengan menggerakkan scroll bar
secara vertikal ke atas atau ke bawah.
2)Jika ingin menambahkan fasilitas design
template, dapat dilakukan dengan mengklik
opsi yang terdapat di bawah design template,
seperti tampak pada tampilan di samping.
3)Kemudian, pilih salah satu folder template
yang bernama 1033 atau Presentation Design,
kemudian pilih salah satu desain yang disukai.

b) Color Schemes

1)Opsi Color Schemes, digunakan untuk
mengatur konfigurasi warna yang akan
digunakan pada halaman slide, di antaranya
konfigurasi warna untuk latar belakang
(background), teks, shadow, title text, dan link.

2)Konfigurasi warna ini dapat diedit sesuai
dengan kebutuhan dan estetika pewarnaan yang
akan diimplementasikan, dengan mengklik
tombol yang terdapat di
bagian bawah dari template color schemes.

3)Pada menu edit color schemes terdapat dua tab
pilihan, yaitu standar dan custom.

4)Pada tab Standard, pilih salah satu warna
standar yang akan digunakan, cari efek yang
kamu inginkan, kemudian klik tombol OK jika
sudah selesai.

5)Pada tab Custom, pengaturan color schemes
dapat diatur sesuai dengan kebutuhan dan
keinginan desainer s/ide.
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Gambar 5.32
Tampilan menu Slide Design

Gambar 5.33
Tampilan menu Template

Gambar 5.34
Tampilan Open Template

Gambar 5.35
Tampilan Open Template

Gambar 5.36
Tampilan Opsi Color Scheme




Gambar 5.37
Tampilan Edit lor Scheme

Gambar 5.40
Tampilan background color

Gambar 5.41
Tampilan Animation Sceme

I TIK SMA Kelas XII

Gambar 5.38 Gambar 5.39

Tampilan Edit Color Scheme Tampilan konfigurasi warna custom

6) Dengan pilihan konfigurasi warna custom,

pengaturan warna dapat dilakukan terhadap
komponen background, teks and lines, shadow,
title text, fill, dan sebagainya seperti terlihat
pada gambar di samping.

7) Proses pengubahan warna dari masing-masing

komponen warna kustom dapat dilakukan
dengan mengklik komponen warna yang akan di
ubah warnanya, kemudian klik tombol

sehingga tampilan pilihan warna seperti pada
gambar di samping:

8) Pilih salah satu warna yang disukai, kemudian

klik tombol OK.

9) Lakukan hal serupa untuk setiap komponen

kustom warna yang ingin diubah warna
standarnya.

c) Animation Schemes
1) Pada opsi animation schemes, terdapat pilihan

skema animasi yang dapat diterapkan pada
sebuah tampilan s/ide.

2) Untuk melihat efek yang ditimbulkan dari

masing-masing skema animasi maka dapat
dilakukan dengan mengklik tombol guna
melihat hasil preview dari animasi yang dipilih.
Sedangkan untuk melihatnya secara fullscreen
dalam format slide show, dilakukan dengan

menekan tombol dan jika skema
animasi yang dibuat akan diterapkan pada
semua slide, maka klik tombol dan

jika skema animasi yang dibuat akan
diterapkan pada semua s/ide, maka klik tombol



Sekilas Info

"Memilih Warna yang Tepat bagi Presentasi Saya"

Jaga Pilihan Warna Anda supaya tetap Sederhana

Anda sedang mengerjakan suatu presentasi slide yang penting. Anda telah
mengikuti semua langkah yang terdapat pada femplate PowerPoint Anda. Anda
telah mengorganisasi sistem informasi anda, membuat headline, dan
memposisikan tabel dan grafik. Semua elemen tampaknya sudah beres, namun
slidenya kurang semarak.

Anda bertanya-tanya, apa yang dipikirkan audiens nantinya ?
Anda mencari tahu apa yang anda perlukan, misalnya warna dengan banyak bold,
warna menyala - warna untuk membuat informasi anda menonjol dan
diperhatikan, warna untuk meneriakkan pesan anda, warna untuk membuat
audiens anda terjaga. Anda menambahkan warna merah, hijau, biru, dan oranye.
Setelah selesai, presentasi slide Anda tampak seperti sirkus. Alih-alih
menghidupkan slide dan menegaskan pesan anda, Anda malah merusaknya
dengan cipratan lumpur warna-warni .

Apanya yang salah?

Kebanyakan orang (atau paling tidak kita yang tidak memiliki latar belakang
grafik desain) tidak tahu bahwa perpaduan yang diciptakan oleh warna-warna
tersebut lebih penting daripada warna-warna yang mereka pilih. Beberapa warna
berpadu dengan baik, namun yang lainnya saling bertolak belakang. Kunci untuk
menggunakan warna dengan efektif adalah dengan MEMBANGUN
PERPADUAN.

Warna tidak pernah berdiri sendiri. Namun, selalu dinilai dalam lingkungannya.
Warna terpengaruh oleh warna-warna di sekitarnya. Sebagai contoh, tempatkan
lingkaran kuning menyala di kamar anak-anak dan cocok tentunya. Letakkan
lingkaran yang sama di kamar kos, dan akan terlihat jelas seperti . . . ya,
lingkaran kuning menyala di kamar kos.

Bagaimana Mengetahui Warna-Warna yang Bisa Berpadu?

Bagaimana Anda memilih warna-warna yang akan menjelaskan pesan Anda
dengan nada dan gaya yang tepat? Bagaimana Anda akan menentukan warna-
warna yang dapat berpadu dengan baik?

Ketika Anda berpikir menciptakan suatu palet warna untuk presentasi Anda
selanjutnya, pertimbangkan palet warna alami: warna lautan biru kehijau-hijauan
yang segar dan kering, warna hijau tua pohon cemara, dan warna biru langit bunga
jagung. Warna-warna ini berpadu satu sama lain. Warna-warna ini menciptakan
suasana seimbang dan tentram - berpadu membangkitkan perasaan dan suasana
hati.
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Perlunya Perencanaan

Dalam memilih warna, hendaknya tidak semata-mata mengandalkan pilihan
sendiri secara subjektif. "Karena saya menyukainya" bukanlah kriteria yang baik
untuk menciptakan palet, tetapi Anda perlu merencanakannya.
Hal pertama untuk menentukannya adalah "rasa" yang Anda inginkan untuk
presentasi Anda. Warna memiliki tingkatan suhu, entah itu hangat atau sejuk.

Warna-warna yang berada di antara bentangan merah dan oranye tergolong
hangat; yang berada di antara bentangan biru dan hijau tergolong sejuk. Mulailah
dengan memilih corak yang hangat atau sejuk. Kemudian, pilihlah satu atau dua
warna saja yang dominan. Jika anda ingin meluaskan palet anda, gunakan bentang
warna yang lebih luas. Lakukan hal ini dengan menggunakan warna muda dan tua.

Warna muda adalah campuran warna dengan putih. Pink adalah warna mudanya
merah.

Warna tua adalah campuran warna dengan hitam. Coklat adalah warna tuanya
oranye.

Dengan bereksperimen dengan warna muda dan tua, Anda dapat menciptakan
palet-palet dari yang bersuasana spontan dan riang sampai serius dan suram.

Hal Terakhir untuk Dipikirkan

Kaidah terbaik dalam memilih warna adalah tidak usah neko-neko - beraneka
warna tidaklah selalu lebih baik. Perpaduan antarwarnalah yang akan memperkuat
atau malah menenggelamkan efek visual. Cobalah untuk memilih satu atau dua
saja corak warna yang dominan dan gunakan perluasan warna muda atau tuanya
untuk menambah variasi palet Anda. Dengan mengikuti pedoman-pedoman ini
Anda akan terbantu untuk mempertahankan presentasi slide Anda tetap jelas,
elegan, dan yang pasti to the point!

<Sumber: http://www.presentationsupport.com>

6. Menambahkan Transisi Slide

Untuk menambahkan efek khusus pada masing-masing
individual halaman slide, dapat dilakukan pengontrolan
terhadap pergantian tiap-tiap halaman sl/ide (appears dan
disappears), bagaimana agar tiap-tiap halaman slide dapat
muncul dan menghilang pada halaman show. Proses ini
dikenal dengan slide transition.

Untuk menambahkan slide transition dilakukan langkah
sebagai berikut :




a. Aktifkan Slide Sorter Viewer.

Gambar 5.42
Tampilan Slide Sorter Viewer

b. Klik pada slide pertama yang akan ditambahkan s/ide
transisinya.

c. Aktifkan menu Slide Transition dengan mengklik menu
Slide Show -> Slide Transition, atau dengan mengklik
kanan pada slide yang aktif, pilih Slide Transition pada
pop-up menu.

Gambar 5.43
Tampilan proses transisi

d. Tentukan jenis transisi yang akan digunakan pada
masing-masing slide.

e. Untuk melihat hasil penerapan transisi file maka dapat
diaktifkan dengan mengklik salah satu tombol yang ada

padabagian Advance slide. Tombol untuk
menjalan kan preview transisi slide, untuk
mengaktifkan jendela s/ide show, untuk

menerapkan transisi s/ide untuk semua halaman s/ide.

Tugas 2

Bukalah file presentasi yang telah kamu buat sebelumnya, kemudian tambahkan
efek transisi pada s/ide dengan menggunakan langkah-langkah di atas.
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Gambar 5.44
Tampilan Slide Layout
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f. Tata Letak (Slide Lay Out)

Pengaturan tata letak slide perlu dilakukan, terutama jika
dalam suatu halaman s/ide terdapat beberapa objek yang
berbeda, seperti teks, gambar/image, chart, grafik, clip
art, video klip, dan sebagainya, sehingga untuk
mempermudah proses pembuatan s/ide, dapat dilakukan
dengan menggunakan femplate layout yang telah
tersedia pada PowerPoint dan dapat dipilih sesuai
dengan kebutuhan.Untuk mengaktifkan slide layout ini,
dapat dilakukan dengan mengklik menu Format -> Slide
Layout sehingga, pada sisi kanan area kerja s/ide akan
ditampilkan menu pilihan untuk s/ide layout ini, seperti
diperlihatkan pada gambar di samping.

Slide layout dikelompokkan ke dalam 4 kelompok,

yaitu:

1) Teks layouts, digunakan jika pada halaman slide yang
akan dirancang hanya terdiri atas data teks saja.

2) Content Layouts, digunakan jika pada halaman slide
yang akan dirancang mengadung data content selain
teks, seperti Tuble, Chart, Clip-Art, Pictures, diagram
atau Organization, dan Media Clip.

3) Text and Content Layouts, digunakan jika pada satu
halaman slide terdapat gabungan antara teks dengan
content lainnya.

4) Other layouts, digunakan jika isi dari halaman s/ide
yang dirancang mengandung bentuk isi lainnya.

. Latar belakang (Background)

Seringkali latar belakang standar yang ditetapkan oleh
template slide design tidak sesuai dengan keinginan atau
kebutuhan seorang desiner slide sehingga diperlukan
pengaturan latar belakangini. Untuk melakukan
pengaturan latar belakang halaman slide, dapat
dilakukan langkah-langkah sebagai berikut :

1) Klik menu Format -> Background, sehingga keluar
tampilan menu pengaturan background seperti telihat
pada Gambar 5.45.

2) Pada menu Background terdapat beberapa tombol
yang masing-masing dapat difungsikan: Untuk
menerapkan pengaturan background hanya pada satu
halaman slide yang sedang aktif, maka tekan Apply,
jika akan menerapkan hasil pengaturan background
slide pada semua halaman slide, maka tekan tombol
Apply to All, sedangkan untuk membatalkan hasil
pengaturan, tekan tombol Cancel.

3) Klik tab pilihan




untuk mengatur warna atau fill effect, sorot pilihan More
Colors untuk menentukan pilihan warna latar belakang
lainnya, menu pilihan warna sama seperti terlihat pada
gambar di atas dan sorot pilihan Fil/ Effects, jika akan
mengisi latar belakang s/ide dengan suatu efek. Langkah
ini diperlihatkan pada gambar di samping.

4) Pilihan Fill Effects terdiri atas 4 (empat) tab pilihan isian,
yaitu Gradient, Texture, Pattern, dan Pictures.

Gambar 5.45
Tampilan Background Fill

Gambar 5.46
Tampilan Background Fill dengan
pilihan warna

5) Pilihan fill effect gradient, digunakan jika pada latar
belakang halaman s/ide ditambahkan efek gradient.

Pilihan gradient yang dapat digunakan diperlihatkan
pada gambar di bawah.

Gambar 5.47

Gambar 5.48
Tampilan Fill Effect Gradient

Tampilan Fill Effect Texture
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6) Pilihan fill effect texture, digunakan jika pada latar
belakang halaman slide ditambahkan efek tekstur.
Pilihan tekstur yang dapat digunakan diperlihatkan
pada gambar di atas.
7) Pilihan fill effect pattern (pola), digunakan jika pada
latar belakang halaman s/ide ditambahkan efek format
pola. Pilihan pola yang dapat digunakan diperlihatkan
pada gambar di bawah ini.
8) Pilihan fill effect pictures, digunakan jika pada latar
belakang halaman slide ditambahkan efek berupa Gambar 5.49
gambar. Pilihan gambar yang dapat digunakan Tampilan Fill Effect Pattern
diperlihatkan pada gambar di samping.
9) Pada tab Pictures, selanjutnya tentukan gambar yang
akan dijadikan sebagai latar belakang dengan mengklik

tombol sehingga tampil pilihan
lokasi folder penyimpanan gambar yang terlihat pada
gambar di bawah.

10) Tentukan salah satu gambar yang akan dijadikan latar
belakang, kemudian klik tombol
setelah itu klik tombol OK.

Gambar 5.50 Gambar 5.51
Tampilan Fill Effect Picture Tampilan untuk Insert Picture

7. Mengatur Tampilan Slide Show
(Set Up Show)

Mengatur tampilan Slide Show merupakan langkah yang
tidak kalah pentingnya, karena pengaturan inilah yang akan
menentukan semua konfigurasi yang telah dilakukan di
atas akan dipakai atau tidak.

Untuk mengaktitkan Set Up Show dapat dilakukan dengan
mengklik menu Slide Show -> Set Up Show, sehingga
tampil menu pengaturan show, seperti terlihat pada gambar
dibawah ini.

Gambar 5.52
Tampilan Slide Up Show
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Padamenu Set Up show, terdapat 6 (enam) buah frame, yaitu :

a. Frame Show Type, digunakan untuk mengatur jenis show
yang akan dipergunakan pada saat presentasi dijalankan.
Terdapat tiga jenis pilihan :

1) Presented by a speaker (full screen), jika presentasi yang
disajikan disampaikan oleh seorang penyaji/ pembicara.

2) Browsed by an Individual (window), jika presentasi yang
akan disajikan dibrowsing oleh user pada PC.

3) Browsed at a kiosk (full screen), jika presentasi yang
disajikan akan dibrowsing oleh wuser dalam tampilan
layar penuh.

b. Frame Show Slide, digunakan untuk mengatur s/ide mana
saja yang dipergunakan dalam proses show. Terdapat tiga
pilihan yaitu:

1) All,jikayangakan dipresentasikan seluruh isislide

2) From to , jika yang akan dipresentasikan, adalah halaman
tertentu yang berada pada batas from dan to.

3) Custom Show,jika yang ditampilkan adalah s/ide dengan
nomor urut tertentu, misalnya slide 3, 5, 6, 8 dan
sebagainya.

c. Frame Show Option, digunakan untuk mengatur
konfigurasi show, dalam hal ini terdapat tiga opsi :

1) Loop continuously until ’Esc’, proses pengulangan slide
dilakukan secara terus menerus hingga tombol Esc
ditekan.

2) Show without narration, jika file presentasi disajikan
tanpa penjelasan narasi dalam file.

3) Show without animation, jika file presentasi disajikan
tanpa animasi.

d. Frame Advance Slides, digunakan untuk melakukan
pengaturan show tingkat lanjut, dalam hal ini terdapat dua
pilihan yaitu:

1) Manually, show dilakukan secara manual.

2) Using timing, if present, show dilakukan dengan
mengatur konfigurai pewaktuan, jika fasilitas ini
tersedia.

e. Frame Multiple Monitors, digunakan untuk mengatur
pilihan presentasi menggunakan multiple monitor atau
tidak.

f. Frame Performance, digunakan untuk mengatur kinerja
PowerPoint agar optimal saat slide show dijalankan.

Tips and Trick

Paket PowerPoint ke dalam CD

Pada PowerPoint 2003, kalian dapat menyimpan file presentasi yang telah
kamu buat tidak hanya dilakukan ke hard drive, tetapi juga dapat dilakukan

secara langsung ke dalam bentuk auto run CD.
o BAB 5 Menggunakan Power Point I




Untuk menggunakan fitur ini, lakukan langkah-langkah berikut.

a. Klik menu File -> Package for CD, sehingga tampil wizard untuk
pemaketan file presentasi ke CD.

b. Jika slide presentasi terdiri atas multiple presentasi yang saling
terhubung (hyperlink), maka file-file link-nya ditambahkan ke dalam
paket CD dengan mengklik tombol Add Files.

c. Untuk melakukan pengaturan paket file ke dalam CD, gunakan tombol
Options.

d. Jika pada saat akan dicopy ke CD ternyata, CD writer drive atau CD
blank tidak tersedia, maka proses pemaketan dapat dipindahkan
sementara ke Folder dengan struktur file sama seperti CD. Hal ini dapat
dilakukan dengan mengklik tombol Copy To Folder.

Untuk mencetak s/ide presentasi, kalian dapat melakukannya
dalam dua bentuk. Bentuk pertama, kalian mencetak sama
dengan slide, bentuk kedua, kalian mencetak dalam bentuk
Black-White dari slide.

Langkah percetakannya adalah dengan meng-klik menu File
lalu Pilih Print, maka akan muncul kotak dialog berikut.

Gambar 5.53
Tampilan Menu Print

Bantuan (Help)

Bila kalian mengalami kesulitan dalam menjalankan
PowerPoint, terdapat menu help yang akan membantu kalian
memberikan petunjuk. Untuk mencari bantuan pada Microsoft
Office, khususnya Microsoft PowerPoint adabeberapa cara :
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» TekanF1.

» Ketikkan kata kunci yang akan dicari.

» Klik panah kanan.

» Dialog box tersebut kemudian akan menampilkan beberapa
pilihan mengenai topik yang diminta.

» Untuk melihat bantuan dari salah satu pilihan yang
ditampilkan, pengguna perlu men-dobel klik pilihan
tersebut. Kemudian, akan tampil window yang berisi
informasi mengenai hal tersebut. Jika telah selesai membaca
informasi yang tampil tersebut, tutuplah window informasi
tersebut dengan mengklik tombol Close pada window.

Bekerja dengan Teks
1. Menambahkan Objek Teks

Untuk menambahkan objek teks dalam presentasi yang dibuat,

dapat dilakukan dengan cara:

a. Klik Tombol 7ext Box padatoolbar Drawing

b. Klik pada lokasi dimana kalian ingin menempatkan objek
teks tersebut, sehingga akan tampil kotak penyisipan yang
menunjukkan bahwa penyisipan objek teks sudah siap
lakukan.

c. Ketikan teks pada kotak tersebut

2. Memformat Teks

Untuk memformat teks pada PowerPoint, gunakan tool bar

Formating.
Selain ikon yang ada pada tool bar formating, pengubahan teks
juga dapat melalui menu Format -> Font.

Gambar 5.54 Tampilan Tool bar Formating

Selain itu, pemormatan font juga dapat dilakukan dengan
mengggunakan Shortcut seperti:

Gambar 5.55
Tampilan Tabel
Shortcut Format Font
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Tugas 3

3. Menggunakan Format Painter

Format painter digunakan untuk menyalin s#yle (sekumpulan
format) dari teks atau objek yang kalian pilih kemudian
digunakan untuk memformat teks atau objek yang lain.

Langkah-langkah yang dilakukan untuk menggunakan format
Painter adalah:

a. Pilih salah satu objek atau teks yang telah diformat
sebelumnya.
b. Klik tombol Format Painter daritoolbar standar.

Praktikkan penggunaan Format Painter dalam presentasi yang kalian buat.

Tugas 4

Praktikkan
penggunaan spasi
pada PowerPoint
yang kalian buat.
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4. Mengatur Letak Slide

Untuk mengatur letak slide gunakan langkah-langkah berikut:

a. Buka presentasi dalam tampilan Normal View, klik Tab
Outline.

b. Arahkan pointer mouse ke salah satu Icon Slide yang akan
dipindah sehingga pointer mouse akan berubah bentuk
menjadi anak panah berkepala empat, kemudian klik
sehingga akan terblok satu bagian s/ide.

c. Clik and drag (klik dan tahan) icon slide yang telah terblok
ke atas atau ke bawah sampai kalian mendapatkan posisi
yang tepat, kemudian lepaskan mouse kalian.

5. Mengatur Spasi Baris

Untuk mengatur spasi baris gunakan langkah-langkah berikut:
a. Pilih salah satu bagian s/ide, misalnya bagian judul atau
bagian isi (paragraf) sehingga bagian tersebut akan
dikelilingi sebuah kotak yang bertitik-titik.
b. Perubahan pengaturan pada kotak bertitik ini akan
memengaruhi isi keseluruhan yang ada pada kotak ini.
c. Pilih menu Format -> Line Spacing, berikan ukuran spasi
yang kalian inginkan.
d. Jika ingin memberikan jarak pada paragraf, gunakan menu-
menu:
- Before paragraf, digunakan untuk menentukan jarak spasi
sebelum paragraf aktif.
- After paragraf, digunakan untuk menentukan jarak spasi
sesudah paragrafaktif.
e. Terakhir, klik tombol OK.




Memodifikasi Teks

1.Mengubah Bentuk Penulisan Huruf

Untuk mengubah bentuk penulisan huruf, gunakan menu
Format -> Change Case.

Pilihan-pilihan yang bisa digunakan adalah:

Gambar 5.56
Tampilan Tabel Change Case

Tugas 4

Ubabhlah tulisan di bawah ini menjadi bentuk penulisan huruf yang lainnya.
“PowerPoint 2003”.

2. Mencari dan Mengganti Teks

Untuk mencari dan mengganti teks, gunakan perintah-perintah
sebagai berikut:
a. Untuk mencari teks

- Klik Menu Edit -> Find.

- Pada kotak dialog Find What, masukkan kata yang ingin
dicari.

Pada kotak dialog tersebut, ada pilihan - pilihan sebagai
berikut:

- Match Case, digunakan jika kata yang ingin dicari adalah
mirip dengan kata yang dimasukkan ke dalam kotak
pencarian.

- Find whole words only, digunakan jika kata yang dicari
adalah sama persis dengan kata yang dimasukkan ke
dalam kotak pencarian.

b. Untuk mengganti teks

- Klik Menu Edit -> Replace.

- Pada kotak dialog Replace With, dapat dimasukkan hasil
dari kata penggantinya.

Tugas 5

Praktikkan langkah-langkah untuk mengganti dan mencari teks.
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Bekerja dengan Objek Gambar

1. Membuat Slide Kosong

Langkah-langkah yang harus dilakukan untuk memasukkan

slide kosong adalah:

a. Pilih menu File -> New, atau tekan tombol New sehingga
tampil kotak taks pane New Slide.

b. Pilih layout Clip Art and teks pada bagian Other Layouts
sehingga muncul pilihan seperti ini:

Gambar 5.57 Gambar 5.58
Langkah-langkah membuat slide kosong Tampilan slide baru

Gambar 5.59
Tampilan langkah
menyisipkan clip art
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2. Menyisipkan Clip Art

Untuk menyisipkan c/ip art pada presentasi yang kalian buat,

gunakan langkah-langkah berikut ini:

a. Double click to add clip art atau pilih menu Insert ->
Picture, kemudian pilih Clip Art atau tekan toolbar Insert
Clip Art, jika kalian menggunakan perintah klik dua kali
akan tampil kotak dialog Select Picture.

Pada kotak Dialog Select Picture, ada beberapa bagian yang

perlu kalian ketahui, yaitu:

» Search Text : digunakan untuk mencari bentuk gambar
berdasarkan nama gambar yang ada pada
kotak dialog Select Picture.

» Import : digunakan untuk mengambil atau
menambah objek gambar dari file lain.




b. Pilih objek gambar yang kalian inginkan, tekan tombol OK.

Jika kalian menyisipkan gambar dari Menu /nsert ->Picture
-> Clip Art, maka akan keluar jendela Tusk Pane.

Gambar 5.60
Tampilan jendela Task Pane

3.Mengatur Objek Clip Art

Objek-objek clip art yang kalian masukkan bisa diatur sesuai
dengan keinginan kalian. Misalnya, pengaturan ukuran,
croping, kecerahan dan kekontrasan gambar.

Gambar 5.61
Tampilan Menu ClipArt

Gambar Keterangan

Digunakan untuk menyisipkan gambar dari sebuah file gambar.

tﬁ Pilihan ini mempunyai fungsi yang sama dengan perintah menu:
Insert-> Picture -> From File

Digunakan untuk mengubah warna dari objek gambar yang terpilih

EH dan secara otomatis akan menyesuaikan dengan perintah yang
kalian pilih.
Gambar 5.62
Tabel fungsi
dari pilihan

i Digunakan untuk membuat gambar dengan warna yang lebih
kontras.

|'.le_ Digunakan untuk mengurangi kekontrasan warna.
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Digunakan untuk menambah kepekatan warna pada gambar yang
terpilih.

I,

Digunakan untuk mengurangi kepekatan warna pada gambar yang
terpilih.

Digunakan untuk memotong objek gambar.

Digunakan untuk memutar objek gambar sebesar 90 derajat ke arah
kiri.

Digunakan untuk menambah garis bingkai di sekitar garis batas
objek.

Digunakan untuk mengubah masing-masing warna pada objek
gambar yang terpilih.

Digunakan untuk menampilkan kotak dialog Format Picture.

Digunakan untuk mengubah warna-warna tertentu dari objek yang
terpilih menjadi warna transparan.

Digunakan untuk mengilangkan efek pemotongan objek,
mengembalikan warna objek ke warna semula, dan
mengembalikan intensitas pencahayaan objek ke kondisi semula
serta, mengembalikan ukuran objek ke kondisi aslinya.

i EEE NP R

4. Menyisipkan Gambar dengan Perintah

Menu
Untuk memasukkan gambar melalui perintah menu, gunakan
langkah-langkah berikut:

Klik menu Insert -> Picture -> From File.

Gambar 5.63
Tampilan memasukkan
gambar dengan menu
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Gambar 5.64 Gambar 5.65
Tampilan Insert Picure From File Tampilan setelah gambar
dimasukkan ke dalam PowerPoint

Untuk memformat picture, digunakan kotak dialog Format
Picture yang terdiri atas 6 Tabulasi, yaitu: Color and Lines,
Size, Position, Picture, Text Box, dan Web.

Cara untuk memunculkan Format Picture yaitu dengan klik
kanan pada gambar yang ada.

Keterangan penggunaan Format Picture adalah sebagai
berikut:

» Tab Color and Lines
Digunakan untuk mengatur tampilan garis bingkai.

» Tab Size
Digunakan untuk mengatur ukuran objek gambar.
Pada tab ini terdapat beberapa pengaturan-pengaturan yang
bisa ditemui, yaitu:

» Height and Width, digunakan untuk mengatur ukuran
tinggi dan lebar objek, baik dalam ukuran satuan inci
maupun dalam ukuran satuan persen.

» Lock Aspect Ratio, digunakan untuk mengunci rasio
perbandigan tinggi dan lebar objek, dan objek akan selalu
memilikinilai perbandingan tinggi dan lebar yang sama.

» Relative to Original Picture size, digunakan untuk
mempertahankan proporsional ukuran tinggi dan lebar
objek.

> Reset, digunakan untuk mengembalikan ukuran picture
ke dalam aslinya.

» Tab Position, digunakan untuk mengatur posisi objek
secara horizontal maupun vertikal

» Tab Picture, digunakan untuk mengatur pemotongan
objek gambar, warna objek, dan untuk mengatur tingkat
intensitas pencahayaan objek.
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Menyisipkan Suara dalam Presentasi

Untuk memasukkan suara dalam presentasi gunakan perintah

sebagai berikut:

1. Pilih menu: Insert -> Object kemudian pada bagian object
type pilih Wavesound, lalu klik OK sehingga akan tampil
kotak dialog Sound Object.

2. Pilih menu: Edit -> Insert File, pilih direktori serta nama
objek musik yang akan kamu masukkan (file yang
dimasukkan harus berekstensi .wav).

. Klik tombol Open.

. Untuk mendengarkan suara, klik tombol Play.

. Jika kalian sudah selesai dari objek suara ini, pilih menu File
-> Exit and Return to Presentation.

6. Untuk mengetahui apakah suara tersebut berhasil masuk ke

dalam presentasi kamu, perhatian ikon suara kecil yang
terdapat pada presentasi yang kamu buat.

AW

Tugas 5

Buatlah sebuah presentasi dengan tema: “Siklus Air”

Lihatlah contoh yang kami lampirkan pada CD lampiran dengan nama
[drive:]\lampiran\kelas12\bab5\praktikum5.ppt, kemudian buatlah presentasi dari
kumpulan gambar itu menjadi presentasi tentang siklus air.

Silakan kamu melengkapi text, musik background, suara, animasi dan lain-lain
sehingga presentasimu sempurna.

Presentasikan ke depan kelas.

Menambahkan Objek WordArt

Untuk memasukkan objek WordArt, gunakan langkah-langkah

sebagai berikut:

1. Klik Menu Insert -> Picture, kemudian pilih WordArt atau
klik tombol Insert WordArt pada tool bar Drawing.
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2. Pilih salah satu bentuk WordArt yang diinginkan dan klik
OK

3. Buat tulisan yang kamu inginkan pada kotak Edit WordArt
Teks, pilih bentuk font, ukuran, penebalan, miring, dan
garis bawah yang diinginan.

Gambar 5.66 Tampilan WordArt Galery Gambar 5.67 Tampilan Kotak Dialog isian

Untuk mengubah WordArt yang telah dibuat, dibutuhkan
Wordart Tool bar, seperti pada gambar di bawah ini:

Gambar 5.68 Gambar 5.69
Tampilan hasil akhir WordArt Tampilan WordArt Tool bar
yang dibuat
Tugas 6

Buatlah sebuah WordArt berisikan tulisan sesuai dengan tema yang kamu buat
sebelumnya, kemudian simpan perkerjaan kalian.

Untuk memformat WordArt yang telah
dibuat, gunakan ikon seperti pada gambar di
bawabh ini:

Hingga muncul kotak dialog Format WordArt
seperti pada gambar di samping.

Gambar 5.70
Tampilan Kotak Dialog Format WordArt
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Tugas 7

Buka kembali file yang telah kamu buat sebelumnya dengan WordArt, kemudian
lakukan modifikasi terhadap WordArt yang telah kamu buat sebelumnya.

Untuk mengubah bentuk WordArt, gunakan menu Shape, seperti pada gambar di
bawah ini.

Gambar 5.71 Tampila menu Shape Gambar 5.72 Tampilan menu Color
Tugas 8

Buka kembali file yang telah kamu buat sebelumnya dengan WordArt, kemudian
lakukan perubahan pada bentuk WordArt sesuai keinginan kamu.

Bekerja dengan Table

Untuk membuat presentasi kita berisi fable, ikuti langkah-

langkah berikut ini:

Pada jendela Task Pane, pilih Slide Layout, kemudian pilih

layout sesuai dengan keinginan.
Klik icon Table,
kemudian pada kotak
dialog yang muncul,
masukkan jumlah baris
dan kolom tabel yang
akan dibuat

Gambar 5.73
Tampilan jendela Task Pane Untuk melakukan

pengesetan lebih lanjut
terhadap tabel yang ada

dapat dilakukan dengan cara double click tabel tersebut atau

mengklik kanan pada bagian garis tabel tersebut dan memilih

“Borders and Fill”
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Gambar 5.74 Tampilan Insert Table

Gambar 5.75 Tumpilan Format Table
Tugas 9

Buatlah tabel dengan bentuk 5 baris 3 kolom, isilah tabel tersebut dengan data-
data sesuai dengan kemauan kalian.

Misal:

1. Data tentang perkembangan saham

2. Data tentang nilai rata-rata per pelajaran kelas XII SMU

Bekerja dengan Shape

Untuk membuat shape pada PowerPoint, gunakan langkah-
langkah berikut ini.

1. Pada Toolbar Drawing, klik tombol AutoShape.

2. Untuk menempatkan objek, arahkan poinfer mouse pada
lembar kerja, klik dan tahan mouse untuk membentuk objek
gambar, geser pointer mouse untuk menentukan ukuran
objek gambar.

3. Letakkan mouse ke salah satu titik kendali, klik dan tahan,
geser untuk mengatur ukuran objek yang telah ditentukan.

4. Untuk membatalkan, klik di luar area objek.

Tugas 10

Buatlah sebuah objek yang menarik untuk dimasukkan ke dalam tema presentasi
yang kamu buat sebelumnya. Setelah jadi, presentasikan di depan kelas.

1. Menambah Objek Panah

Untuk memasukkan objek panah pada Microsoft PowerPoint,
gunakan langkah-langkah berikut:

1. Pilih objek panah yang ingin dibuat.
2. Pilih Autoshape dari menu Format (Ctrl+1).
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Pada kotak dialog Format Autoshape ada 4 tampilan tabulasi
yang bisa digunakan untuk memformat panah, yaitu:

Tab Color and Lines
Pengaturan yang ada pada tab Color and Lines adalah:
Fill Color ->Untuk memberi warna dalam objek
Semitransparent->Untuk membuat warna transparan
Lines Color ->Untuk memberi warna pada garis
Dhased -> Untuk memilih bentuk garis
Style ->Untuk memilih garis
Weight -> Untuk mengatur ketebalan garis
Tab Size
Pengaturan yang ada pada 7ab Size adalah:
Size and Rotate
Height -> Untuk mengatur tinggi garis
Weight -> Untuk mengatur lebar garis
Rotation ->Untuk mengatur rotasi/arah garis
Scale
Height -> Untuk mengatur tinggi skala garis
Weight -> Untuk mengatur lebar skala garis
Lock Aspect Ratio
Untuk mengunci objek supaya tidak dapat diubah
arahnya
Tab Position
Pengaturan yang ada pada tab Position adalah:
Horizontal -> Untuk mengatur perataan objek panah
secara horizontal
Vertikal -> Untuk mengatur perataan objek panah
secara vertikal
From -> Untuk mengatur ukuran jarak objek secara
vertikal maupun secara horizontal
Tab Web

Tugas 11

Buatlah beberapa panah, kemudian lakukan formating dengan menggunakan
langkah-langkah di atas. Buat agar panah-panah tersebut mempunyai arti pada
file PowerPoint yang kamu kerjakan. Misal: Panah penunjuk arah jalan.
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Beberapa perintah keyboard yang dapat digunakan dalam
pekerjaan dengan tabel adalah:

Perintah Posisi Yang Dituju
Tab Ke sel berikutnya
Shift+Tab Ke sel sebelumnya
Panah kanan Maju satu karakter
Panah kiri Mundur satu karakter
Panah bawah Ke baris berikutnya
Panah atas Ke baris sebelumnya

Pada table yang kalian buat, terdapat pengaturan yang bisa
dilakukan melalui 7oolbar table and Borders.

Gambar 5.76
Tampilan Toolbar
Table and Border

Kegunaan dari masing-masing ikon yang ada adalah sebagai

berikut.

Perintah Kegunaan

Draw Un‘guk menggambar garis tabel,
baris atau kolom

Eraser Untuk mengapus garis kolom
atau baris
Untuk menampilkan perintah-

Table perintah yang dapat digunakan
untuk memodifikasi tabel

Border Untuk menampilkan daftar bentuk-

Style bentuk garis

Border Untuk menampilkan pilihan

Width ukuran ketebalan garis

Border Untuk menampilkan pilihan warna

Color garis

Outside Untuk menampilkan pilihan bentuk

Border bingkai pada sel atau tabel.

o BAB 5 Menggunakan Power Point I




Perintah Kegunaan

Untuk memberi warna latar belakang

Fill Color pada sel atau tabel

Wiy Cells Untuk mqgggabung beberapa sel
yang terpilih

Split Cell Untuk membagi sel terpilih menjadi
beberapa sel

A T Untuk meratakan teks pada posisi

atas sel

oy Weritaedlly Untuk meratakan teks pada posisi

tengah vertikal
A Beviio Untuk meratakan teks pada posisi
bawabh sel
Distribute Rows Untuk menyamakan tinggi dari
Evenly beberapa baris yang terpilih

Distribute Columns| Untuk menyamakan tinggi dari
Evenly beberapa kolom yang terpilih

Tugas 12

1. Editlah tabel yang kamu telah buat sebelumnya dengan menggunakan tool bar
Table and Borders.

2. Buatlah border dengan warna-warna sesuai keinginan kamu.

. Editlah border yang telah kamu buat dengan ukuran bingkai sesuai dengan
keinginan kamu.

4. Buatlah tulisan di dalam tabel.

. Editlah tulisan di dalam tabel yang telah kamu buat dengan menggunakan
perintah posisi perataan teks seperti yang telah dijelaskan.

6. Ubahlah rotasi tulisan dalam tabel dengan menggunakan perintah Rotate Text.

W
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Membuat Link dengan Lembar Kerja Excel

Link adalah sebuah fasilitas yang digunakan untuk membuat

hubungan antarprogram. Link objek/data dari program aplikasi

lain ke program PowerPoint akan diterima sebagai objek yang

tertempel dan sifatnya hanya tampilan saja. Untuk melakukan

link ini, ikuti penjelasan berikut ini:

1. Bukalembar kerja Excel.

2. Sorotlembar kerja Excel (Misalnya Al sampai C5 ).

3. Kemudian, klik tombol Copy.

4. Buka PowerPoint, kemudian klik di sembarang tempat pada
area kerja PowerPoint.

5. Klik menu Edit pilih Paste Special.




Gambar 5.77
Tampilan menu Paste Spesial

6. Pada kotak dialog Paste Spesial, klik pilhan Paste Link,
kemudian tekan tombol OK.

7. Aktifkan lembar kerja Excel, kemudian ketik teks pada
Range atau sel yang telah dibuat, kemudian perhatikan pada
slide PowerPoint, secara otomatis /ink hasil copy-an juga
akan berisi teks.

Tugas 13
Praktikkan langkah-langkah membuat link dengan Microsoft Excel di atas.

Bekerja dengan Grafik (Chart)

Untuk membuat presentasi yang menggunakan Chart (Grafik),
ikuti langkah-langkah berikut ini:

» Klik Insert pada Menu Bar, lalu pilih chart,
atau klik ikon untuk memasukkan grafik kalian.

» Secara otomatis akan tampak tampilan seperti gambar
5.78.

> Perubahan terhadap nama, jumlah, maupun data-data lain
hanya dengan mengganti isi dari tabel pada Datasheet
tersebut dan secara otomatis grafiknya akan ikut berubah
mengikuti data pada tabel Datasheet.

> Bila sudah selesai, klik di luar area Datasheet maka akan
diperoleh grafik yang diinginkan (untuk mengeditnya
kembali dapat dilakukan dengan cara double klik grafik
tersebut).

» Untuk melakukan pengaturan lainnya dapat dilakukan
dengan meng-klik kanan bagian-bagian diagram sehingga
tampilannya dapat disesuaikan sesuai keinginan.
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Gambar 5.78 Tampilan diagram Gambar 5.79 Tampilan buka menu 3-D View

Untuk mempercantik tampilan grafik kalian, perhatikan
beberapa menu pengaturan berikut ini.

3D View (untuk mengatur posisi chart secara keseluruhan),
seperti diperlihatkan gambar di bawah.

Chart Type (untuk mengatur jenis grafik yang diinginkan),
seperti diperlihatkan gambar di bawabh ini.

Gambar 5.80 Tampilan menu 3-D View Gambar 5.81 Tampilan menu Chart Type

Chart Option (untuk pemberian nama sumbu, legenda, label),
seperti diperlihatkan gambar di bawah ini.

Gambar 5.82
Tampilan Menu Chart Option
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Menambahkan File Video

Untuk membuat presentasi atau slideshow, diperlukan file

dengan format FLV atau flash.

Untuk menampilkan video clip atau animasi dalam presentasi

PowerPoint kamu, gunakan langkah sebagai berikut.

» Cek versi dari Adobe Flash Player dan menginstall-nya ke
computer.

» Simpan file .FLV sebagai .SWF. Jika kamu tidak memiliki
Adobe Flash, kamu membutuhkan software converter
untuk mengubah file FLV ke SWF.

» Buka PowerPoint dan simpan dalam dokumen baru.

» Buatlah s/ide baru untuk video. Pilih “View” dari menubar
di bagian atas, kemudian “Zoolbar” dari menu drop down
dan “Visual Basic”, kemudian box dialog pop-up kecil akan
muncul. Klik ikon “Control Toolbox” yang berbentuk
seperti palu dan kunci inggris, kemudian box dialog pop-up
kecil akan muncul.

» Klik icon “More Control” yang berbentuk seperti palu dan
kunci inggris dengan tiga titik di depannya.

» Pada drop down list dengan urutan abjad dari format. Scroll
ke bawah list tersebut hingga kamu melihat “Shockwave
Flash Object”.

» Buatlah gambar box persegi di slide dengan kursor mouse
yang berubah menjadi garis kecil. Klik kanan box tersebut
dan pilih “Properties”. Ubahlah properties dalam tab
Alphabetical sebagai “Embed Movie:” menjadi “True” dan
“Loop:” menjadi “False”. Hal ini akan menjalankan film
dalam slideshow.

> Kemudian ketik pada “Movie:” berupa path dari file SWF
dalam folder atau lokasi dimana kamu menyimpan file
tersebut.

» Kamu dapat mengecek file SWF yang kamu masukkan,
kemudian kamu dapat memutar slide show preview di
PowerPoint.

Tugas 14

1. Buatlah sebuah file presentasi dengan mengggunakan Table dan Grafik

2. Buatlah sebuah file presentasi yang berisi undangan Ulang Tahunmu. Gunakan
tambahan file Video klip (atau kamu rekam sendiri pakai kamera handphone),
Audio (Suara musik, atau suara rekamanmu sendiri berupa undangan untuk
hadir ) agar lebih menarik.

3. Buatlah presentasi yang bisa menarik perhatian seseorang (seperti contoh pada
halaman berikutnya).
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Gambar 5.83
Contoh presentasi yang
menggugah imajinasi seseorang

Membuat Diagram di PowerPoint

Untuk membuat diagram ke dalam file presentasi, lakukan
langkah-langkah berikut ini.

1. Pilih jenis slide yang bernama “Title and Diagram or
Organization Chart Slide Layout”, seperti tampak pada
gambar di bawabh ini:

2. Setelah pilihan tadi kamu pilih, akan muncul kotak dialog
Diagram Gallery, seperti pada gambar di bawah ini.

Gambar 5.84
Pemilihan jenis slide

Gambar 5.85
Tampilan kotak dialog
Diagram Galery

Pada pilihan diagram galeri terdapat banyak model yang bisa
dipilih melalui ikon yang tersedia, pilihan tersebut adalah:
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Gambar Fungsi

Organization Chart
Diagram yang menunjukkan struktur hubungan hirarki

Cycle Diagram . : :
4 = Diagram yang menunjukkan proses yang berlanjut
dengan alur lingkaran
Radial Diagram
e Diagram yang menunjukkan hubungan antara bagian
dengan inti bagian
Piramid Diagram

Diagram yang menunjukkan hubungan dalam bentuk
piramid

Di . : .
Venn Diagram Diagram yang menunjukkan hubungan dalam formasi

elemen lengkap

Target Diagram . .
Diagram yang menunjukkan langkah-langkah untuk

mencapai suatu tujuan

3. Setelah itu, pilih Model Diagram yang kamu inginkan,
misalnya Organization Chart, seperti pada gambar berikut.

Gambar 5.86
Tampilan model diagram

Kamu dapat melakukan beberapa modifikasi terhadap diagram
yang telah kamu buat. Proses tersebut dapat dilakukan melalui
fasilitas toolbar Organization Chart.

Gambar 5.87 Tumpilan Tool bar Organization Cart
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Tombol

Subordinate

Coworker

Assistant

Tombol

Level

Branch

All Assistans

All Connecting
Lines

Gambar 5.88
Tampilan Toolbar Diagram

Keterangan toolbar sebagai berikut:

» Tombol insert Shape, digunakan untuk menambah kotak
bagan. Di sini juga, kamu dapat menentukan style diagram
dengan menekan tombol anak panah bawah.

Beberapa pilihan pada Insert Shape, yaitu:

Fungsi

Menambah kotak bagan di bawah dari kotak bagan yang telah
dipilih sebelumnya.

Menambah kotak bagan di sebelah kiri dari kotak bagan
yang telah dipilih sebelumnya.

Menambah kotak bagan di bawah dari kotak bagan yang telah
dipilih sebelumnya dengan bentuk garis yang berbeda.

» Tombol Layout, digunakan untuk mengubah susunan kotak
bagan di bagian bawah kotak bagan yang terpilih.

» Tombol Select, digunakan untuk memilih kotak bagan
berdasarkan pilihan dalam daftar.

Beberapa pilihan yang terdapat pada tombol Select adalah:
Fungsi

Digunakan untuk memilih semua level dari kotak bagan di
sebelah kiri dan kanan kotak bagan aktif.

Digunakan untuk memilih semua cabang kotak bagan di
bagian bawah kotak bagan aktif.

Digunakan untuk memilih semua kotak bagan yang
memiliki bentuk susunan Assistants.

Digunakan untuk memilih semua garis penghubung pada
kotak bagan.

» Tombol Fit Text, digunakan untuk menyesuaikan ukuran
font pada kotak bagan.

» Tombol AutoFormat, digunakan untuk menentukan bantuk
format dari kotak diagram.

» Tombol Zoom, digunakan untuk mengatur ukuran lembar
kerja, presentasi.

Dalam membuat diagram, ada beberapa pilihan, salah satunya
adalah Cycle Diagram. Diagram ini, pada saat obek Cycle
Diagram aktif atau dalam kondisi terpilih, PowerPoint akan
menampilkan tool bar diagram yang dapat digunakan untuk
mengatur tampilan
objek diagram.
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Keterangan dari foolbar tersebut adalah:

Tombol Fungsi
Insert Shape Digunakan untuk menambah shape baru pada diagram Cycle
Move Shape Digunakan untuk mengubah shape terpilih satu level/tingkat
Backward ke belakang
Move Shape Digunakan untuk mengubah urutan shape terpilih satu
Forward level/tingkat ke depan

Digunakan untuk mengubah shape terpilih berbalik dengan

Reverse Diagram ..
& format atau posisi sebelumnya.

Pada Cycle Diagram juga mempunyai bentuk-bentuk yang bisa
diatur sesuai dengan keinginan, di antaranya adalah bentuk dan
warna. Pengaturan ini ada di dalam Diagram Style Galery.

Gambar 5.89
Tampilan Diagram Style Galery

Tugas 15

Buat Presentasi dan Tampilkan di depan kelas.

1.Buatlah presentasi di bawah
ini. Presentasi berisi
gambaran suatu perusahaan
perusahaanmu sendiri,
meliputi diagram
orgasisasi, tujuan, visi, misi
perusahaan, produk yang Gambar 5.90 Gambar 5.91
dibuat. Jika diperlukan, Contoh Diagram Organisasi Contoh Presentasi
tambahkan beberapa file
pendukung berupa hasil potret tentang bentuk barang yang dihasilkan.

2.Buatlah presentasi tentang suatu pemecahan masalah penanggulangan sampah
yang terjadi di lingkungan-mu. Presentasi dibuat berisi ajakan, himbauan
tentang 3R (Reduce, Reuse, Recycle) dalam penanggulangan sampah. Lengkapi
pula presentasi yang kalian buat dengan menggunakan hasil potret sampah atau
clip art (foto maupun clip video) mengenai sampah (dari internet).
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Membuat Hyperlink

Gambar 5.92
Proses Hyperlink

Gambar 5.93
Proses Hyperlink
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Dalam proses pembelajaran, sering kali ditemui suatu materi
yang terdiri atas beberapa pokok pembahasan. Jika dirancang
suatu slide presentasi untuk mendukung pembelajaran materi
tersebut, maka muncul persoalan, ukuran file akan
membengkak atau terlalu banyaknya jumlah halaman slide
yang terdapat di dalam sebuah s/ide presentasi, hal ini akan
sedikit mengurangi efektifitas dan efisiensi penggunaan sl/ide,
terutama pada saat melakukan strukturisasi pembelajaran.
Untuk mengatasi persoalan di atas, slide presentasi dipecah
menjadi beberapa file, tiap-tiap file terdiri atas satu pokok
bahasan, kemudian rancang sebuah slide utama untuk
mengatur struktur tampilan slide. Kemudian, sl/ide utama
melakukan /ink ke masing-masing slide pokok bahasan,
metoda ini disebut dengan teknik iyperlink dalam PowerPoint.

Langkah-langkah pembuatan /yperlink adalah sebagai berikut
1. Rancang sebuah slide utama, sebagai linker antarpokok
bahasan.
2. Rancang semua s/ide untuk maing-masing pokok bahasan
materi ajar.
3. Aktifkan Slide utama.
4.Pilih salah satu topik, kemudian klik menu /nsert ->
Hyperlink atau klik
ikon pada toolbar,
atau klik kanan pada
topik pokok bahasan
materi, kemudian klik
kanan, maka akan
muncul pop-up menu,
pilih hyperlink,
seperti diperlihatkan
pada gambar di
samping ini.

5. Kemudian, akan muncul kotak dialog untuk mengatur
konfigurasi
hubungan antarfile
pada proses
hyperlink, terlihat
pada gambar di
samping ini




6. Dalam membuat /ink file, terdapat tiga pilihan lokasi /ink,
yaitu Current Folder, jika link file tersebut terdapat pada
folder yang sama dengan s/ide utama, Browsed Pages, jika
link tersebut dihubungkan dengan halaman yang telah di
browsing sebelumnya dan Recent Files, jika link dilakukan
dengan salah satu file yang sering digunakan.

7. Kadang /ink tidak dilakukan antarfile, tetapi ke salah satu
halaman file yang dijelaskan target /ink, maka untuk menuju
ke halaman yang bersangkutan, klik tombol untuk
membuka daftar bookmark halaman slide file target link.

8. Kemudian, tentukan salah satu halaman s/ide yang akan di
link-kan.

Tugas 16

Buatlah Hyperlink untuk menampilkan presentasi dibawah ini.

Materi : Komponen Pasif Elektronika
Pokok Bahasan : A. Resistor
1. Konsep Dasar Tahanan 3. Rangkaian Resistor
2. Kode Warna Resistor 4. Mengukur Resistor
B. Kapasitor
1. Prinsip Kerja Kapasitor 3. Kode Nilai Kapasitor
2. Jenis Kapasitor 4. Mengukur Kapasitor
C. Induktor
1. Prinsip Kerja Induktor
2. Jenis Induktor
3. Mengukur Induktor

Animasi Slide dengan Microsoft
PowerPoint 2003

Kalian pasti merasa jenuh dan bosan jika melihat materi
PowerPoint yang monoton (yang hanya berupa tampilan-
tampilan bahan tulisan saja)?

Untuk mengurangi kejenuhan pendengar dan juga mengurangi
rasa kantuk dari pendengar, dalam presentasi dengan
PowerPoint dapat digunakan efek Animasi.

Animasi s/ide dalam presentasi merupakan salah satu cara yang
dapat digunakan untuk meningkatkan perhatian audiens
terhadap presentasi yang digunakan. Namun, jika di dalam
presentasi banyak hal-hal yang berlebihan juga akan
mengganggu konsentasi dan fokus audiens.

PowerPoint 2003, telah dilengkapi dengan berbagai jenis
kemampuan animasi yang dikelompokkan ke dalam dua sub

menu, yaitu :
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1. Animation Scheme
2. Custom Animation

1. Animation Scheme

Animation Schema merupakan fasilitas animasi yang telah

diberikan secara default oleh PowerPoint, sehingga

desainer cukup memilih salah satu dari default yang tersedia

tersebut.

Untuk mengkatifkan Animation Scheme ini lakukan

langkah-langkah sebagai berikut :

a. Buatlah sebuah presentasi baru yang sederhana

b. Pilih menu Slide Show, kemudian pilih sub menu
Animation Scheme, sehingga akan tampil jendela

Animation Scheme dikelompokkan ke dalam beberapa

pengelompokan, yaitu:

* Recently Used

* Subtle
* Moderate
Gambar 5.94 * Exciting o .
Tampilan Animation Scemes Pengelompokan ini ditujukan untuk mempermudah desainer

slide dalam menggunakan skema animasi yang tersedia
dalam Microsoft PowerPoint 2003.

2. Custom Animation
Falisitas animasi yang terdapat pada Animation Scheme,
kadangkala tidak mencukupi bagi seorang desainer yang
menginginkan tampilan slidenya
lebih hidup dan wvariatif, maka
untuk menjawab kebutuhan
tersebut PowerPoint 2003

Gambar 5.95 . ..
Pilihan pada Custom menyediakan fasilitas custom
Animation Animation, sehingga seorang
desainer dapat mengatur sendiri
kebutuhan animasinya pada sebuah s/ide presentasi.
Secara garis besar, kustomisasi animasi ini dikelompokkan
dalam 4 bagian, yaitu:

* Entrance, digunakan untuk
memberikan efek animasi masuk
pada layar.

* Emphasis, digunakan untuk

Gambar 5.96 memberikan efek animasi pada
Efek Animasi .. .

Enterance transisi slide yang sedang
berlangsung.

* Exit, digunakan untuk memberikan efek animasi keluar

dari layar.
* Motion Path, digunakan untuk memberikan efek animasi
dengan gerak mengikuti pola yang digunakan.
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Dalam efek animasi Motion Path ini, kalian dapat
menggambarkan sendiri pola gerak animasi teks yang ingin
dibuat. Hal ini dapat dilakukan dengan menggunakan fasilitas
Draw Custom Path, seperti diperlihatkan pada gambar di

bawah ini:
Gambar 5.97 Gambar 5.98
Cara membuat path animasi sendiri Efek Motion Path

Di samping pola gerak standar yang ada pada Motion Path,

pola gerak animasi teks ini dapat ditambahkan dengan berbagai

pola yang lebih menarik, hal ini dapat dilakukan dengan

memilih opsi More Motion Path sehingga akan tampil menu _ Gambar5.99
. . . Pilihan pada Emphasis

pilihan sebagai berikut.

Tugas 16

Misalkan kamu adalah seorang manajemen keuangan
pada perusahaan konsultan Indonesiana Investment.
Salah satu dari tanggung jawab utama kamu adalah
memberikan seminar mengenai investasi keuangan.
Buatlah slide presentasi dengan menggunakan efek
animasi dan sisipan objek/tabel/gambar, kemudian
cetak slide tersebut.

Kamu juga perlu menyisipkan tabel Jumlah Potensial
Investasi berikutini:

Tahun Ke-1 | Tahun Ke-3 | Tahun Ke-5 | Tahun Ke-10 Gambar 5.100
Menambahkan Motion Path
Modal 4.5% 5.2% 5.5% 10%
Saham 71% 8% 8.2% 7.8%
Keuntungan | 6.1% 6.5% 7% 6.8%
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Animation Trigger

Animation trigger adalah suatu fitur di dalam Microsoft
PowerPoint yang memungkinkan satu atau lebih animasi
dilakukan saat dilakukan klik terhadap suatu objek tertentu
(yang menjadi trigger-nya).

1. Kegunaan Animation Triger

Animation trigger berguna untuk mengontrol animasi-animasi
yang kita buat. Contohnya, kita ingin hanya animasi-animasi
tertentu yang dilakukan di dalam presentasi kita (dan kita masih
belum dapat menentukan animasi mana yang harus dilakukan
sebelum presentasi karena animasi yang diperlukan dapat
berbeda-beda setiap presentasi). Dalam hal ini, kita dapat
membuat beberapa objek yang masing-masing menjadi trigger
dari animasi-animasi yang ada. Saat presentasi, kita cukup
menekan objek yang menjadi trigger dari animasi yang kita
inginkan.

Langkah-langkah membuat Animation Trigger adalah sebagai
berikut:

a. Buat semua animasi yang diperlukan seperti biasa. Sebagai
contoh, kalian ingin melakukan animation trigger pada 2
objek (“Rectangle 1” dan “Rectangle 2) sedemikian
sehingga “Rectangle 1” akan melakukan animasi “flash
bulb” saat Anda meng-klik “Rectangle 2” dan sebaliknya,
“Rectangle 2” akan melakukan animasi “flash bulb” saat

Anda meng-klik
“Rectangle 1”. Pada
langkah pertama ini,
kamu <cukup
memasukkan animasi
“flash bulb” ke
“Rectangle 17 dan
“Rectangle 2” (buat
“Rectangle 17, klik
“Rectangle 17, pilih
menu Slideshow >
Custom Animation> Add
Effect > Emphasis >
More Effect > Flash
Bulb, lakukan hal yang
sama pada “Rectangle 27). Hasilnya dapat terlihat pada
bagian “Modify effect” pada “Custom animation” sebagai
berikut.

Gambar 5.101
Custom Animation
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2. Klik kanan “Rectangle I” pada bagian “modify effect” seperti
gambar di atas, lalu pilih tab “7iming”, klik button
“Triggers”, pilih radio button “Start effect on click of>”, pilih
“Rectangle 2” sehingga muncul dialog box seperti gambar
dibawabh.

3. Lakukan hal yang sama untuk “Rectangle 2” (Start effect on
click of: “Rectangle 1”). Setelah langkah 2 dan 3 dilakukan,
bagian “modify effect” akan tampak seperti gambar 5.98 di
bawabh.

4. Untuk melihat hasilnya pada slideshow mode (tekan F5),
cobalah klik “Rectangle 1’ dan “Rectangle 2" sehingga akan
bereaksi dan sebaliknya.

Gambar 5.102 Proses Animation Triger Gambar 5.103 Modify Effect
Sekilas Info

Menciptakan Presentasi Multimedia yang Menarik

Hampir setiap saat kita dihadapkan dengan presentasi. Umumnya, banyak dari
kita yang berpresentasi menggunakan aplikasi slide seperti Microsoft Power
Point atau Open Office Presentation. Tentunya, kesederhanaan aplikasi slide ini
memberikan batasan untuk bisa menampilkan presentasi visual yang menarik.
Oleh karena itu, kadang aplikasi multimedia seperti Macromedia Flash bisa
banyak membantu.

Seperti layaknya sebuah cerita, presentasi multimedia pun perlu diawali dengan
intro yang menarik dan sesuai dengan tema materi yang disampaikan. Sebagai
contoh, presentasi multimedia Pepsodent Nightbrushing buatan SmartShell,
bercerita tentang program dan strategi Pepsodent yang mengajak konsumennya
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untuk menggosok gigi setiap malam. Ancaman kuman malam menjadi prolog
presentasi multimedia. Diceritakan dalam intro, seorang anak yang tidur di
malam hari tidak bebas dari ancaman kuman mulut. Kuman-kuman tetap beraksi
meski anak itu tidur. Untuk itulah, dirasakan penting untuk menggosok gigi
sebelum tidur. Penggunaan musik dan efek suara juga sangat membantu
membangun suasana presentasi. Kalau awalnya saja tidak menarik, mana
mungkin penonton tertarik untuk melihat materi presentasi tersebut lebih lanjut.

Selanjutnya, pembagian konten presentasi, penahapan yang tepat, dan urutan
presentasi perlu diperhatikan. Visual, musik, dan efek suara yang relevan dengan
materi presentasi akan menjaga penonton untuk terus tertarik memperhatikan.
Bila materi yang disampaikan penuh dengan teks, atur jeda dengan menyisipkan
ilustrasi, foto, video, atau aplikasi lain. Salah satu tujuannya adalah untuk
meringankan beban mata penonton yang cenderung lelah bila dihadapkan teks
terus menerus.

Akhiri presentasi dengan kesimpulan yang mengarahkan penonton akan pesan
yang ingin kita sampaikan. Bila perlu, lengkapi dengan video atau animasi
penutup yang memvisualkan berbagai kemungkinan implementasi materi yang
kita sampaikan.

<sumber: http://media-ide.bajingloncat.com, 3 Agustus 2008>

Articulate Presenter adalah sebuah software yang terintegrasi dengan Microsoft
PowerPoint untuk mempermudah Anda membuat narasi, interaktivitas, dan film
Adobe Flash dalam presentasi Power Point. Setelah itu, Anda dapat
mengirimkannya ke Internet. Berikut merupakan tips presentasi menggunakan
flash :

1. Install Articulate Presenter. Jika sudah terinstal, maka ketika Anda membuka
PowerPoint akan tertampil menu “Articulate’ di PowerPoint Anda.

2. Membuat presentasi PowerPoint sesuai yang Anda inginkan. Gunakan banyak
fitur seperti animasi, slide transitions, gambar, ataupun flying text.

3. Dari menu PowerPoint, pilihlah “Articulate” yang akan menampilkan menu
drop down. Pilih “Publish”, dan kemudian akan muncul kotak dialog
“Publish”

4. Terdapat beberapa pilihan dari mulai publish ke web hingga publish ke CD-
ROM. Jika Anda tertarik dengan publish ke Internet, Anda dapat memilih
“Web”, lalu “Publish”.

5. Setelah presentasi dipublikasikan, sebuah pesan akan tertampil untuk Anda
yang menunjukkan bahwa file Adobe Flash baru saja di-copy. Terdapat pilihan
apakah Anda ingin melihat presentasi yang tela dipublikasikan.

6. Click “Yes”, kemudian presentasi Flash dengan web akan loading dan
tertampil dalam player Articulate Presenter.

<sumber: http:www.articulate.com, 3 Agustus 2008>
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PowerPoint Sudah Tersedia di Google Docs

SAN FRANSISCO, Setelah lima bulan diumumkan, layanan online yang
menyediakan aplikasi membuat dan berbagi file presentasi secara cuma-cuma
akhirnya tersedia di Google Docs. Layanan tersebut akan menjadi pesaing
langsung aplikasi PowerPoint yang selama ini hanya tersedia dalam paket
software yang berlisensi.

Untuk menggunakan layanan tersebut, pengguna tak perlu meng-install di
komputernya, namun harus terhubung secara online. Seperti halnya PowerPoint,
aplikasi tersebut dapat dipakai untuk membuat halaman presentasi yang berisi
teks, grafik, maupun gambar. Selain aplikasi presentasi, Google Docs sudah
menyediakan aplikasi pengolah kata, pengolah tabel, dan program manajemen
kalender.

Namun, tidak semua tersedia gratis. Untuk versi yang lebih lengkap fiturnya
ditawarkan kepada perusahaan, pemerintah, dan lembaga pendidikan dengan
biaya akses 50 dollar AS setahun.

Selama ini, aplikasi kantoran semacam itu didominasi Microsoft melalui paket
aplikasi Office-nya. Namun, sejak dua tahun terakhir, eksekutif Google
menunjukkan strategi persaingan langsung kepada Microsoft dengan
menawarkan aplikasi yang mirip.

<Sumber: www.kompas.com, 3 Agustus 2008>

Tips and Trick
1. Perencanaan Materi Presentasi

Perencanaan dokumen presentasi merupakan hal paling mendasar yang perlu
dipersiapkan. Perencanaan tersebut di antaranya:

» Tentukan Tema dan Tujuan secara Spesifik
Meskipun dimungkinkan menyusun satu dokumen presentasi dengan
kandungan yang sangat komprehensif untuk berbagai keperluan, namun hal
ini tidak disarankan. Pastikan kamu memiliki dokumen presentasi tersendiri
dengan tema, tujuan, dan misi, serta target audience penyajian presentasi
yang spesifik.

» Susun Kerangka Materi Presentasi

Ibarat merencanakan sebuah karya tulis yang dituangkan dalam sebuah
kerangka karangan, maka presentasi yang baik juga harus memiliki kerangka

o BAB 5 Menggunakan Power Point I




materi yang dituangkan dalam poin-poin presentasi. Susun poin-poin utama
presentasi, estimasikan jumlah dan koherensi slide-slide kamu, temasuk
pertimbangan perlunya referensi-referensi pendukung.

» Kumpulkan Materi Utama dan Pendukung
Pengumpulan materi dapat kamu persiapkan dari awal. kamu dapat mulai
merangkum sumber-sumber materi yang akan kamu tuangkan. Pilih koleksi
file gambar, audio, atau video sebagai objek pendukung. Siapkan tabel, grafik,
dan data pendukung jika diperlukan.

> Tentukan Aplikasi Pembuat Presentasi yang Tepat
Berdasarkan perencanaan, kerangka, dan kumpulan materi yang telah kamu
siapkan di awal, maka kamu dapat memilih aplikasi pembuat presentasi yang
tepat bagi penuangan materi presentasi kamu.

» Manfaatkan Aplikasi Penunjang
Inovasi di bidang perangkat lunak dewasa ini sangat beragam. Kamu dapat
memanfaatkan aplikasi tertentu untuk keperluan tertentu. Pada dasarnya,
output akhir yang kamu persiapkan melalui aplikasi penunjang selalu dapat
kamu integrasikan ke dalam slide presentasi. Di samping memanfaatkan
aplikasi penunjang bagi penyusunan materi, kamu juga sebaiknya
melengkapi diri dengan berbagai aplikasi bantu bagi penyajian presentasi.

» Tentukan Output sesuai dengan Kebutuhan
Tentukan output akhir presentasi kamu berdasarkan pertimbangan-
pertimbangan yang telah diulas di bagian awal. Jika memungkinkan, pilih
output akhir yang paling fleksibel sehingga kamu mudah menyajikan,
mengekspor, atau mengonversikan formatnya ke dalam output lainnya jika
diperlukan.

2. Penguasaan Aspek Teknis

Selain menguasai aspek pembuatan sebuah dokumen presentasi melalui aplikasi
tertentu, akan lebih ideal jika kamu juga memahami berbagai hal berkaitan
dengan aspek teknis seputar penyajian presentasi. Beberapa di antaranya adalah
tentang perangkat-perangkat yang diperlukan dalam menyajikan sebuah
presentasi, perangkat pendukung yang dapat kamu pilih, serta teknik-teknik
penggunaannya. Beberapa hal yang sebaiknya kamu pahami, antara lain :

> Pemilihan Perangkat Komputer
Peran komputer penyaji sangat dominan bagi kelancaran sebuah sesi
presentasi. Pertimbangan pemilihan perangkat komputer, antara lain
mengenai spesifikasi teknis komputer, jenis atau tipe komputer, kelengkapan
perangkat teknologi yang terpasang, serta sistem operasi dan aplikasi
penunjang yang ada di dalamnya.
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» Pemilihan Media Simpan
Media simpan tidak hanya terbatas pada harddisk yang ada di dalam PC kamu.
Pertimbangkan segi portabilitas, fleksibilitas, dan mobilitas media simpan
bagi dokumen presentasi kamu.

» Pemilihan Perangkat Display
Perangkat display presentasi tidak hanya terbatas pada OHP. Pertimbangkan
penggunaan LCD Projector, DLP Projector, atau Dual/Multi Monitor untuk
berpresentasi.
Tentukan juga jenis screen yang paling sesuai dengan kebutuhan kamu.
Pemilihan perangkat pendukung sound system yang memadai adalah syarat
mutlak bagi penyajian presentasi. Tentukan jenis perangkat sound system
yang fleksibel, namun berkemampuan optimal. Pertimbangkan juga
pemakaian laser pointer untuk mendampingi sesi presentasi kamu.
Sediakan camera pada ruang presentasi untuk keperluan dokumentasi kamu,
terlebih jika kamu ingin mendistribusikan kembali moment-moment
presentasi yang cukup penting untuk kolega kamu.

» Teknik Penyajian Presentasi
Sebagus apapun materi presentasi kamu, selengkap apapun perangkat
presentasi yang tersedia, semua akan sia-sia jika teknik penyajian presentasi
kamu tidak menarik.

3. Beberapa tips agar sukses dalam penyajian presentasi :

» Kuasai Teknik-teknik Penyajiaan Presentasi
Temukan teknik-teknik tertentu, seperti bagaimana menyajikan presentasi
melalui beberapa monitor, bagaimana menyembunyikan sajian slide secara
temporer untuk mengalihkan perhatian audience dari screen ke pembicaraan
kamu, termasuk bagaimana mengemas slide presentasi agar dapat berjalan
secara otomatis atau dapat diakses via internet.

» Simulasikan Presentasi Kamu Sesering Mungkin
Jika perlu, gunakan fasilitas Timer yang tersedia pada aplikasi penyaji
presentasi untuk melatih dan memastikan ketepatan waktu pemaparan setiap
slide presentasi kamu.

> Lengkapi Sajian Presentasi dengan Materi Tambahan
Kamu dapat mencetak dan mendistribusikan lembar handout, membagikan
CD materi presentasi, atau bahkan menyertakan materi pendukung bagi
audience.

Hal ini dapat meminimalkan pecahnya perhatian audience karena harus
mencatat poin-poin dan paparan kamu, menghindari tidak tertangkapnya
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sebagian materi presentasi yang Kamu sajikan, dan tentunya menjadi salah
satu media penyebaran bagi visi dan misi penyajian presentasi kamu.

> Persiapkan Keberhasilan Sejak Dini
Masuk ke ruang presentasi paling akhir bukanlah kebiasaan yang baik.
Datanglah lebih awal untuk memastikan segala sesuatu telah dipersiapkan
dengan baik. Sambutlah kedatangan audience dan lakukan perbincangan awal
untuk lebih mencairkan suasana. Dengarkan harapan-harapan dan
permasalahan mereka untuk memperoleh keuntungan materi spesifik yang
akan mempertajam penyajian presentasi kamu.

ngkum,
2 %

1. Membuat dokumen presentasi sangatlah mudah, ada 4 cara yang dapat
dilakukan untuk membuat dokumen presentasi yang baru. Keempat cara
tersebut adalah:

» Blank Presentation

» From Design Template

» From AutoContent Wizard

» From Existing presentation

2. Untuk membuat presentasi yang baik, perhatikan konten yang ingin
dibuat, yang meliputi:

»Tujuan

» Data atau Informasi

» Struktur

» Bahasa

3. Penyampaian Presentasi yang baik adalah dengan:
» Attention Grabbing

» Audience Interaction

»Style

» Time

4. Merencanakan sebuah dokumen presentasi yang baik meliputi:
» Penentuan tema dan tujuan secara spesifik
» Penyusunan kerangka materi presentasi yang baik
» Pengumpulan materi utama dan pendukung yang sesuai dan cukup
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» Penentuan aplikasi pembuat presentasi yang tepat
» Pemanfaatan aplikasi penunjang
» Penentuan output sesuai dengan kebutuhan

5. Penguasaan aspek teknis agar presentasi berjalan dengan baik meliputi:
» Pemilihan perangkat komputer

» Pemilihan media simpan

» Pemilihan perangkat display

» Teknik penyajian presentasi

6. Agar sukses dalam penyajian presentasi :

» Kuasai teknik-teknik penyajiaan presentasi

» Simulasikan presentasi kamu sesering mungkin

» Lengkapi sajian presentasi dengan materi tambahan
» Persiapkan keberhasilan sejak dini

Trigger Berguna untuk Membuat Sejumlah Pertanyaan dan
Jawaban

Kegunaan lain dari trigger: Anda dapat membuat sejumlah pertanyaan dan
jawaban pada slide, dan membuat pilihan jawaban sebagai trigger yang
menampilkan jawaban benar atau salah. Sebagai contoh, pada presentasi
“Perkenalan ke kelas saya”, Anda bisa mengajak pembaca untuk menebak
tentang diri Anda:

Mana yang benar? Peliharaan saya adalah:
1. Kucing bernama Puss.

2. Burung bernama Jacob.

3. Anjing bernama Blacky.

Jawaban apapun yang diklik pembaca, teks, atau gambar akan muncul,
misalnya sebuah suara berbunyi yang menandakan jawaban benar atau salah.
Trigger membantu Anda berinteraksi dua arah dengan para murid, mengajak
mereka untuk menebak, tertawa, mempertimbangkan, dan belajar.

Beberapa hal penting tentang trigger:

- Setiap Anda mempunyai efek animasi, film, atau suara, Anda bisa
membuatkan trigger. Atau, dengan kata lain: Anda tidak bisa menggunakan
fitur Trigger kecuali salah satu efek tersebut terdapat pada slide Anda.

- Anda harus mengklik trigger secara langsung (tidak hanya mengklik slide
saja) supaya efeknya berjalan.

<Sumber: http://www.pcmedia.co.id, 5 September 2008>
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A. Pengecekan Konsep

Pilihlah salah satu jawaban yang paling benar!

@ Membuat presentasi berdasarkan

(6]

langkah demi langkah dapat
ditentukan dengan menggunakan
pilihan.....

a. Mailmerge

b. Open and exciting

c. Blank Presentation

d. Auto Content Wizard

e. Design Template

Di bawah ini adalah submenu dari
menu File, kecuali....

a. New d. Close
b. Open e. Save
c. Paste

Pada toolbar standar PowerPoint,
ikon dideskripsikan untuk....

a. menyimpan presentas

b. membuka presentsi

¢. membuat presentsi baru

d. menyisipkan ClipArt

e. mencetak presentasi

Untuk memberi efek Animation pada
objek dapat dilakukan dengan
menggunakan perintah....

a. Slide show-Set up Show

b. Slide show-CustoAnimation

c.Slide show - Animation Schemer

d. Slide show-View show

e. View- Slide show

Pada toolbar standar PowerPoint,
ikon dideskripsikan untuk....

a. menyimpan presentasi

b. membuat presentasi baru

c. mencetak kertas kosong

d. membuka presentasi

e. mencetak presentasi

Icon berguna untuk...

O Ikon

a. membuka file

b. menutup dokumen

c. mencetak naskah

d. membuka dokumen baru
e. membuka permainan

@ Pada roolbar Formating, ikon

bergunauntuk ....
a. penomoran otomatis
b. ratatengah objek teks
c. pemberian simbol otomatis
d. pilihan jenis font
e.ratabawah atas teks

© Di bawah ini adalah contoh software

untuk membuat program presentasi,
kecuali....

a. Microsoft Power Point

b. Macromedia Action 3D

c. Autowerestar

d. Macromedia Flash

e. Corel Draw

@ Di bawah ini adalah submenu dari

menu Edit, kecuali....
a. Duplicate d. Clear
b. Slide Show e. Replace

c. Copy

berguna untuk menentukan
perataan teks. ...

a.rata kanan kiri

b.ratakanan

c.rataatas

d. ratakiri kanan objek teks
e.ratabawah atas teks

@ Di bawah ini adalah submenu dari

menu View, kecuali....

a. Duplicate Slide d. Notes Pages
b. Slide Sorter e. Task Pane

c¢. Normal



Perintah tombol F5 pada Ms. Power

Pointberfungsiuntuk ....

a. menampilkan presentasi

b. menyimpan presentasi

c.menyisipkan gambar untuk
presentasi

d. membuka presentasi

€. mengcopy presentasi

Perintah Insert-Picture, berarti....

a. menempatkan objek gambar

b. menempatkan view

c.menyisipkan ikon suara dan CD
Audio

d.mengambil file suara dari folder
tertentu

e. merekam gambar

Untuk memberi efek keterampilan
teks, pada saat slide ditampilkan dapat
digunakan perintah. ...

a. Slide show-Custom Animation

b. Slide show-Set up Show

c. Slide show - Animation Schemes

d. View- Slide- Sorter

e. Slide show-View show

Pada foolbar standar PowerPoint, ikon
untuk....

a. menyimpan presentasi

b. membuka presentasi

c. mencetak presentasi ke kertas

d. mencetak ke layar

e. membuat presentasi baru

Untuk menghubungkan kata/kalimat
pada slide yang kita buat dengan suatu
file yang pernah dibuat sebelumnya
dapat menggunakan fasilitas. ...

a. Packing/Publishing

b. Web Page

c. Slide Show

d. Navigasi

e. Hyperlink

Perintah format font adalah untuk. ..
a. memilih ukuran huruf
b. memilih bentuk huruf

¢. memilih warna huruf
d. memilih gaya tampilan huruf
e.a,b,cdandbenar

® Perpindahan slide yang satu dengan

slide yang lain serta waktu
perpindahan disebut....

a. Mailmerge d. Transisi
b. Hyperlink e. Interval
c. Embeded
® Presentasi yang dicetak ke printer
disebut....
a. Soft Hand d. Hand Out
b.Jack Out e. Ear Out
c. Cetakan

@ Waktu tayang slide dalam presentasi

dapat diatur dengan fasilitas ....
a. Mailmerge d. Transisi
b. Hyperlink e. Interval
c. Embeded

@ Untuk menampilkan slide ada dua

cara, yaitu otomatis dan manual.
Bila akan mengatur, maka anda klik
padaview, lalupilih....

a. Slide show d.Header and
b. Zoom Footer
c. Master e. Ruler

@ Pada toolbar Formating, icon Font

Size digunakan untuk....
a. pilihan jenis font
b.ratabawah atas teks

c. pilihan ukuran font

d. rata tengah objek teks
e. huruftebal

@ Berikut ini yang tidak dapat disisipkan

dalam slide presentasi adalah...
a.suara d. video

b. gambar e.table

c. program sistem informasi kantor
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@ Untuk membuat sebuah presentasi,

kalian bisa melakukannya melalui
Blank Presentasi, Design Template,
Auto Contect Wizard. Blank Presentasi,
Design Tempalte Auto Content Wizard

@ Istilah Prevoius Slide berarti....

a. pindah ke slide sebelumnya

b. pindah ke sl/ide berikutnya

c. sama dengan perintah Page Down
d. sama dengan perintah tombol Page

berada di dalam.... Up

a. Menu Bar d. Task Pane e. a dan d benar
b. Toolbar e. Slide Master

c. Header and Footer

B. Pemahaman Konsep

Jawablah pertanyaan di bawah ini.

Jelaskan urutan untuk menambah efek suara pada text presentasi kamu.
Jelaskan manfaat dari sebuah presentasi bagi sebuah perusahaan atau instansi.

Apa yang dimaksud dengan Animation trigger dalam PowerPoint.

0o 00

Jelaskan kegunaan fasilitas-fasilitas di bawabh ini.
a. Slide Transition c. Design Template
b. Custom Animation  d. Set up Show

e. Background

®

Tuliskan hal-hal apa saja yang harus diperhatikan dalam membuat suatu
presentasi yang baik.

C. Aktifitas Siswa

Buatlah sebuah presentasi tentang Bimbel Online dengan menggunakan themes berikut
ini (contoh themes dapat diambil melalui CD yang disertakan):
Isi dari presentasi harus ada unsur-unsur seperti tercantum pada gambar di bawah ini:
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Tujuan Pembelajaran:

KATA KUNCI |
B Action Script M Animasi
B Scene B Stage
B Panels B Frame

Setelah mempelajari bab ini diharapkan

siswa mampu:

1. Memahami dan mengetahui menu dan
ikon yang terdapat dalam perangkat
lunak pembuat animasi

2. Dapat menggunakan menu dan ikon
yang terdapat dalam perangkat lunak
pembuat animasi

3. Membuat animasi sederhana.

Ada banyak sekali contoh animasi yang
kita temui di televisi dan komputer,
contohnya seperti animasi peta di samping.

Animasi tersebut dibuat dengan
menggunakan perangkat lunak yang
bernama Flash, perangkat lunak ini dapat
membantu kita membuat berbagai macam
animasi.

Pada bab ini, kamu akan mempelajari lebih
jauh tentang pembuatan animasi dengan
menggunakan perangkat lunak Flash.

B Timeline m Keyframe
W Shape Hint ™ Tween Animation
B Fasing B Free Transform.



Peta konsep

Menunjukkan
Menu dan Tkon
yang terdapat
dalam
Perangkat Lunak
Pembuat
Animasi

Menggunakan
b Sl Menu dan Tkon

Perangkat yang terdapat
Lunak dalam
Animasi Perangkat Lunak
Pembuat Animasi

Membuat
Animasi
Sederhana
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BAB Menggunakan Perangkat
6 Lunak Animasi

Film Animasi jaman dulu dibuat dengan cara mengambar 1 per
1 (frame by frame). Sekarang dengan adanya tehnologi
komputer, banyak perangkat lunak yang akan memudahkan
kita dalam pembuatan animasi. Salah satunya adalah
Macromedia Flash.

Pengertian Flash dan ActionScript

Macromedia Flash merupakan suatu program aplikasi grafis
buatan Macromedia. Sejak Macromedia diakuisisi oleh Adobe,
Macromedia Flash menjadi Adobe Flash. Beberapa versi Flash
yang pernah beredar antara lain: Macromedia Flash 5, Internet Link
Macromedia Flash MX, Macromedia Flash MX 2004,

Macromedia Flash 8, dan Adobe Flash CS (Creative Suite). Untuk informasi

lebih lanjut tentang

. . . Flash, kalian dapat
ActionScript merupakan suatu skrip pemrograman (kode mengunjungi situs

program) yang digunakan pada program Flash. Sejak http://www.flash-
Macromedia Flash MX 2004, editor teks untuk menulis skrip mx.com/

telah terintegrasi pada program Flash. Pada versi sebelumnya,

hingga Macromedia Flash MX, skrip pemrograman ditulis pada

editor teks eksternal, misalkan Notepad.

Keuntungan Menggunakan Flash

Flash memiliki sejumlah kelebihan, beberapa kelebihan Flash

antara lain:

» Animasi dan gambar konsisten serta fleksibel karena tetap
terlihat bagus pada ukuran jendela dan resolusi layar
berapapun pada monitor pengguna.

» Kualitas gambar terjaga, hal ini disebabkan karena Flash
menggunakan teknologi Vector Graphics yang
mendeskripsikan gambar memakai garis dan kurva sehingga
ukurannya dapat diubah sesuai dengan kebutuhan tanpa
mengurangi atau memengaruhi kualitas gambar. Berbeda
dengan gambar bitmap, seperti bmp, jpg, dan gif yang
gambarnya akan pecah-pecah ketika ukurannya dibesarkan
atau diubah karena dibuat dari kumpulan titik-titik.

» Waktu loading (kecepatan gambar atau animasi muncul atau
loading time) lebih cepat dibandingkan dengan pengolah
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animasi lainnya, seperti animated gifs dan java applet.

» Mampu membuat website yang interaktif karena pengguna
(user) dapat menggunakan keyboard atau mouse untuk
berpindah ke bagian lain dari halaman web atau movie,
memindahkan objek, memasukkan informasi di form.

» Mampu menganimasi grafis yang rumit dengan sangat cepat
sehingga membuat animasi layar penuh bisa langsung
disambungkan ke situs web.

» Secara otomatis mampu mengerjakan sejumlah frame antara
awal dan akhir sebuah urutan animasi sehingga tidak
membutuhkan waktu yang lama untuk membuat berbagai
animasi.

» Mudah diintegrasikan dengan program Macromedia yang
lain, seperti Dreamweaver, Fireworks, dan Authorware,
karena tampilan dan tool yang digunakan hampir sama.

» Dapat diintegrasikan dengan skrip sisi-server (server side
scripting) seperti CGI, ASP, dan PHP untuk membuat
aplikasi pangkalan data web.

» Lingkup pemanfaatan luas, dapat juga dipakai untuk
membuat film pendek atau kartun, presentasi, iklan atau web
banner, animasi logo, kontrol navigasi, dan lain-lain

Menjalankan Flash

Aktivasi program Flash pada komputer dengan sistem operasi
Windows XP dilakukan dengan mengklik Start>All Program
Files > Macromedia> Macromedia Flash 8.

Setelah dijalankan, Flash akan menampilkan window berisi

menu:

1. membuka dokumen Flash, selanjutnya disebut dokumen
saja, yang baru-baru ini dibuka (Open a Recent Item),

2. membuat dokumen baru (Create New), dan

3. membuat dokumen baru dari template (Create from
Template).

Gambar 6.1 Halaman awal (Start Page) Gambar 6.2 Area kerja flash
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Area kerja Flash terdiri atas lima area, yaitu Menu, Toolbox,
Timeline, Stage, dan Panels. Deskripsi dan fungsi masing-
masing area adalah sebagai berikut:

» Menu berisi kontrol untuk berbagai fungsi seperti membuat,
membuka, menyimpan file, dan lain-lain.

Gambar 6.3 Area Menu
» Stage adalah area persegi empat yang merupakan tempat
membuat objek atau animasi yang akan dimainkan.

Gambar 6.4 Area Stage

» Toolbox berisi koleksi untuk membuat atau menggambar,
memilih, dan memanipulasi isi stage serta timeline. Toolbox
dibagi (lagi) menjadi empat bagian, yaitu Tools, View,
Colors, dan Options. Beberapa tool mempunyai bagian
option. Contohnya ketika Arrow tool dipilih, options snap,
smouth, straighten, rotate, dan scale akan muncul.
Gambar 6.6

» Timeline adalah tempat membuat dan mengontrol objek dan Area alat
animasi.

Gambar 6.5 Area timeline

» Panels berisi kontrol fungsi yang dipakai untuk mengganti
dan memodifikasi berbagai properti objek atau animasi
secara cepat dan mudah.

Gambar 6.7 Panel Properties Frame
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Mengenal Animasi dengan Flash

I TIK SMA Kelas XII

Animasi adalah proses penciptaan efek gerak atau efek
perubahan bentuk yang terjadi selama beberapa waktu.
Animasi bisa berupa gerak sebuah objek dari tempat yang satu
ke tempat yang lain, perubahaan warna, atau perubahan bentuk
(yang dinamakan “morphing”)

Animasi Flash dapat dilakukan dengan dua cara, yaitu:

1. Frame by frame

2. Twweening

1.Frame by Frame Animation (Animasi Frame
per Frame)

Bentuk dasar dari animasi adalah animasi frame per frame.
Animasi frame per frame menuntut banyak gambar yang harus
dibuat. Efek animasi diciptakan dengan mengganti gambar
yang satu dengan gambar yang lain selama beberapa waktu.
Contoh animasi frame per frame dapat dilihat pada Help >
Samples > Flower. Semua gambar yang bergerak dihasilkan
dari gambar yang berbeda-beda tiap framenya. Karena animasi
frame per frame harus memiliki gambar yang unik tiap
framenya maka animasi frame per frame sangat ideal untuk
membuat animasi yang kompleks yang terdiri atas banyak
perubahaan seperti ekspresi wajah. Kelemahan dari animasi
frame per frame adalah membutuhkan banyak waktu untuk
membuat setiap gambar dan menghasilkan file yang besar
ukurannya.

Di dalam Flash, sebuah frame yang memiliki gambar yang
unik dinamakan keyframe. Animasi frame per frame
membutuhkan gambar yang unik setiap framenya, hal ini
menyebabkan setiap framenya adalah keyframe.

2. Menambahkan Keyframe

Untuk menambah keyframe pada timeline, sorot frame dan
lakukan satu dari beberapa cara berikut ini :

» Klik kanan dan pilih Insert Keyframe

» Pilih Insert >Keyframe dari menu

» Tekan F6 pada keyboard.




3.Membuat Animasi Frame per Frame

Di bawah ini akan ditunjukkan proses pembuatan animasi

frame per frame :

1. Sorot frame dimana kamu akan memulai animasi frame per
frame.

2. Jika belum berupa sebuah keyframe, buatlah menjadi
keyframe dengan cara memilih menu /nsert lalu Keyframe
(F6).

3. Gambarlah atau impor gambar pertama kamu dari urutan
gambar pada keyframe ini.

4. Kemudian, klik frame selanjutnya dan buatlah menjadi
keyframe yang lain. Rubahlah isi dari keyframe ini dengan
gambar berikutnya.

5. Lakukan penambahan keyframe dan perubahan isinya
sampai kamu memperoleh animasi yang utuh. Pada
akhirnya, teslah animasi kamu dengan kembali ke frame
pertama kemudian pilih menu Control, lalu Play .

4. Tweening

Tween animation sangat mengurangi waktu karena kamu tidak
perlu membuat animasi secara frame per frame. Sebaliknya,
kamu hanya membuat frame awal dan frame akhir saja. Dua
alasan utama mengapa tween animation sangat baik yaitu
karena mengurangi pekerjaan mengambar dan meminimalkan
ukuran file karena isi dari setiap frame tidak perlu disimpan.

Ada 2 jenis tween animation yaitu Shape tween dan Motion
tween, dimana masing-masing memiliki karakter yang unik.

5.Shape Tweening (Animasi Perubahan
Bentuk)

Shape tweening berguna untuk mengubah bentuk. F/ash hanya
dapat mengubah bentuk, jadi jangan mencoba untuk
melakukan Shape tween untuk group, symbol, atau teks. Hal ini
tidak akan berhasil. Kamu dapat melakukan Shape Tween pada
beberapa bentuk di dalam sebuah layer, tetapi lebih baik untuk
menempatkannya pada layer yang berbeda.

Hal ini akan memudahkan jika kita ingin melakukan
perubahan. Shape tweening juga memperbolehkan kamu untuk
mengubah warna.

6.Membuat Sebuah Shape Tween

Langkah-langkah membuat shape tween adalah :
1. Sorot frame di mana kamu ingin membuat animasi. Jika
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Ayo Cari Tahu

belum berupa sebuah keyframe maka rubahlah menjadi
keyframe.

. Buatlah gambar pada stage. Ingatlah shape tween hanya

bekerja pada bentuk, bukan pada group, simbol atau teks
yang dapat diedit. Untuk 3 elemen tersebut maka kamu perlu
mengubahnya menjadi bentuk dasar dengan melakukan
perintah Modify> Break Apart.

. Buatlah sebuah keyframe kedua dan buatlah gambar akhir

padastage.

Ayo cari contoh animasi menggunakan Flash di internet, lalu kamu simpan contoh
tersebut. Setelah kamu mempelajari penggunaan aplikasi perangkat lunak Flash
ini, kamu harus membuat animasi yang sudah kamu simpan. Tentunya dengan
modifikasi tampilan menurut seleramu.

4. Bukalah kotak dialog Frame Properties dengan mengklik

Gambar 6.8 6
Properties Frame

Internet Link 7

Untuk informasi
lebih lanjut
tentang Flash,
kalian dapat
mengunjungi situs
http://www.ado
be.com/suppor
t/flash/docume
ntation/fl_mx_t
utorials.html

pada frame mana pun yang berada di antara dua keyframe.
Kamu dapat juga menyorot sebuah frame di antaranya,
kemudian memilih menu Modify, lalu Frame.

. Pilih tab Tweening dan pilih Shape pada field Tweening.

Kamu akan melihat beberapa pilihan untuk merubah shape
tween seperti yang terlihat pada gambar di samping.

. Sorot salah satu Blend Type. Pilihan Distributive yang akan

menciptakan animasi transasi bentuk yang halus, sedangkan
pilihan Angular akan menciptakan transisi bentuk dengan
sudut dan garis-garis lurus. Jika gambar akhir kamu berisi
bentuk yang mempunyai sudut dan garis, pilih Angular,
selain itu pilih Distributive.

Jika perlu, rubahlah FEasing slider. Easing menentukan
bagaimana animasi kamu dari awal sampai akhir. Ini
berguna jika kamu ingin menciptakan efek mempercepat
atau memperlambat. Jika kamu ingin animasi kamu mulai
dengan lambat, kemudian cepat, geser sl/ider ke arah lain.
Untuk animasi yang permulaannya cepat, kemudian
melambat, geser slider ke arah out. Jika kamu ingin
kecepatan animasi konstan maka biarkan s/ider berada di
tengah. Kamu dapat juga mengetik besar dari Easing yaitu
dari—100 sampai 100.

8. Tekan tombol OK, teslah animasi dengan memilih menu

Control, lalu Play (Enter).

7.Shape Hints

Shape hints memberikan kontrol untuk shape tween yang

kompleks. Kamu bisa mengatur setiap titik awal dari
animasi perubahan bentuk, lalu titik akhir dari animasi
perubahan bentuk tersebut. Dengan memberi beberapa




shape hints maka kita bisa mengontrol animasi perubahan
bentuk sesuai dengan yang kita inginkan karena dalam
animasi perubahan bentuk yang kompleks seringkali apa
yang kita inginkan tidak bisa dilakukan oleh program Flash
secara otomatis kecuali melalui shape hints.

8. Menggunakan Shape Hints Pada Sebuah Shape
Tween

Kamu dapat menggunakan shape hints dengan mudah pada
shape tween, caranya sebagai berikut.
1. Buatlah shape tween dengan menggunakan langkah-langkah
membuat Shape Tiveen di atas.
2. Sorot frame awal dari shape tween. Pilih Modify>Transform
> Add Shape Hint, atau tekan Ctrl + H untuk menambah
sebuah shape hint. Shape hint muncul dengan lingkaran
merah dan sebuah huruf di dalamnya (huruf itu mulai dari a
sampai z).
. Pindahkan shape hint ke tempat yang kamu inginkan.
4. Sekarang sorot frame terakhir kamu akan melihat lingkaran
hijau kecil dengan huruf yang sama seperti pada shape hint
awal. Pindahkan shape hint ke tempat di mana kamu ingin
shape hint pertama bergerak menujunya. Internet Link
5. Jalankan movie kamu (Control | Play) untuk melihat
bagaimana shape hint memengaruhi tweening. ; ;
6. Tambahkan shape hint hingga kamu puas dengan hasilnya. ~ 16bih lanjut

W

Untuk informasi

Ingatlah untuk mencocokkan shape hint yang ada pada ten‘Fang Flash,

frame awal dan frame akhir — a harus ke a, b ke b dan kalian d'flpat'

seterusnya. mengunjungi
situs

Jika setelah menambahkan shape hint, kemudian kamu tidak
menginginkan shape hint tersebut, kamu dapat membuang ~ Nttp:/ WYVW-te
semua shape hint dengan memilih menu Modify>Transform acherclick.co
>Remove All Hints. Kamu juga dapat mengklik kanan pada m/flash2004/i
salah satu shape hint untuk membuka menu pop-up shape ndex.htm

hint. Menu ini memungkinkan kamu untuk menambahkan

sebuah hint (4dd Hint), membuang sebuah hint (Remove

Hint), atau Remove All Hint.

9. Motion Tweening (Animasi gerak)

Motion tween tidak hanya berguna untuk menggerakkan
groups, simbol, atau teks yang dapat diedit dari satu tempat ke
tempat lain. Motion tween menolong kamu untuk merubah
ukuran, memutar, merubah warna, dan transparansi simbol.
Motion tween hanya bisa digunakan pada satu objek pada satu
layer. Jadi, jika ingin mengerakkan banyak objek maka
membutuhkan banyak layer.
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Tips and Trick

Untuk animasi perubahan bentuk yang kompleks, jangan segan-segan untuk
menggunakan shape hint sebanyak-banyaknya. Semakin banyak shape hint
maka animasi kamu akan semakin baik sesuai dengan keinginan kamu.

Internet Link

Untuk informasi

10. Membuat Motion Tween

Langkah-langkah membuat sebuah motion tween adalah :

1.

2.

Sorot frame di mana Kamu ingin membuat animasi. Jika
belum berupa sebuah keyframe maka rubahlah menjadi
keyframe.

Gambar atau imporlah gambar yang kamu ingin lakukan
animasi. Kamu hanya dapat melakukan animasi pada group,
simbol, dan teks yang dapat diedit.

lebih lanjut
tentang » Jika kamu menggunakan sebuah gambar, grouplah
photoshop, gambar tersebut atau ubah menjadi sebuah simbol.

kalian dapat
mengunjungi
s 1t u s
http://board.fl
ashkit.com/bo
ard/forumdisp
lay.php?forum
id=61

» Jika kamu mempunyai gambar berupa simbol di /ibrary,
kamu cukup mendrag gambar dari library ke stage.

» Jika kamu menggunakan teks yang dapat diedit, kamu
tidak perlu melakukan apa pun karena sudah berupa
objek.

. Sorot frame dimana animasi akan berakhir. Rubah frame ini

menjadi sebuah keyframe dengan memilih menu /nsert lalu
Keyframe.

. Pindahkanlah gambar dalam stage ke tempat yang ingin

dituju. Ingatlah, kamu tidak hanya dapat menggerakkan
gambar, kamu juga bisa melakukan putaran, merubah
ukuran, dan merubah efek warna.

. Klik kanan pada sebuah frame di antara kedua keyfirame dan

pilih Create Motion Tween lalu test-lah animasi kamu.

. Jika kamu ingin mengubah properties motion tween, klik

pada salah satu frame yang berada di antara kedua keyframe
untuk membuka kotak dialog Frame Properties. Pilih tab
Tweening maka kamu dapat melakukan perubahan
properties, seperti pada gambar berikut ini :

Gambar 6.9
Menu Tweening
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» Tween scaling—Jikakamu ingin mengubah ukuran.

» Rotate — Jika kamu ingin memutar objek. Pilih jenis putaran
pada menu drop down, kemudian angka rotasi pada kotak
times. Jika kamu mengetik 0 pada kotak times atau memilih
None pada menu drop down, tidak ada putaran yang
dilakukan.

» Orient to path direction — Ketika objek mengikuti sebuah
alur, pilihan ini menyebabkan objek berada di tengah alur.

» Easing — menentukan bagaimana animasi kamu dari awal
sampai akhir.

Ini berguna jika kamu ingin menciptakan efek mempercepat
atau memperlambat.

Jika kamu ingin animasi kamu mulai dengan, dan kemudian
cepat, geser slider ke arah ini. Untuk animasi yang
permulaannya cepat, kemudian melambat, geser slider ke arah
out. Jika kamu ingin kecepatan animasi konstan maka biarkan
slider berada di tengah. Kamu dapat juga mengetik besar dari
Easing yaitu dari—100 sampai 100.

Tugas 1
Membuat Flash Sederhana

Membuat Project Baru

1. Jalankan Macromedia Flash lewat start menu, caranya pilih Start > All
Programs >Macromedia > Macromedia Flash 2004 MX

2. Buat dokumen Flash, caranya pilih File > New.

3. Tampil kotak dialog New Document, selanjutnya pilih Flash Document, lalu
klik OK.

Gambar 6.10 New Document
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4. Atur ukuran dokumen pada Property Panel, sesuaikan ukuran dokumen
menjadi 550x 400 pixels.

Gambar 6.12
Membuat simbol baru

Gambar 6.13
Time line

Gambar 6.14
Roda bus
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Gambar 6.11 Properti panel

11. Menggambar Objek Bus

Berikut ini langkah-langkahnya (file objek bus.fla tersedia
dalam CD):

1.

2.

Buat simbol terlebih dahulu, caranya pilih Insert >New
Symbol.

Tampil kotak dialog Create New Symbol, beri nama Bus
pada kotak isian Name. Lalu, pilih Type dengan pilihan
Graphics, kemudian klik OK.

Dalam Timeline, ubah nama Layer 1 menjadi Roda Bus
karena Layer 1 akan dipergunakan untuk menempatkan
gambar roda Bus. Caranya klik dua kali pada Layer 1,
kemudian ketikkan teks Roda Bus di dalamnya, kemudian
tekan Enter.

Gambar roda Bus ke dalam Stage menggunakan Oval Tool
yang ada dalam kotak 700!/ Box. Caranya, klik tombol Oval
Tool. Kemudian, klik satu kali menggunakan klik kiri pada
mouse sambil tetap menekan tombol kiri mouse, lalu tarik
ke arah kanan atas atau kanan bawah sesuai dengan ukuran
yang diinginkan, selanjutnya lepaskan tombol kiri mouse
untuk mengakhiri proses.

o




. Ubah ketebalan garis tepi lingkaran dan warna lingkaran,
caranya klik tombol Selection Tool yang ada di dalam ool
Box. Lalu, klik dua kali pada objek lingkaran yang ada di
dalam Stage. Selanjutnya, ubah tebal garis tepi dan warna
objek pada Property Panel.

Gambar 6.15 Properti panel

. Buat objek lingkaran yang berukuran lebih kecil,
selanjutnya tempatkan di dalam objek lingkaran yang telah
digambar sebelumnya.

. Berikutnya pilih kedua objek lingkaran tersebut. Lalu,
lakukan klik kanan, pilih Copy. Selanjutnya, klik satu kali
di sembarang area Stage, lalu klik kanan, pilih Paste.
Pindahkan objek lingkaran hasil kopian ke sebelah kanan
objek lingkaran asli.

. Buat layer baru, caranya pilih Insert > Timeline > Layer.
Selanjutnya, ubah nama Layer 2 menjadi bodi bus dengan
cara melakukan klik dua kali pada nama Layer di Timeline,
ketikkan teks bodi bus, kemudian tekan Enter.

. Gambar bodi bus menggunakan Pen Tool yang ada dalam
Tool Box. Caranya, klik satu kali pada Pen Tool. Tentukan
titik awal gambar bodi bus, kemudian klik satu kali dalam
area Stage (menggunakan klik kiri). Berikutnya, klik kiri
pada titik kedua pada area Stage, untuk mengakhiri proses
penggambaran bodi Bus, tutup bangun bodi Bus ke titik
awal/pertama penggambaran tadi.

Gambar 6.16
Contoh gambar bus
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10. Klik dua kali pada bodi Bus menggunakan Selection Tool
yang ada dalam 700!/ Box. Kemudian, rubah warna dan
garis tepi menggunakan perangkat yang ada dalam
Property Panel.

Gambar 6.17 Merubah warna dan garis tepi

11. Rubah urutan layer yang ada di dalam 7imeline, caranya
drag dan drop layer roda bus, tempatkan di atas bodi bus.

12. Tampilan gambar dalam Stage tampak seperti gambar di
bawabh ini.

Gambar 6.18
Tampilan bus

13. Keluar dari tampilan simbol Bus untuk kembali ke tampilan
Scene 1, caranya klik teks Scene 1 yang ada di atas
Timeline.

14. Dalam tampilan Scene 1, ubah nama Layer 1 yang ada di
dalam 7imeline menjadi layer Bus, caranya klik dua kali
pada nama layer, kemudian ketikkan nama layer dengan

Gambar 6.19 nama “Bus”, lalu tekan Enter.
Tampilan Timeline

15. Drag (tarik) dan drop (jatuhkan) objek/simbol Bus yang

ada dalam panel Library ke dalam Stage.

Gambar 6.20
Tampilan Library
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16. Ukuran Bus akan terlihat memenuhi Stage, seperti tampak
pada gambar di bawah ini.

é )

Gambar 6.21
K j Tampilan ukuran bus

17. Rubah ukuran Bus yang ada dalam Stage, perkecil

ukurannya dengan cara klik kanan pada objek Bus lalu pilih

Free Transform. Atur ukuran Bus dengan cara menarik

titik-titik yang ada di tiap sudut objek Bus.
12.Membuat Objek Jalan Raya dan

Pemandangan
Berikut ini adalah langkah-langkah untuk membuat objek
jalan raya dan pemandangan sebagai latar belakang gambar :
1. Buat layer baru untuk membuat Jalan Raya, caranya pilih

Insert> Timeline> Layer.
2. Klik dua kali pada nama layer yang ada dalam Timeline,

kemudian ubah namanya menjadi Jalan Raya, lalu tekan

Enter.
3. Ubah susunan layer dalam Timeline, drag, dan drop layer

Bus, tempatkan di atas layer Jalan Raya.

Gambar 6.22 Tumpilan Timeline Gambar 6.23 Tumpilan Timeline Jalan Raya

4. Klik pada nama Layer Jalan Raya, berikutnya klik tombol
Line Tool, selanjutnya gambar garis jalan raya tepat di
bawah Bus, seperti tampak pada gambar di samping.
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Gambar 6.24 Tampilan Bus 6

Buat layer baru, kemudian beri nama Gedung. Caranya
pilih Insert > Timeline > Layer. Ubah nama layer menjadi
Gedung, lalu atur urutan layer supaya berada pada urutan
paling bawah.

. Gambar objek Gedung menggunakan Rectangle Tool yang

ada dalam 7oo! Box. Caranya, klik tombol Rectangle Tool,
kemudian gambar kotak-kotak hingga menyerupai gedung
di dalam Stage, seperti tampak pada gambar di samping.

Gambar 6.25 Layer Gedung Gambar 6.26 Objek Gedung

13. Membuat Animasi

1.
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Klik kanan pada frame ke-80 yang ada di dalam layer
Gedung, lalu pilih Insert Frame.

Gambar 6.27 Layer Gedung

Lakukan hal serupa untuk layer Jalan Raya dengan cara
klik kanan pada frame ke-80 pada layer Jalan Raya,
kemudian pilih Insert Frame.

Klik kanan frame-80 pada layer Bus, kemudian pilih /nsert
Keyframe.

Gambar 6.28 Insert keyfrema

Klik kiri frame 1 pada layer Bus. Geser posisi Bus menjadi
berada di sudut paling kanan (menggunakan cara drag and
drop dengan mouse, atau menggunakan tombol Arrow Key
kiri dan kanan yang ada dalam keyboard).




Gambar 6.29
Menggeser Posisi

5. Klikkiri frame 80 pada layer Bus. Geser posisi Bus menjadi
berada di sudut paling kiri (dengan cara drag and drop
dengan mouse atau menggunakan tombol Arrow Key kiri
dan kanan yang ada di dalam keyboard).

Gambar 6.30
Pergeseran posisi

6. Klik kiri frame 1 pada layer Bus. Selanjutnya, pada
Property Panel, dalam pilihan Tween pilihlah Motion.

Gambar 6.31
Properti Panel

7. Jalankan movie dengan cara pilih Control> Test Movie.
14. Membuat Tombol dan Action Script

1. Berikutnya buat layer baru, beri nama Stop. Dalam layer ini
nantinya akan diberi action script Stop supaya animasi akan
berhenti ketika animasi pertama kali dijalankan. Caranya
pilih Insert > Timeline >
Layer. Ubah nama layer
baru tersebut dengan
nama Stop.

Gambar 6.32
Action Script
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Gambar 6.33
Membuat layer baru

Gambar 6.34 Library

Gambar 6.35
Stage

Gambar 6.36
Action Script

Gambar 6.37 Timeline
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8.
9.

10.

Klik kanan pada frame 1 pada layer Stop, lalu pilih Actions.
Kemudian dalam panel Actions, ketikkan script Stop ();
seperti tampak pada gambar di samping ini.

Buat layer baru, kemudian beri nama Play.

Tampilkan Library Button, caranya pilih Window > Other
Panels > Commons Libraries > Buttons.

Expand semua folder yang tampil dengan cara klik kanan
pada salah satu menu tombol yang tampil dalam Library,
lalu pilih expand All Folders.

Klik kiri pada layer Play terlebih dahulu. Selanjutnya pilih
salah satu tombol, kemudian tarik dan masukkan ke dalam
Stage.

Klik kanan pada tombol Enfer yang ada dalam Stage,
kemudian pilih Actions. Kemudian, ketikkan kode seperti
tampak pada gambar di bawah ini.

Buat layer baru dan beri nama Pause.

Tarik dan masukkan salah satu tombol (button) yang ada di
dalam Panel Library ke dalam Stage dalam layer Pause.
Klik kanan pada tombol Pause yang ada dalam Stage
kemudian pilih Actions. Kemudian, ketikkan kode seperti
tampak pada gambar di bawah.




Gambar 6.38
Tampilan Bus

Gambar 6.39
Action Script

11. Jalankan animasi yang telah dibuat dengan cara, pilih
Control> Test Movie.

15. Mempublish Hasil Akhir

Berikut ini adalah langkah untuk membuat file SWF sebagai
hasil akhirnya:

Untuk mempublish hasil animasi Flash yang sudah dibuat,
caranya pilih File>Publish Settings.

Gambar 6.40
Publish Setting
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Tugas 2

Buatlah sebuah animasi dengan Flash, tema yang dibuat misalkan:

» Slide foto tentang Lingkungan hidup

» Global Warming

» danyanglainnya

Gabungkan animasi yang kamu buat dengan tulisan pada PowerPoint.

Mengubah Presentasi PowerPoint ke dalam
Macromedia Flash MX

Untuk mengubah PowerPoint ke dalam Macromedia Flash

MX dibutuhkan beberapa langkah antara lain:

» Buka Slide PowerPoint yang kamu telah buat.

» Klik File > Save As > pada Save as type pilih windows
metafile.

Gambar 6.41
Save As

Jika ditanya, apakah kamu menyimpan semua s/ide, maka

jawaban adalah setiap slide (every slide)

» Buka Macromedia Flash MX > File > Import > Import to
Stage> pilih slide .wmfyang akan diimport > Open.

» Setelah itu, kamu dapat mengedit sesuai dengan keinginan
kamu.

» Dalam mengubah PowerPoint ke dalam Macromedia Flash
terdapat beberapa kelemahan, antara lain kamu harus
menata ulang tampilan PowerPoint pada Flash sangat tidak
efisien kalau Slide yang akan diubah terlalu banyak
jumlahnya.

I TIK SMA Kelas XII




Tugas 3

Ubahlah PowerPoint yang telah kalian buat ke dalam Flash dengan
menggunakan langkah-langah di atas.

Memasukkan Animasi Flash Ke dalam
PowerPoint

Langkah-langkah yang diperlukan untuk memasukan animasi
Flashke dalam Power Point antara lain:

» Buka file PowerPointkalian.

» Klik menu View pada PowerPoint > Toolbars > Control
Toolbox.

» Pilih Shockwave Flash Object.
» Klik pada stage PowerPoint.
» Klik kanan > Properties.

Gambar 6.40
Pilihan Menu
Shokewave Flash Object

» Klik dua kali pada (Custom) maka akan muncul kotak
dialog properties pages.

» Isi Movie URL sesuai dengan lokasi file .swf yang kita
letakan, misalnya di e:\fla/home.swf.
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Adobe Flash, suatu program yang dibuat untuk membuat animasi dalam bentuk
2 dan 3 dimensi.
1. Beberapakelebihan Flash antara lain:

» Animasi dan gambar konsisten dan fleksibel, karena tetap terlihat bagus
padaukuran jendela dan resolusi layar berapapun pada monitor pengguna.

» Kualitas gambar terjaga. Hal ini disebabkan karena Flash menggunakan
teknologi Vector Graphics yang mendeskripsikan gambar memakai garis
dan kurva, sehingga ukurannya dapat diubah sesuai dengan kebutuhan
tanpa mengurangi atau mempengaruhi kualitas gambar. Berbeda dengan
gambar bitmap seperti bmp, jpg dan gif yang gambarnya akan pecah-
pecah ketika ukurannya dibesarkan atau diubah karena dibuat dari
kumpulan titik-titik.

» Waktu loading (kecepatan gambar atau animasi muncul atau loading time)
lebih cepat dibandingkan dengan pengolah animasi lainnya, seperti
animated gifs dan java applet.

» Mampu membuat website yang interaktif, karena pengguna (user) dapat
menggunakan keyboard atau mouse untuk berpindah ke bagian lain dari
halaman web atau movie, memindahkan objek, memasukkan informasi di
form.

» Mampu menganimasi grafis yang rumit dengan sangat cepat, sehingga
membuat animasi layar penuh bisa langsung disambungkan ke situs web.

» Mampu secara otomatis mengerjakan sejumlah frame antara awal dan
akhir sebuah urutan animasi, sehingga tidak membutuhkan waktu yang
lama untuk membuat berbagai animasi.

» Mudah diintegrasikan dengan program Macromedia yang lain, seperti
Dreamweaver, Fireworks, dan Authorware, karena tampilan dan tool
yang digunakan hampir sama.

» Dapat diintegrasikan dengan skrip sisi-server (server side scripting)
seperti CGI, ASP dan PHP untuk membuat aplikasi pangkalan data web.

» Lingkup pemanfaatan luas, dapat juga dipakai untuk membuat film
pendek atau kartun, presentasi, iklan atau web banner, animasi logo,
kontrol navigasi dan lain-lain.

2. Areakerja Flash terdiri dari lima area, yaitu: Menu, Toolbox, Timeline, Stage,
dan Panels.

3. Animasi adalah proses penciptaan efek gerak atau efek perubahan bentuk
yang terjadi selama beberapa waktu. Animasi bisa berupa gerak sebuah objek
dari tempat yang satu ke tempat yang lain, perubahaan warna, atau perubahan
bentuk (yang dinamakan “morphing”).

Animasi Flash dapat dilakukan dengan dua cara yaitu :

1. Frame by frame
2. Tweening
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Bermimpi untuk Menjadi Spielberg

Membuat animasi sekarang ini memang menjadi sebuah
pekerjaan yang tidak sulit, tergantung imajinasi dan kreativitas
apa yang ingin dikembangkan oleh penciptanya. Berbagai
program sekarang tersedia di pasaran yang memungkinkan siapa
saja, di mana saja, dan kapan saja mencipta berbagai animasi,
film, dan sejenisnya.

Ambil saja, misalnya, program perangkat lunak Macromedia
Flash (http://'www.macromedia.com/software/flash/). Macromedia
Flash menjadi kunci untuk mendesain dan menghasilkan animasi
yang dimungkinkan untuk bisa diakses pada jaringan Internet
berkecepatan rendah. Flash dirancang untuk memungkinkan
penggunanya untuk membuat script animasi maupun film.

Sudah ada yang memikirkan untuk membuat sebuah tandingan
membuat film legendaris Star Wars yang menjadi mahakarya
Steven Spielberg dan George Lucas. Film Star Wars "palsu"
dengan judul "The Empire Strikes Backyard" (lihat
http://www.backyardproductions.co.uk) merupakan sebuah karya
para pencipta Star Wars menggunakan teknologi komputer yang
tersedia sekarang ini.

Atau coba simak apa sebenarnya mimpi Steven Spielberg
(http://www. countingdown. com/theater/stevew). Sutradara
kondang ini bermimpi untuk memakan semua makanan, termasuk
memakan dirinya sendiri. Hasilnya, sebuah gabungan film,
animasi, dan cerita pendek yang berkualitas.

<Sumber: http://www2.kompas.com/kompas-cetak/0103/06/iptek/berm41.htm,
7 agustus 2008>
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1. Prosedur Penggunaan Komputer

Komputer tidak dapat dipergunakan dengan sekehendak hati kita sebagai
pengguna. Ada prosedur yang harus diikuti jika ingin menggunakannya. Dengan
memperhatikan prosedur yang benar, kondisi komputer dapat terjaga dan
keselamatan kerja penggunanya dapat terjamin. Beberapa hal yang perlu
diperhatikan sebagai prosedur dalam menggunakan komputer antara lain
perawatan komputer dan posisi tubuh pada saat menggunakan komputer.

A.Perawatan Komputer

Sebagai seorang pengguna komputer, tentunya kita ingin agar komputer kita
bisa terawat dengan baik dan tidak cepat rusak. Hal-hal yang perlu diperhatikan
sehubungan dengan penggunaan komputer agar lebih aman dan tetap awet
adalah sebagai berikut:

»Hindari terkena air pada peralatan
komputer.

» Gunakan stabilizer maupun UPS untuk
mencegah tegangan listrik yang sering
mati dan tidak stabil.

» Bersihkan dari debu.

» Tempatkan komputer di tempat yang
sejuk, tidak terkena panas dan hujan.

»Lengkapi komputer dengan penangkal
petir untuk daerah rawan petir, terutama
jaringan komputer yang terhubung
menara yang tidak dilengkapi
penangkal petir

» Gunakan anti virus yang tepat demi keamanan data serta sistem komputer dan
jangan memakai anti virus lebih dari satu.

»Manajemen folder dan file dengan baik dan buang file-file yang tidak
diperlukan (file sampah).

»Jauhkan dari medan magnetik karena bisa mengganggu performa CPU dan
monitor.

»Usahakan lantai dilengkapi dengan karpet atau alas untuk menghindari
sengatan listrik jika terjadi kebocoran listrik.
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B. Perawatan Pengguna

Sebelum menggunakan komputer, kita
harus memperhatikan posisi tubuh yang
baik supaya dapat menjaga kesehatan dan
keselamatan kerja selama menggunakan
komputer. Penggunaan komputer yang
tidak sesuai dapat menyebabkan nyeri
kepala, nyeri otot, dan tulang (terutama
bahu, pergelangan tangan, Icher,
punggung, dan pinggang bagian bawah).
Selain itu, pengguna komputer juga
masih dapat terserang penyakit lain
seperti kesemutan, badan bengkak,
anggota badan kaku, sakit ginjal, mata
merah,berair, nyeri, dan bahkan ganguan

penglihatan.

Posisi tubuh yang baik saat menggunakan komputer adalah sebagai berikut:
»Hindari menggunakan komputer dengan bersila, terutama jika akan
menggunakan komputer dalam jangka waktu yang lama karena hal itu dapat
menyebabkan terganggunya kesehatan.

»Sebaiknya gunakan komputer sebagaimana umumnyam yaitu komputer
diletakkan di atas meja dan kita duduk menggunakan kursi yang nyaman.
»Sebaiknya kaki menempel di tanah, tidak menggantung. Usahakan lantai
dilapisi karpet atau alas.

» Usahakan tangan sebelah kanan dapat menjangkau mouse dengan mudah dan
pergelangan kedua tangan terangkat dengan nyaman pada saat mengetik

»Jika sudah merasa lelah, tangan diistirahatkan sampai kita siap mengetik
kembali.

» Tempatkan siku sedikit di bawah keyboard agar lebih leluasa pada saat
mengetik.

» Duduklah pada kursi yang ada sandarannya.

» Posisi punggung usahakan tidak membungkuk.

» Usahakan jarak pandang mata dengan monitor tidak kurang dari 50 cm.

» Istirahatlah sejenak apabila mata kita terasa lelah.

N /
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2. Prosedur Keamanan Data

Seperti halnya di dunia nyata, internet sebagai dunia maya juga banyak
mengundang tangan-tangan kriminal, baik untuk mencari keuntungan materi
maupun sekedar untuk melampiaskan keisengan. Hal ini memunculkan
fenomena khas yang sering disebut cybercrime (kejahatan di dunia cyber).

Dalam lingkup cybercrime, kita sering menemui istilah hacker dan cracker.
Istilah hacker biasanya mengacu pada seseorang yang punya minat besar untuk
mempelajari sistem komputer secara detail dan bagaimana meningkatkan
kapabilitasnya. Adapun mereka yang sering melakukan aksi-aksi perusakan di
internet disebut sebagai cracker. Beberapa metode atau cara yang digunakan para
hacker dan cracker untuk menyusup ke sebuah jaringan komputer antara lain
sebagai berikut:

a.Spoofing

Spoofing merupakan sebuah bentuk kegiatan pemalsuan, dimana seorang hacker
memalsukan identitas seorang user hingga dia berhasil secara ilegal logon atau
login ke dalam satu jaringan komputer (seolah-olah seperti user yang asli).

b. Sniffer

Sniffer adalah kata lain dari network analyzer yang berfungsi sebagai alat untuk
memonitoring jaringan komputer. Alat ini dapat dioperasikan hampir pada
seluruh tipe protokol, seperti ethernet, TCP/IP, dan lain-lain.

c. Password Cracker

Password cracker adalah sebuah program yang dapat membuka enkripsi sebuah
password, bahkan bisa digunakan untuk mematikan sistem pengamanan
password.

d. Destructive Devices
Destructive devices merupakan sekumpulan program virus yang dibuat khusus
untuk melakukan penghancuran data-data.

e. Scanner

Scanner adalah sebuah program yang secara otomatis akan mendeteksi
kelemahan sebuah komputer di jaringan lokal atau di jaringan lain. Dengan
menggunakan program ini, seorang hacker yang berada di Indonesia dapat

- /
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Untuk menjaga keamanan data di jaringan komputer pada saat data tersebut
dikirim maupun disimpan, maka dikembangkan beberapa teknik keamanan data.
Teknik keamanan data tersebut antara lain.

a.SSL

Browser di lengkapi dengan secure socket layer yang berfungsi untuk
menyandikan data, sehingga komputer-komputer yang berada diantara pengirim
dan penerima tidak dapat membaca isi data. Hal ini dilakukan karena jalur
pengiriman data melalui internet melalui banyak transisi dan dikuasai banyak
orang sehingga pengiriman data melalui internet rawan oleh penyadapan. Oleh
karena itu, perlu dibuat pengamanan secure socket layer (SSL).

b. Internet Firewall
Internet firewall berfungsi untuk mencegah akses dari pihak luar ke sistem
internal.

Dengan demikian, data-data yang berada di dalam jaringan komputer tidak dapat
diakses oleh pihak luar yang tidak bertanggung jawab. Jaringan komputer yang
terhubung ke internet, perlu dilengkapi dengan internet firewall.

Firewall bekerja dengan dua cara, yaitu dengan menggunakan filter dan proxy.
Firewall yang bekerja dengan menggunakan filter, mampu menyaring
komunikasi yang seperlunya saja.

Hanya aplikasi dan identitas tertentu saja yang bisa berhubungan. Sedangkan
firewall yang bekerja dengan menggunakan proxy akan mengijinkan pemakai
dari dalam untuk mengakses internet seluasnya, sedangkan pemakai dari luar
hanya bisa mengakses komputer tertentu saja.

c. Kriptografi

Kriptografi merupakan seni membuat sandi data. Sebelum dikirim ke internet,
data-data yang akan dikirim disandikan terlebih dahulu. Di komputer tujuan,
data tersebut dikembalikan ke bentuk aslinya sehingga bisa dimengerti dan
dibaca oleh penerima. Data yang disandikan dimaksudkan agar pihak-pihak
yang menyadap pengiriman data, tidak mengerti isi data yang dikirim karena
berbentuk kata sandi. Dengan demikian keamanan data dapat dijaga.

Ada dua proses yang terjadi dalam kriptografi, yaitu proses enkripsi dan dekripsi.

Proses enkripsi adalah proses mengubah data asli menjadi data sandi, sedangkan
proses dekripsi adalah proses mengembalikan data sandi menjadi data asli.

- /
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A. Pengecekan Konsep

Pilihlah salah satu jawaban yang paling benar!
@ Nama Perusahaan Piranti Lunak @ Teknologi

pembuat program Flash adalah ....

a. Adobe d. Macromedia
b. Microsoft e. Nullsoft
c.Apple

Di bawah ini nama program-program
yang dibuat untuk membantu
pekerjaan manusia dalam mendesain
animasi, adalah ....

a. Winamp d. Dreamweaver
b. Winzip e. Paint
c. Flash

Di bawah ini nama program-program
yang dibuat untuk membantu
pekerjaan manusia dalam mendesain,
kecuali....

a. Camtasia d. Dreamweaver

b. Swish e. Firework

c. Flash

Teknologi  yang mendeskripsikan

gambar memakai garis dan kurva,
sehingga ukurannya dapat diubah
sesuai dengan kebutuhan tanpa
mengurangi atau mempengaruhi

kualitas gambar yaitu.....
a. Morphing d. Bitmap
b.Jpeg e. Vector

c. Vector Graphics

Istilah untuk proses penciptaan efek
gerak atau efek perubahan bentuk yang

terjadi  selama  beberapa waktu,
adalah ...

a.Animasi d. Video

b. Morphing e. Render

c. Efek

yang digunakan untuk
membuat grafik, dari kumpulan titik-

titik yaitu.....
a. Morphing d. Bitmap
b. Raster e. Vector

c. Vector Graphics

Tempat membuat dan mengontrol
objek dan animasi disebut dengan ...

a. TaskPane d. Plot
b. Toolbar e. Keyframe
c. Timeline

Bentuk dasar dari animasi adalah.....
a. Video

b. Gambar

c. Timeline

d. Animasi frame per frame

e. Tweening

©® Motion Tweening disebut juga

dengan....

a. Video

b. Animasi Gambar

c. Animasi gerak

d. Animasi frame per frame
e. Animasi Diam

Koleksi dalam Flash yang digunakan
untuk membuat atau atau
menggambar, memilih dan
memanipulasi isi stage dan timeline,
disebut....

a. TaskPane d. Plot
b. Toolbar e. Keyframe
c. Timeline



B. Pemahaman Konsep

Jawablah pertanyaan di bawah ini.

@ Sebutkan bagian-bagian dari foolbox pada program Flash.

@ Secbutkan dua kelebihan dari program Flash.

@ Tuliskan langkah-langkah untuk menambah keyfiame pada timeline.
@ Tuliskan langkah-langkah untuk membuat Motion Tween.

@ Tuliskan langkah-langkah membuat animasi frame per frame.

C. Aktifitas Siswa

Menurun:

1. Bahasa Inggris dari Film adalah ....

3. Salah satu cara pembuatan animasi dalam Flash ....
5. Salah satu area kerja Flas ....

Mendatar:
2. Salah satu teknologi memprosesan gambar adalah ....
4. Bahasa Inggris dari memutar adalah ....
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A. Pengecekan Konsep
Pilihlah salah satu jawaban yang paling benar!

@ Membuat presentasi dengan @ Untuk menghubungkan kata/kalimat

menggunakan langkah demi langkah
disebutdengan ....

a. Mailmerge

b. Open and Exciting

c. Blank Presentation

d. Auto Content Wizard

e. Design Template

Di bawah ini adalah submenu dari
menu File, kecuali....

a. New d. Print
b. Open e.Save
c.Cut

Untuk menyimpan file digunakan
icon...

a. Save d. Close
b. Open e. Print
c. New

Di bawah ini adalah submenu dari
menu Edit, kecuali....

a. Duplicate d. Clear

b. Slide Show e. Replace

c. Copy

Di bawah ini adalah submenu dari
menu View dalam PowerPoint,
kecuali....

a. Duplicate Slide d. Notes Pages

b. Slide Sorter e. Task Pane

c. Normal

Di bawah ini adalah contoh program
pembuat presentasi, kecuali....

a. Ms. Power Point

b. Macromedia Action 3D

c. Autowerestar

d. Macromedia Flash

e. Corel Draw

pada slide yang kita buat dengan suatu
file yang pernah dibuat sebelumnya
dapat menggunakan fasilitas....

a. Packing/Publishing

b. Web Page

c. Slide Show

d. Navigasi

e. Hyperlink

Untuk memberi efek keterampilan
teks, pada saat slide ditampilkan dapat
dilakukan....

a. Slide show-Custom Animation

b. Slide show-Set up Show

c.Slide show - Animation Schemes

d. View—Slide— Sorter

e. Slide show-View show

Untuk membuat sebuah presentasi,
kalian bisa melakukannya melalui
Blank Presentasi, Design Template,
Auto Contect Wizard. Blank
Presentasi, Design Template, Auto
Content Wizard berada di dalam....

a. Menu Bar

b. Header and Footer

c. Task Pane

d. Slide Master

e. Toolbar

Perpindahan slide yang satu dengan
slide yang lain serta waktu
perpindahan disebut....

a. Mailmerge d. Transisi

b. Hyperlink e. Interval

c. Embeded

Presentasi yang dicetak ke printer
disebut...

a. Soft Hand d. Hand Out



b. Jack Out
c. Cetakan

e.Ear Out

Waktu tayang slide dalam presentasi
dapat diatur dengan fasilitas. ..

a. Mailmerge d. Transisi

b. Hyperlink e. Interval

c. Embeded

Untuk menampilkan slide ada dua
cara, yaitu otomatis dan manual.

Bila akan mengatur, maka anda klik
padaview pilih...

a. Slide show

b. Zoom

c. Master

d. Header and Footer

e. Ruler

Pada toolbar Formating, ikon Font
Size digunakanuntuk...

a.pilihan jenis font

b. ratabawabh atas teks

c. pilihan ukuran font

d. ratatengah obyek teks

e. huruftebal

Nama Perusahaan Piranti Lunak
pembuat program Flash adalah ...

a.Adobe d. Macromedia
b. Microsoft e. Nullsoft
c.Apple

Di bawah ini nama program-program
yang dibuat untuk membantu
pekerjaan manusia dalam mendesain
animasi, adalah ...

a. Winamp d. Dreamweaver
b. Winzip e. Paint
c. Flash

Di bawah ini nama program-program
yang dibuat untuk membantu
pekerjaan manusia dalam mendesain,
kecuali...

a. Camtasia d. Dreamweaver
b. Swish e. Firework
c.Flash

18] Teknologi

yang mendeskripsikan
gambar memakai garis dan kurva,
sehingga ukurannya dapat diubah
sesuai dengan kebutuhan tanpa
mengurangi atau mempengaruhi

kualitas gambar yaitu ...
a. Morphing d. Bitmap
b.Jpeg e. Vector

c. Vector Graphics

Teknologi  yang digunakan untuk
membuat grafik, dari kumpulan titik-

titik yaitu ...
a. Morphing d. Bitmap
b. Raster e. Vector

c. Vector Graphics

Istilah untuk proses penciptaan efek
gerak atau efek perubahan bentuk
yang terjadi selama beberapa waktu,

adalah ...

a.Animasi d. Morphing
b. Render e. Video

c. Efek

Tempat membuat dan mengontrol
objek dan animasi disebut dengan ...

a. TaskPane d. Plot
b. Toolbar e. Keyframe
c. Timeline

Bentuk dasar dari animasi adalah ...
a. Video

b. Gambar

c. Timeline

d. Animasi frame per frame

e. Tweening

& Motion Tweening disebutjuga dengan

a. Video

b. Animasi Gambar

c. Animasi gerak

d. Animasi frame per frame
E. Animasi Diam




@ Koleksi dalam Flash yang digunakan @ Berikut ini adalah contoh-contoh

untuk membuat atau atau presentasi, kecuali....
menggambar, memilih dan a.Pembacaberitadi TV
memanipulasi isi stage dan timeline, b. Dosen yang mengajar

disebut ... c.Tenaga penjual yang sedang
a. TaskPane d. Plot menawarkan produk

b. Toolbar e. Keyframe d. Orang yang sedang mengaktifkan
c. Timeline ponsel

e. Orang yang membaca koran

B. Pemahaman Konsep

Jawablah pertanyaan di bawah ini.

Sebutkan dan jelaskan 3 (tiga) submenu file yang terdapat dalam program Ms.
PowerPoint!

Sebutkan bagian-bagian dari tool box pada program Flash!
Sebutkan dua kelebihan dari program Flash!

Tuliskan langkah-langkah untuk menambah keyframe pada timeline!
Tuliskan langkah-langkah untuk membuat Motion Tveen!

Tuliskan langkah-langkah membuat animasi frame per frame!

Jelaskan kegunaan fasilitas-fasilitas dibawah ini !
a. Diagram b. Grafik c. Presentasi

Jelaskan kegunaan fasilitas-fasilitas dibawah ini !
a. Stagee b. Timeline

Jelaskan istilah di bawah ini !
a. Action Script b. Animasi
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Sebutkan langkah-langkah membuat proyek baru dalam Flash!




G losarium

Account: Data tentang seseorang atau
objek yang menyimpan berbagai
informasi tentang seseorang atau objek
yang dimaksud.

Action Script: Kode-kode program dalam
Flash digunakan untuk mengontrol
jalannya suatu animasi agar animasi
yang dibuat menjadi lebih atraktif dan
menarik.

Ambigous: Arti dari kata yang tidak
mutlak atau tepat.

Animasi: Hasil dari pengolahan gambar
tangan sehingga menjadi gambar yang
bergerak

Annotation: Tool yang dapat digunakan
untuk memberi komentar berupa note
maupun suara.

Attachment Fasilitas dari e-mail
untuk melampirkan file dengan
berbagai format.

Autofill: Istilah yang digunakan untuk
mengisi baris dengan secara otomatis.

Backup: Cadangan dari suatu file atau
database.

Bitmap: Gambar yang berbasiskan piksel,
merupakan format gambar pada
umumnya.

Block: Istilah yang digunakan untuk
memilih data.Bentuk Vektor: Suatu
bentuk yang terbuat dari titik-titik yang
disebut titik Anchor dan dihubungkan
dengan segmen-segmen.

Canvas: Bidang kerja kita, halaman kerja
tempat kita menggambar.

Clipping Path: Bagian dari Layer Vektor
yang menampilkan bentuk Vektor yang
kita buat.

Desain grafis: Bentuk komunikasi visual
dengan menggunakan gambar untuk
menyampaikan pesan atau informasi
dengan efektif

Diagram: Sebuah objek untuk
manampilkan (biasanya) sebuah
struktur organisasi, garis komando

tugas, dan alur proses kerja.

Elegan: Berpenampilan menarik dan enak
dipandang dan sederhana.

Ergonomis: Ilmu terapan yang
menjelaskan interaksi antara manusia
dengan tempat kerjanya.

Fill Pixel: Sifat dari Vektor yang akan
membuat bentuk Vektor pada layer
yang sedang aktif, tidak membuat layer
baru.

Foreground: Bagian depan dari gambar.

Frame: Suatu istilah yang digunakan
untuk membuat adegan objek pada
Flash

Gambar: Sebuah objek yang digunakan
untuk menampilkan efek visual

Gambar 3D: Bentuk dari objek yang
memiliki panjang, lebar, dan tinggi

Gardient: Tingkatan, pada Photoshop
biasa digunakan untuk tingkat
ketebalan warna.

Grafik: Sebuah objek yang berupa model
tampilan visual untuk menampilkan
data angka dalam bentuk garis batang
(bar) atau lingkaran (pie)

Grouping: Pengelompokan objek yang
berbeda sehingga menjad suatu
kesatuan yang utuh.

Ikon: Secbuah gambar kecil yang
diciptakan agar memudahkan manusia
mengakses perintah-perintah yang ada
pada sebuah software

Install: Memasang perangkat lunak pada
komputer

Layer: Seperti lapisan yang masing-
masing lapisan dapat kita gambar
sesuka kita.

Menu: Suatu objek yang di dalamnya
merupakan perintah-perintah yang
dapat digunakan untuk mempermudah
penyelesaian suatu pekerjaan dengan
menggunakan piranti lunak.

Mode Blend: Mode yang digunakan untuk
mencampurkan warna Layer pada

(e,




Layer atau gambar di bawahnya.
Objek: Suatu masukkan yang digunakan
untuk menambah fungsionalitas dari
program yang dibuat
Opacity: Bagian untuk kita mengatur
seberapa transparan sebuah layer.
Orgonomis:
Palette: Panel-panel pada Photoshop yang
digunakan untuk memonitor atau

memodifikasi gambar.

Path: Jalur atau gambaran kasar dari
sebuah gambar.

Pixel: Suatu ukuran, biasa untuk

mengukur gambar dan tampilan pada
monitor.

Portait: Posisi kertas yang tegak atau
vertical

Poster: Desain grafis yang memuat
gambar dan huruf pada kertas
berukuran besar yang digunakan untuk
mencari perhatian atau memberi
pengumuman.

Presentasi: adalah suatu kegiatan
berbicara di hadapan banyak hadirin.
Berbeda dengan pidato yang lebih
sering dibawakan dalam acara resmi
dan acara politik, presentasi lebih sering
dibawakan dalam acara bisnis. Tujuan
dari presentasi bermacam-macam,
misalnya untuk membujuk (biasanya
dibawakan oleh wiraniaga), untuk
memberi informasi (biasanya oleh
seorang pakar), atau untuk meyakinkan
(biasanya dibawakan oleh seseorang
yang ingin membantah pendapat
tertentu).

Property: Hal yang dimiliki oleh suatu
objek dan menjadi identitas dari objek
tersebut. Properti satu objek dengan
objek lain dapat mempunyai nilai yang
berbeda.

Rasterize: Perintah yang digunakan
mengubah Layer Vektor menjadi Layer
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biasa.

Resolusi: Kualitas suatu gambar dilihat
dari detail gambar.

Stage: Area persegi empat yang
merupakan tempat membuat objek atau
animasi yang akan dimainkan.

Table: Tabel

Task Pane: Panel perintah yang
dibutuhkan untuk tugas tertentu

Timeline:  Tempat membuat dan
mengontrol objek dan animasi.

Tool: Piranti atau perangkat yang dapat
melakukan suatu fungsi.

Vektor: Suatu objek yang didefinisikan
dengan besaran dan arah.
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Powerpoint
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Sharpen Tool
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Slice Selection Tool
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T
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unci Jawaban

Bab 1 (nomor ganjil)
Pengecekan Konsep
l.c 3.a 5.b 7.b 9.b
Pemahaman Konsep
1. Duamacam format citra, yaitu :
a. Format vektor
Citra yang dimodelkan dengan format vektor
dihasilkan menggunakan deskripsi matematis
untuk menentukan posisi, lebar dan arah
bagaimana sebuah garis digambarkan. citra
dengan format vektor, objek dibentuk dari
kumpulan garis.
b. Format bitmap
Citra dengan format bitmap dibentuk dari
kumpulan titik berwarna yang pada akhirnya
membentuk suatu gambar.

3. Bagian-bagian dari jendela CorelDRAW:

1. Title bar 6. Color pallete

2. Menu bar 7. Document navigator
3. Toolbar 8. Docker

4. Toolbox 9. Status bar

5. Propertybar  10.Ruller

5.Cara membuat objek berada di belakang objek
yang lain:
Klik kanan pada objek yang akan diletakan
dibelakang objek yang lain, pilih order, kemudian
pilih behind. Setelah itu, pointer akan berubah
bentuk menjadi tanda panah, lalu klik pada objek
lain yang akan diletakkan lebih ke depan.

7.Fungsi tombol Ctrl dalam pembuatan sebuah
objek digunakan untuk membuat bentuk
sempurna pada sebuah objek. Jika kita tidak
menekan tombol Ctrl, dimungkinkan bahwa kita
akan membuat bentuk persegi panjang atau
ellipse, sedangkan dengan menekan tombol Ctrl,
kita akan menghasilkan bentuk dengan sisi yang
sama. Contoh penggunaan tombol Ctrl adalah
dalam pembuatan objek persegi atau lingkaran.

9.Propertise bar merupakan bagian dalam jendela
Core]DRAW yang memuat attribut dari suatu
objek sehingga kita dapat menggati nilai attribut
tersebut dengan mudah. Yang dimaksud dengan
attribut adalah sifat-sifat yang melekat dan
menjadi ciri suatu objek. Contohnya objek persegi
mempunyai attribut warna garis, panjang, lebar,
ketebalan garis, dan lain-lain.

Bab 2 (nomor ganjil):

Pengecekan Konsep

l.c 3.b S5.a 7.c 9.a

Pemahaman Konsep

1. Fungsi break curve appart digunakan untuk
memecah sebuah objek bertipe kurva menjadi
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bagian-bagian yang terpisah.

3. Untuk memasukkan gambar dalam format bimap,
kita harus melakukan import. Caranya: klik file,
kemudian pilih import. Setelah muncul kotak
dialog, pilih file yang akan dimasukkan ke dalam
lembar kerja. Langkah terakhir, tekan import.

5. Perbedaan eraser tool dan knife tool adalah
Eraser tool digunakan untuk menghapus bagian
dalam sebuah objek sehingga ada bagian yang
hilang dalam objek tersebut. Sendangkan knife
tool digunakan untuk memotong sebuah objek
sehingga tidak ada bagian yang hilang dalam
sebuah objek yang dipotong.
7.Empat macam jenis penggunaan artistic media
tool:

1. Preset: digunakan untuk membuat bentuk
artistic yang acak sesuai dengan jalur yang
dibuat dan bentuk yang dipilih dalam preset
stroke list.

2. Brush: menghasilkan gambar berwarna sesuai
dengan tipe yang telah dipilih pada brush stroke
list dan jalur yang dibuat.

3. Calligraphic: digunakan untuk membuat
gambar atau garis seperti pada saat kita menulis
menggunakan kuas untuk membuat tulisan
kaligrafi.

4. Pressure: hampir mirip seperti calligraphic,
tetapi pada jenis ini kita menghasilkan tulisan
menggunakan pulpen atau pensil.

9. Keterangan dari bagian yang ditunjuk:

a. font list: digunakan untuk mengubah tipe huruf
padasebuah teks

b. font size: digunakan untuk mengatur ukuran
hurufpada sebuah teks

c. bold: digunakan untuk mempertebal teks

d. italic: digunakan untuk membuat teks menjadi
miring

e. underline: digunakan untuk menggarisbawahi
sebuah teks.

Bab 3 (nomor ganjil)

Pengecekan Konsep

1.d 3.b 5.¢c 7.d 9.b

Pemahaman Konsep

1.Bagian dari Photoshop yang berisi menu-menu
atau perintah-perintah yang disediakan Photoshop
untuk menyimpan, memanipulasi gambar, dan
lain-lain. Pada Photoshop 7, Menu Bar terdiri dari
Menu, Edit, Image, Layer, Select, Filter, View,
Window, dan Help.

3. Blur Tool adalah Tool yang digunakan untuk
mengaburkan sisi gambar yang tajam.
Submenunya adalah Sharpen Tool dan Smudge
Tool. Sharpen Tool adalah Tool yang digunakan



untuk menegaskan atau menajamkan sisi gambar
yang kabur, sedangkan Smudge Tool adalah Tool
yang digunakan untuk meratakan atau
mengaburkan bagian gambar tertentu.

yang digunakan untuk meratakan atau mengaburkan
bagian gambar tertentu.

5. Melalui Layer Palette dan melalui pilihan Layer
padamenu bar.

7. Tidak sama, Opacity digunakan untuk mengatur
tingkat transparansi (tingkat tembus pandang),
semakin sedikit Opacity maka Layer akan
semakin transparan (tembus pandang). Sedangkan
Fill digunakan untuk mengatur banyaknya pixels
pada sebuah Layer, semakin rendah Fill maka
akan semakin sedikit.

9.Transform Selection digunakan untuk menjadikan
teks tersebut menjadi suatu objek, sehingga dapat
diperbesar atau diperkecil.

Bab 4 (nomor ganjil)
Pengecekan Konsep

1.b 3.c 5.d 7.b 9.d

Pemahaman Konsep

1.Lasso Tool, Polygon Lasso Tool dan Magnetic
Lasso Tool. Lasso Tool untuk membuat seleksi
dengan bebas, tetapi untuk menggunakan tool ini
membutuhkan ketelitian serta keterampilan
tangan yang baik dalam menggerakkan mouse.
Polygon Lasso Tool digunakan untuk membuat
seleksi dengan berbentuk lurus. Sedangkan, untuk
kasus seperti ini, kalian juga dapat menggunakan
Magnetic Lasso Tool, yaitu menyeleksi
berdasarkan perbedaan pixel.

3.Untuk mengatur tingkat pencahayaan pada
gambar, schingga kita dapat membuat menjadi
semakin kontras atau bahkan sebaliknya.

5. Bentuk Vektor adalah suatu bentuk yang terbuat
dari titik-titik yang disebut titik Anchor dan
dihubungkan dengan segmen-segmen. Ada dua
macam bentuk Vektor, yaitu bentuk Vektor
Geometris dan bentuk Vektor Khusus. Bahkan kita
dapat membuat bentuk vektor sendiri
menggunakan Pen Tool.

7.Supaya dapat kita perlakukan seperti Layer pada
umumnya.

9.Jika Color Dodge menambahkan terang warna
dasar untuk merefleksikan warna blend dengan
mengurangi kontras, sedangkan Linear Dodge
dengan meningkatkan brightness.

Permainan :

3. Lasso Tool
9. Paths

1. Pencil
7.Level

5. Crop Tool

Semester Ganjil

Pengecekan Konsep

1.d 3.c 5.¢c 7.d 9.b
Pemahaman Konsep

1. Cara pertama untuk menjalankan program

Core]DRAW adalah
klik start, program file, kemudian pilih
Core]DRAW 12
cara kedua yaitu dengan mengklik shortcut
Core]DRAW12 yang terletak di desktop
3. (pilih 4 saja) frechand tool, bezier tool, artistic
media tool, polyline tool, pen tool,interactive
connector tool, dimension tool, 3 point curve tool
5. Bagian-bagian yang ditunjuk yaitu

a: Menu bar d: propertise bar
b: Document Navigator e: toolbar
c: toolbox

7.Horizontal Type Tool, digunakan untuk menulis
dengan orientasi horisontal
- Vertical Type Tool, digunakan untuk menulis
dengan orientasi vertikal
- Horizontal Type Mask Tool, digunakan untuk
membuat seleksi dari tulisan dengan orientasi
horisontal
- Vertical Type Mask Tool, digunakan untuk
membuat seleksi dari tulisan dengan orientasi
vertikal
9. Kita dapat melakukan modifikasi kuas yang kita
gunakan untuk brush. Modifikasi tersebut
diantaranya adalah modifikasi Texture, Scattering,
Dual Brush, Smoothing, dan masih banyak lagi.

Uji Kompetensi Semester Ganjil (nomor ganjil)

Pengecekan Konsep

1d

3¢

S5.c

7.d

9.b

Pemahaman Konsep

1. Cara pertama untuk menjalankan program
Core]DRAW adalah
klik start, program file, kemudian pilih
Core]DRAW 12
cara kedua yaitu dengan mengklik shortcut
Core]DRAW12 yang terletak di desktop

3. (pilih 4 saja) freehand tool, bezier tool, artistic
media tool, polyline tool, pen tool,interactive
connector tool, dimension tool, 3 point curve tool

5. Bagian-bagian yang ditunjuk yaitu
a: Menu bar

b: Document Navigator

c: toolbox

d: propertise bar

e: toolbar

7. Horizontal Type Tool, digunakan untuk menulis
dengan orientasi horisontal

- Vertical Type Tool, digunakan untuk menulis
dengan orientasi vertikal

- Horizontal Type Mask Tool, digunakan untuk

membuat seleksi dari tulisan dengan orientasi




horisontal

- Vertical Type Mask Tool, digunakan untuk
membuat seleksi dari tulisan dengan orientasi
vertikal

9. Kita dapat melakukan modifikasi kuas yang kita
gunakan untuk brush. Modifikasi tersebut
diantaranya adalah modifikasi Texture,
Scattering, Dual Brush, Smoothing, dan masih
banyak lagi.

Bab5 (nomor ganjil)

Pengecekan Konsep

1.d 3.d 5.a 7.a 9.b
1l.a 13.a 15.b 17.¢ 19.d
2l.a 23.¢c 25.E

Pemahaman Konsep

1. Untuk memasukkan suara dalam presentasi,
gunakan perintah sebagai berikut:

1. Pilih menu: Insert -> Object. Kemudian pada
bagian object type pilih Wavesound kemudian
klik OK., sehngga akan tampil kotak dialog
Sound Object.

2. Pilih menu: Edit -> Insert File, pilih direktori
serta nama objek musik yang akan kamu
masukkan ( file yang dimasukkan harus
berekstensi.wav).

3. Klik tombol Open

4. Untuk mendengarkan suara klik tombol Play

5.Jika kalian sudah selesai dari objek suara ini,
pilih menu File -> Exit and Return to
Presentation.

6.Untuk mengetahui apakah suara tersebut
berhasil masuk ke dalam presentasi kamu,
perhatian icon suara kecil yang terdapat pada
presentasi yang kamu buat.

3. Animation trigger adalah suatu fitur di dalam
Microsoft PowerPoint yang memungkinkan satu
atau lebih animasi dilakukan saat dilakukan klik
terhadap suatu objek tertentu (yang menjadi
trigger-nya).

5. Hal-hal yang harus diperhatikan dalam membuat
presentasi
» Penentuan Tema dan Tujuan secara Spesifik
» Penyusunan kerangka materi presentasi yang

baik

Core]DRAW 12 yang terletak di desktop

3. (pilih 4 saja) freehand tool, bezier tool, artistic
media tool, polyline tool, pen tool,interactive
connector tool, dimension tool, 3 point curve
tool

5. Bagian-bagian yang ditunjuk yaitu

a: Menu bar d: propertise bar
b: Document Navigator e: toolbar
c: toolbox

7.Horizontal Type Tool, digunakan untuk menulis
dengan orientasi horisontal
- Vertical Type Tool, digunakan untuk menulis

I TIK SMA Kelas XIl

dengan orientasi vertikal
- Horizontal Type Mask Tool, digunakan untuk
membuat seleksi dari tulisan dengan orientasi
horisontal
- Vertical Type Mask Tool, digunakan untuk
membuat seleksi dari tulisan dengan orientasi
vertikal
9. Kita dapat melakukan modifikasi kuas yang kita
gunakan untuk brush. Modifikasi tersebut
diantaranya adalah modifikasi Texture,
Scattering, Dual Brush, Smoothing, dan masih
banyak lagi.

Bab 6 (nomor ganjil)

Pengecekan Konsep

l.a 3.a S5.a 7.c 9.c
Pemahaman Konsep

1. Tools, View, Colors, dan Options

3. Untuk menambah keyframe pada timeline, sorot
frame dan kemudian lakukan satu dari beberapa
caraberikutini:
* Klik kanan dan pilih Insert Keyframe.
* Pilih Insert | Keyframe dari menu.
* Tekan F6 pada keyboard.

5. Di bawah ini akan ditunjukkan proses

pembuatan animasi frame per frame :

1. Sorot frame dimana Kamu akan memulai
animasi frame per frame.

2. Jika belum berupa sebuah keyframe, buatlah
menjadi keyframe dengan cara memilih
menu Insert | Keyframe (F6).

3. Gambarlah atau impor gambar pertama
Kamu dari urutan gambar pada keyframe ini.

4. Kemudian klik frame selanjutnya dan
buatlah menjadi keyframe yang lain.
Rubahlah isi dari keyframe ini dengan
gambar berikutnya.

5. Lakukan penambahan keyframe dan
perubahan isinya sampai Kamu memperoleh
animasi yang utuh. Pada akhirnya teslah
animasi Kamu dengan kembali ke frame
pertama dan kemudian pilih menu Control |
Play.

Teka-Teki Silang
1. movie
Timeline

2.Frame 3

Uji Kompetensi Semester Genap

Pengecekan Konsep

1.d 3.a S5.a 7.e 9.c

11.d 13.¢c 15.a 17.a 19.d

21.c 23.¢c 25.d

Pemahaman Konsep

1.>»New : Perintah yang digunakan

untuk membuat file baru

»Open Perintah



»Close

> Save

»SaveAs

yang digunakan untuk
membuka file yang pernah
dibuka sebelumnya
Perintah
yang digunakan untuk
menutup file yang sekarang
dibuka

: Perintah yang digunakan

untuk menyimpan file

: Perintah yang digunakan

»>File Search

> Permission

untuk menyimpan file yang
berbeda
Dalam format yang berbeda

: Perintah yang digunakan
untuk menyimpan file
dalam bentuk web

: Perintah yang digunakan
untuk mencari file yang
pernah disimpan

: Perintah yang digunakan
untuk menetapkan akses
yang bisa memodifikasi
atau membuka file
persentasi yang dibuat.

: Perintah yang digunakan
untuk membuat paket CD
Presentasi

: Perintah yang digunakan
untuk melihat tampilan file
dalam bentuk halaman Web

»Save as Web Page

»Package for CD

» Web Page Preview

3. Beberapa kelebihan Flash antara lain:

» Animasi dan gambar konsisten dan fleksibel,
karena tetap terlihat bagus pada ukuran jendela
dan resolusi layar berapapun pada monitor
pengguna.

» Kualitas gambar terjaga. Hal ini disebabkan
karena Flash menggunakan teknologi Vector
Graphics yang mendeskripsikan gambar
memakai garis dan kurva, sehingga ukurannya
dapat diubah sesuai dengan kebutuhan tanpa
mengurangi atau mempengaruhi kualitas
gambar. Berbeda dengan gambar bitmap seperti
bmp, jpg dan gif yang gambarnya akan pecah-
pecah ketika ukurannya dibesarkan atau diubah
karena dibuat dari kumpulan titik-titik.

» Waktu loading (kecepatan gambar atau animasi
muncul atau loading time) lebih cepat
dibandingkan dengan pengolah animasi
lainnya, seperti animated gifs dan java applet.

» Mampu membuat website yang interaktif,
karena pengguna (user) dapat menggunakan
keyboard atau mouse untuk berpindah ke
bagian lain dari halaman web atau movie,
memindahkan objek, memasukkan informasi di
form.

» Mampu menganimasi grafis yang rumit dengan
sangat cepat, sehingga membuat animasi layar
penuh bisa langsung disambungkan ke situs
web.

» Mampu secara otomatis mengerjakan sejumlah

frame antara awal dan akhir sebuah urutan
animasi, sehingga tidak membutuhkan waktu
yang lama untuk membuat berbagai animasi.

» Mudah diintegrasikan dengan program

Macromedia yang lain, seperti Dreamweaver,
Fireworks, dan Authorware, karena tampilan
dan tool yang digunakan hampir sama.

» Dapat diintegrasikan dengan skrip sisi-server

(server side scripting) seperti CGI, ASP dan
PHP untuk membuat aplikasi pangkalan data
web.

» Lingkup pemanfaatan luas, dapat juga dipakai

untuk membuat film pendek atau kartun,
presentasi, iklan atau web banner, animasi logo,
kontrol navigasi dan lain-lain.

5. Langkah-langkah membuat sebuah motion tween

1.

adalah

Sorot frame di mana Kamu ingin membuat
animasi. Jika belum berupa sebuah keyframe
maka rubahlah menjadi keyframe.

. Gambar atau imporlah gambar yang Kamu ingin

lakukan animasi. Kamu hanya dapat melakukan
animasi pada group, simbol, dan teks yang dapat
diedit.

. Sorot frame dimana animasi akan berakhir.

Rubah frame ini menjadi sebuah keyframe
dengan memilih menu Insert | Keyframe.

. Pindahkanlah gambar dalam stage ke tempat

yang ingin dituju. Ingatlah Kamu tidak hanya
dapat menggerakkan gambar, Kamu juga bisa
melakukan putaran, merubah ukuran, dan
merubah efek warna.

. Klik kanan pada sebuah frame di antara kedua

keyframe dan pilih Create Motion Tween. Test-
lah animasi Kamu.

6.Jika Kamu ingin mengubah properties motion
tween, klik pada salah satu frame yang berada di
antara kedua keyframe untuk membuka kotak
dialog Frame Properties. Pilih tab Tweening.
Kamu dapat melakukan perubahan properties.

7. Istilah

Diagram

Grafik

Presentasi

Sebuah objek untuk
manampilkan (biasanya) sebuah
struktur organisasi, garis
komando tugas, dan alur proses
kerja.

Sebuah objek yang berupa model
tampilan visual untuk
menampikan data angka dalam
bentuk garis batang (bar) atau
lingkaran (pie)

Adalah suatu kegiatan berbicara
di hadapan banyak hadirin.
Berbeda dengan pidato yang
lebih sering dibawakan dalam
acara resmi dan acara politik,
presentasi lebih sering dibawakan
dalam acara bisnis. Tujuan dari

o Kunci Jawaban I




presentasi bermacam-macam,
misalnya untuk membujuk
(biasanya dibawakan oleh
wiraniaga), untuk memberi
informasi (biasanya oleh seorang
pakar), atau untuk meyakinkan
(biasanya dibawakan oleh
seseorang yang ingin membantah
pendapat tertentu).
9.Istilah

Action Script : Kode-kode program dalam Flash
digunakan untuk mengontrol
jalannya suatu animasi agar
animasi yang dibuat menjadi
lebih atraktif dan menarik.

Animasi : Hasil dari pengolahan gambar
tangan sehingga menjadi gambar
yang bergerak
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